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작동 주의 사항 및 제한 1
참고: 시스템을 작동하기 전에 본 안내서에 나오는 모든 절의 내용을 자세히 읽으십시오.

이 절에서는 일반적인 안전 관련 정보와 규정 준수 정보를 제공합니다. 또한 시스템에 대한 잠
재적인 위험과 관련 경고는 물론, 위험을 최소화하기 위해 수행해야 할 예방책도 설명합니다.

이 섹션 외에도, 실험실 환경, 시스템 및 이 문서에 사용되는 기호 및 표기 규칙에 대한 정보는
기호 용어 섹션을 참조하십시오. 주 전원 공급, 소스 배기, 환기, 압축 공기, 질소 및 러핑 펌프
요구 사항을 포함하여 현장 요구 사항에 대한 정보는 현장 계획 안내서 문서를 참조하십시오.

일반 안전 정보
신체 부상 또는 시스템 손상을 방지하기 위해 이 문서에 나오는 모든 안전 주의 사항과 경고,
제조업체 화학물질 SDS(안전 보건 자료) 및 제품 레이블 정보를 읽고 이해한 후 준수하십시
오. 레이블에는 국제 인증 기호가 표시되어 있습니다. 이러한 경고를 따르지 않으면 심한 부상
을 입을 수 있습니다.

이 안전 정보는 연방, 주, 지방 및 현지 환경 보건 안전(Environmental Health and Safety, EHS)
규정을 보완하기 위한 것입니다. 제공된 정보는 시스템 작동에 적용되는 시스템 관련 안전 정
보에 관한 것입니다. 실행해야 할 모든 안전 절차를 포함하지는 않습니다. 따라서, 사용자와 조
직은 연방, 주, 지방 및 현지 EHS 규정을 준수하고 안전한 실험실 환경을 유지해야 할 책임이
있습니다.

적합한 실험실 참조 자료 및 표준 작동 절차를 참조하십시오.

설명서 기호 및 표기 규칙
이 안내서 전체에서 다음 기호와 표기 규칙이 사용됩니다.

위험! 위험은 심한 부상이나 사망을 초래하는 행동을 나타냅니다.

경고! 경고는 주의 사항을 따르지 않을 경우 부상을 초래할 수 있는 행동을 나타냅니다.

주의: 주의는 주의 사항을 따르지 않을 경우 시스템 손상 또는 데이터 손상이나 손실을 초래할
수 있는 작업을 나타냅니다.

참고: 참고는 절차나 설명에서 중요한 정보를 강조합니다.

팁! 팁은 특정 요건에 대한 설명에서 기술과 절차를 적용하는 데 도움이 되는 유용한 정보와 손
쉬운 방법을 제공하지만, 절차의 완료하는데 꼭 필요하지 않을 수도 있습니다.
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규정 준수
본 시스템은 이 섹션에 열거된 규정 및 표준을 준수합니다. 이전 참조에 대해서는 시스템 및 개
별 시스템 구성품에 동봉된 적합성 선언을 참조하십시오. 해당 라벨이 시스템에 부착되었습니
다.

호주 및 뉴질랜드
• 전자기 적합성(EMC): 아래 표준에 구현된 1992년 무선통신법:

• 전자기 간섭—AS/NZS CISPR 11/ EN 55011/ CISPR 11(Class A). 자세한 정보는 전자기
간섭 섹션을 참조하십시오.

• 안전: AS/NZ 61010-1 및 IEC 61010-2-061

캐나다
• 전자파 방해(EMI): CAN/CSA CISPR11. 본 ISM 장치는 캐나다 ICES-001을 준수합니다. 자
세한 정보는 전자기 간섭 섹션을 참조하십시오.

• 안전:

• CAN/CSA C22.2 No. 61010-1

• CAN/CSA C22.2 No 61010-2-061

유럽
• 전자파 적합성(EMC): 아래 표준에 구현된 전자파 적합성 지침 2014/30/EU:

• EN 61326-1

• EN 55011(Class A)

자세한 정보는 전자기 적합성 섹션을 참조하십시오.

• 안전: 아래 표준에 구현된 저전압 지침 2014/35/EU:

• EN 61010-1

• EN 61010-2-061

• 전기/전자 장비 폐기물(WEEE): EN 40519에 구현된 전기/전자 장비 폐기물 처리 지침
2012/96/EEC. 자세한 정보는 전기/전자 장비 폐기물 섹션을 참조하십시오.

• 포장 및 포장 폐기물(PPW): 포장 및 포장 폐기물 처리 지침 94/62/EC

• RoHS 유해 물질 제한: RoHS 지침 2011/65/EU

미국
• 전파 방출 혼선 규정: 47 CFR 15, FCC Part 15 (Class A)에 구현

• 안전: 작업안전보건 규정, 29 CFR 1910, 아래 표준에서 구현:

• UL 61010-1
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• IEC 61010-2-061

국제
• 전자파 적합성(EMC):

• IEC 61326-1

• IEC CISPR 11 (Class A)

• IEC 61000-3-2

• IEC 61000-3-3

자세한 정보는 전자기 적합성 섹션을 참조하십시오.

• 안전:

• IEC 61010-1

• IEC 61010-2-061

전기 주의 사항
경고! 감전 위험. 커버를 분리하지 마십시오. 커버를 분리하면 부상 또는 시스템 오
작동이 발생할 수 있습니다. 커버는 정기 유지보수, 검사 또는 조정 시 분리할 필요
가 없습니다. 커버를 제거해야 하는 수리 작업은 SCIEX 현장 서비스 직원(FSE)에게
문의하십시오.

• 필수 전기 안전 실무 지침을 따르십시오.

• 케이블 관리 실무 절차를 사용하여 전기 케이블을 제어합니다. 이렇게 하면 트리핑 위험이
발생할 가능성이 줄어듭니다.

시스템 전기 사양에 대한 정보는 현장 계획 안내서 문서를 참조하십시오.

주 전원 공급 장치
본 안내서에 나타난 대로 시스템을 호환 주 공급 장치로 연결하십시오.

경고! 감전 위험. 모든 전기 공급 장치와 고정장치는 적격 기술자만 설치할 수 있
으며 모든 설치는 현지 규정 및 안전 기준을 준수해야 합니다.

경고! 감전 위험. 비상시에 주 전원 공급 콘센트에서 시스템을 분리할 수 있는지
확인하십시오. 주 전원 공급 콘센트를 막지 마십시오.
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경고! 감전 위험. 시스템과 함께 제공된 주 전원 공급 케이블만 사용하십시오. 이
시스템을 작동하는 데 적합한 등급이 아닌 주 전원 공급 케이블을 사용하면 안 됩
니다.

질량 분석계 또는 러핑 펌프에는 외부 라인 변압기가 필요하지 않습니다.

보호 접지 도체
주 전원 공급 장치에는 올바르게 설치된 보호 접지 도체가 있어야 합니다. 보호 접지도체는 시
스템을 연결하기 전 적격 기술자에 의해 설치 또는 검사되어야 합니다.

경고! 감전 위험. 보호 접지 도체를 의도적으로 차단하지 마십시오. 보호 접지 도
체를 차단하면 감전 위험이 있습니다.

경고! 감전 위험. 보호 접지 도체(접지 케이블)는 샘플 루프와 질량 분석계 이온 소
스의 해당 접지 지점 사이가 연결되어 있는지 확인하십시오. 이 보조 접지는 SCIEX
에서 지정한 안전 구성을 강화합니다.

화학물질 주의 사항
경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 청소 또는 유지
보수를 수행하기 전에 오염 물질 제거가 필요한지 확인하십시오. 방사성 물질, 생
물학적 작용제 또는 독성 화학물질을 시스템에 사용한 경우 고객은 청소나 유지보
수를 수행하기 전에 시스템의 오염 물질을 제거해야 합니다.

경고! 자상 위험, 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 이
온 소스 창이 갈라지거나 깨진 경우 이온 소스 사용을 중단하고 SCIEX FSE(현장
서비스 직원)에게 문의하십시오. 장비로 유입된 독성 또는 유해 물질이 소스 배기
출력에 남게 됩니다. 장비의 배기 가스는 실내에서 배출되어야 합니다. 규정된 실
험실 안전 절차에 따라 날카로운 조각을 폐기하십시오.

경고! 환경 위험. 시스템 구성품을 도시 폐기물로 폐기하지 마십시오. 구성품을 폐
기할 때는 현지 규정을 따르십시오.
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경고! 생물학적 또는 독성 화학물질 위험. 배출 배관을 질량 분석계와 소스 배기
배출 용기에 올바르게 연결하여 누출을 방지하십시오.

• 서비스 및 정기 유지보수 전에 시스템에서 사용된 화학물질을 확인하십시오. 화학 물질에
대해 준수해야 할 보건 안전 예방책은 안전 보건 자료 문서를 참조하십시오. 보관 정보는 분
석 증명서 문서를 참조하십시오. SCIEX 안전 보건 자료 또는 분석 증명서를 찾으려면
sciex.com/tech-regulatory 페이지로 이동하십시오.

• 무분말 장갑, 보안경, 실험복 등을 포함하여 지급된 개인 보호 장비를 항상 착용하십시오.

참고: 니트릴 또는 네오프렌 장갑이 권장됩니다.

• 통풍이 잘 되는 곳이나 흄후드에서 작업하십시오.

• 이소프로판올, 메탄올 및 기타 인화성 용매 등 인화성 물질과 관련된 작업을 수행할 때는 점
화원을 피하십시오.

• 화학물질을 사용하거나 폐기할 때는 항상 주의하십시오. 올바른 화학물질 취급 및 폐기 절
차를 따르지 않으면 부상을 입을 수도 있습니다.

• 청소 중에 화학물질이 피부에 닿지 않게 하고 사용 후에는 손을 씻으십시오.

• 모든 배출 호스가 올바르게 연결되어 있고 모든 연결부가 설계대로 기능하고 있는지 확인
하십시오.

• 사용된 모든 액체를 수집하여 위험물질 폐기물로 처리합니다.

• 생물학적 위험 물질, 독성 물질 및 방사성 물질의 보관, 취급 및 폐기와 관련된 모든 현지 규
정을 준수하십시오.

• (권장) 러핑 펌프, 용매 용기 및 폐기액 용기 아래에 이차 봉쇄 트레이를 사용하여 잠재적 화
학물질 유출물을 획득하십시오.

시스템에 안전한 액체
다음 액체는 시스템에 안전하게 사용할 수 있습니다.세정액에 대한 자세한 정보는 필요한 품
목 섹션을 참조하십시오.

주의: 잠재적 시스템 손상. SCIEX로부터 위험이 없다는 확인을 받을 때까지 다른 액체
를 사용하지 마십시오. 이 목록은 완전한 목록이 아닙니다.

참고: LC 이동상에는 새로 준비한 LC-MS 등급 이상의 용매만 사용하십시오.

• 유기 용매

• LC-MS 등급 아세토니트릴, 최대 100%

• LC-MS 등급 메탄올, 최대 100%

• LC-MS 등급 이소프로판올, 최대 100%

• LC-MS 등급 이상의 물, 최대 100%
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• 아세토니트릴, 최대 100%

• 메탄올, 최대 100%

• 이소프로판올, 최대 100%

• DDI 물, 최대 100%

• 테트라히드로푸란, 최대 100%

• 톨루엔 및 기타 방향족 용매, 최대 100%

• 헥산, 최대 100%

• 완충액

• 아세트산 암모늄, 100mM 미만

• 포름산 암모늄, 100mM 미만

• 인산염, 1% 미만

• 산과 염기

• 포름산, 1% 미만

• 아세트산, 1% 미만

• TFA(트리플루오로아세트산), 1% 미만

• HFBA(헵타플루오로뷰티르산), 1% 미만

• 암모니아/수산화암모늄, 1% 미만

• 인산, 1% 미만

• 트리메틸아민, 1% 미만

• 트리에틸아민, 1% 미만

환기 주의 사항
가스 환기 및 폐기물 처리는 연방, 주, 지방 및 현지 보건 및 안전 규정을 모두 준수해야 합니
다. 고객은 현지 보건 및 안전 규정에 따라 공기질을 유지할 책임이 있습니다.

소스 배기 시스템 및 러핑 펌프는 전용 실험실 흄후드 또는 외부 배기 시스템으로 환기시켜야
합니다.

경고! 화재 위험. 이온 소스에 가연성 증기가 쌓이지 않도록 소스 배기 시스템이 연결되
어 작동하고 있는지 확인하십시오.
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경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 배기 가스를
전용 실험실 흄후드 또는 배기 시스템으로 환기할 때는 각별히 주의해야 하며 환기
배관을 클램프로 고정해야 합니다. 작업이 이루어지는 동안 실험실이 적절하게 환
기되어야 합니다.

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 소스 배기 배출
구 및 러핑 펌프 배출 호스가 실험실 환기 시스템에 올바르게 연결되지 않은 경우 질
량 분석계를 작동하지 마십시오. 배기 배관을 정기적으로 점검하여 누출이 없는지
확인하십시오. 적절한 시스템 환기 장치 없이 질량 분석계를 사용하면 건강에 해가
되며 심각한 부상을 입을 수 있습니다.

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 이온 소스와
함께 사용되는 독성 또는 유해 물질의 올바른 사용, 봉쇄 및 배출에 대한 지식과
관련 교육을 받은 적이 없으면 이온 소스를 사용하지 마십시오.

경고! 자상 위험, 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 이
온 소스 창이 갈라지거나 깨진 경우 이온 소스 사용을 중단하고 SCIEX FSE(현장
서비스 직원)에게 문의하십시오. 장비로 유입된 독성 또는 유해 물질이 소스 배기
출력에 남게 됩니다. 장비의 배기 가스는 실내에서 배출되어야 합니다. 규정된 실
험실 안전 절차에 따라 날카로운 조각을 폐기하십시오.

물리적 주의 사항
경고! 들어올리기 위험. 질량 분석계를 들어 올려 이동하려면 기계식 인양 장치를 사용
하십시오. 규정된 안전 인양 절차를 따르십시오. 전문 운송 서비스를 이용하는 것이 좋
습니다. 시스템 구성품의 무게는 현장 계획 안내서 문서를 참조하십시오.

환경 주의 사항
주 전원, 가열, 환기 및 배관 소모품 및 고정장치의 설치는 적격 관계자에게 요청하십시오. 모
든 설치는 지역 내규 및 생물학적 위험 규정을 준수해야 합니다. 시스템 관련 필요 환경 조건에
대한 정보는 현장 계획 안내서 문서를 참조하십시오.
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시스템을 설정할 때는 장비 주위에 접근할 수 있는 공간을 만드십시오.

위험! 폭발 위험. 폭발성 가스를 포함하는 환경에서는 시스템을 작동하지 마십시오. 이
시스템은 폭발성 환경에서 작동하도록 설계되지 않았습니다.

경고! 생물학적 위험. 생물학적 위험 물질을 사용하는 경우 항상 위험성 평가, 제어 및
취급과 관련된 현지 규정을 준수하십시오. 이 시스템 또는 부품은 생물학적 봉쇄 역할
을 하기 위한 것이 아닙니다.

경고! 환경 위험. 생물학적 위험, 독성, 반응성, 전자 폐기물 처분은 확립된 절차를
따르십시오. 현지 법률 및 규정에 따라 화학물질, 폐유, 전기 부품을 비롯한 위험
물질을 처분하는 것은 고객의 책임입니다.

주의: 잠재적 질량 변화. 주변 온도를 안정적으로 유지하십시오. 온도가 시간당 2°C 이상 변경
되면 분해능과 질량 교정이 영향을 받을 수 있습니다.

전자기 환경
전자기 적합성
기본 전자파 환경: 공공 주 네트워크에서 저전압으로 직접 공급되는 특정 위치의 환경입니다.

성능 기준 A(기준 A): 장비가 검사 중 또는 검사 후에 성능 저하 및 기능 손실 없이 제대로 작동
해야 합니다.

성능 기준 B(기준 B): 장비가 검사 중에 기능 손실이 한 번 이상 발생할 수 있지만 검사 후에는
자체 복구 가능한 일부 성능과 기능이 저하된 상태로 문제 없이 작동해야 합니다.

성능 기준 C(성능 C): 장비가 검사 중에 기능 손실이 한 번 이상 발생할 수 있지만 검사 후에는
작업자가 복구 가능한 일부 성능과 기능이 저하된 상태로 문제 없이 작동해야 합니다.

장비는 기본 전자파 환경에서 사용하도록 되어 있습니다.

전자기 내성 조건에서 예상되는 성능 손실은 총 이온 개수(TIC) 변경의 20% 미만입니다.

장치가 제대로 작동하도록 장비에 대해 호환되는 전자기 환경을 유지 관리할 수 있어야 합니
다. 전원 공급 라인이 높은 전기적 노이즈에 민감한 경우 과전압 방지기를 설치하십시오.

전자기 간섭
그룹 1 장비: 이 장비는 내부 작동을 위해 RF 에너지를 사용할 수 있는 산업, 과학 및 의료
(ISM) 장비로 분류됩니다.

Class A 장비: 국내 및 국내용 건축물을 공급하는 저전압 전원 공급망에 직접 연결되는 곳 이
외의 모든 기관에서 사용하는 데 적합한 장비. [CISPR 11:2009, 5.3 파생] Class A 장비는
Class A 제한을 충족합니다.

주의: 송수신 장치 간섭이 발생할 수 있음. 이 장비는 주거 환경에서 사용하기 위한 것이 아니
며 이러한 환경에서 사용할 경우 무선 수신을 적절하게 보호하지 못할 수 있습니다.

작동 주의 사항 및 제한
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이 장비는 검사를 거쳐, FCC(Federal Communications Commission) 준수 규칙의 제15항에 준
하는 클래스 A 디지털 장치에 대한 제한에 부합되는 것으로 확인되었습니다.

이러한 제한은 장비가 상업 환경에서 작동될 때 유해한 간섭에 대한 적절한 보호 수단을 제공
하기 위한 것입니다. 본 장비는 무선 주파수 에너지를 생성, 사용하며, 방사할 수 있으며, 작업
자 설명서에 따라 설치 및 사용되지 않을 경우 무선 통신에 유해 간섭을 일으킬 수 있습니다.

주거 지역에서 이 장비를 작동하면 자비로 간섭을 바로 잡아야 하는 유해 간섭을 일으킬 수도
있습니다. 제조업체에서 명시적으로 승인하지 않은 변경 또는 개조로 인해 장비 작동 권한이
무효화될 수 있습니다.

철거 및 폐기
경고! 환경 위험. 생물학적 위험, 독성, 반응성, 전자 폐기물 처분은 확립된 절차를
따르십시오. 현지 법률 및 규정에 따라 화학물질, 폐유, 전기 부품을 비롯한 위험
물질을 처분하는 것은 고객의 책임입니다.

철거 전에 현지 규정에 따라 전체 시스템의 오염 물질을 제거하십시오.

시스템을 더 이상 사용하지 않을 경우 국가 및 현지 환경 규정에 따라 여러 자재를 분리 및 재
활용하십시오. 자세한 정보는 보관 및 취급에 대한 환경 요구 사항 섹션을 참조하십시오.

참고: SCIEX는 오염 물질 제거 양식을 작성하지 않으면 어떠한 시스템 반환도 수락하지 않습
니다. 양식 사본을 구하려면 FSE에게 문의하십시오.

컴퓨터 부품을 비롯하여 시스템 구성품이나 하위 어셈블리를 분류되지 않은 지역 폐기물로 폐
기하지 마십시오.

전기/전자 장비 폐기물
WEEE(전기/전자 장비 폐기물)가 환경에 미치는 영향을 줄이기 위해 현지 도시 폐기물 법령의
올바른 폐기 규정을 따르십시오. 이 장비를 안전하게 폐기하려면 현지 고객 서비스 부서에 무
료 장비 수거 및 재활용에 대해 문의하십시오.

적격 담당자
장비의 설치, 검사 및 정비는 적격 SCIEX 담당자만 수행해야 합니다. 시스템을 설치한 후 현장
서비스 직원(FSE)은 고객 숙지 점검 목록를 사용하여 고객에게 시스템 작동, 청소 및 기본 유
지보수를 안내합니다. SCIEX가 승인하지 않은 사람이 시스템을 정비하여 발생한 시스템 손상
은 SCIEX 보증 대상이 아닙니다.

제조업체에서 적격자로 판단한 관계자만 장비를 관리해야 합니다. 실험실 지정자는 설치 중에
적격 유지보수 기술자(QMP) 절차를 익힐 수 있습니다. QMP는 실험실 장비 서비스와 관련된
전기 및 화학 위험에 대해 잘 알고 있는 담당자입니다.

작동 주의 사항 및 제한
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실험실 조건
안전한 환경 조건
이 시스템은 다음과 같은 조건에서 안전하게 작동하도록 설계되었습니다.

• 실내

• 고도: 최대 2,000m(6,560피트) 해발고도

• 주변 온도: 5°C(41°F) ~ 40°C(104°F)

• 상대 습도: 20%~80%(비응결)

• 주 공급 전압 변동: 공칭 전압의 ±10%

• 과도 과전압: 최대 과전압 범주 II

• 주 전원 공급 장치의 일시적 과전압

• 오염도 2

성능 사양
이 시스템은 다음 조건에서 사양을 충족하도록 설계되었습니다.

• 주변 온도: 15°C~26°C(59°F~78.8°F)

시간이 지나면 온도는 시간당 2°C(3.6°F)를 초과하지 않는 변화율로 4°C(7.2°F) 범위 내에
서 유지되어야 합니다. 주변 온도가 이 제한을 초과하여 변동할 경우 스펙트럼 내에서 질량
변화가 발생할 수 있습니다.

• 상대 습도: 20%~80%(비응결)

장비 사용 및 개조
경고! 신체 부상 위험. 제품 설치, 조정 또는 재배치가 필요한 경우 SCIEX 담당자에게
문의하십시오.

경고! 감전 위험. 커버를 분리하지 마십시오. 커버를 분리하면 부상 또는 시스템 오
작동이 발생할 수 있습니다. 커버는 정기 유지보수, 검사 또는 조정 시 분리할 필요
가 없습니다. 커버를 제거해야 하는 수리 작업은 SCIEX 현장 서비스 직원(FSE)에게
문의하십시오.

경고! 신체 부상 위험. SCIEX 권장 부품만 사용하십시오. SCIEX에서 권장하지 않는 부
품을 사용하거나 원래 용도가 아닌 다른 목적으로 부품을 사용하면 사용자가 상해를
입거나 시스템 성능이 저하될 수 있습니다.

경고! 들어올리기 위험. 질량 분석계를 들어 올려 이동하려면 기계식 인양 장치를 사용
하십시오. 규정된 안전 인양 절차를 따르십시오. 전문 운송 서비스를 이용하는 것이 좋
습니다. 시스템 구성품의 무게는 현장 계획 안내서 문서를 참조하십시오.

작동 주의 사항 및 제한
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경고! Crushing Hazard. 무거운 물건을 이동시킬 때에는 부상방지용 보호신발을 신으
십시오.

질량 분석계 현장 계획 안내서 문서에서 권장하는 환경 조건을 준수하는 실험실 실내에서 시
스템을 사용하십시오.

시스템을 제조업체에서 규정하지 않은 방식이나 환경에서 사용하는 경우 장비에서 제공하는
성능 및 보호 상태가 손상될 수 있습니다.

무단 시스템 개조 또는 작동으로 부상 및 장비 손상을 초래할 수 있으며 보증이 무효화될 수 있
습니다. 시스템을 권장 환경 조건에 맞지 않는 상태에서 작동하거나 무단으로 개조하여 작동
할 경우 잘못된 데이터가 생성될 수 있습니다. 시스템 서비스에 대한 정보는 FSE에게 문의하
십시오.

작동 주의 사항 및 제한
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작동 원리 2
이 시스템은 화학종의 정성 및 정량적 분석용으로 설계되었습니다.

이 섹션에는 질량 분석계에 대한 정보가 포함되어 있습니다. 이온 소스의 개요에 대해서는
DuoSpray Ion Source 작업자 안내서 문서를 참조하십시오.

컴퓨터 및 소프트웨어에 대한 자세한 정보는 소프트웨어의 소프트웨어 설치 안내서 문서를 참
조하십시오.

시스템 개요
TripleTOF 6600+ 시스템은 다음 구성품을 포함합니다.

• TripleTOF 6600+ 질량 분석계(러핑 펌프 포함).

• DuoSpray 이온 소스. 자세한 정보는 DuoSpray 이온 소스 작업자 안내서 문서를 참조하십
시오.

• SCIEX에서 제공하는 컴퓨터와 모니터. 기기 최적화, 획득 방법 개발 및 데이터 획득을 위한
Analyst TF 소프트웨어가 포함됩니다. 컴퓨터 사양 및 요구 사항은 Analyst TF 소프트웨어
의 소프트웨어 설치 안내서 문서를 참조하십시오.

• 교정물질 전달 시스템(CDS) - 옵션

하드웨어 개요
그림 2-1 및 그림 2-2에서는 질량 분석계 구성품과 연결부를 보여 줍니다.

작동 원리
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그림 2-1 전면도와 우측면도

항목 설명 자세한 정보...

1 CDS(옵션) CDS 작업자 안내서를 참조하십시
오.

2 DuoSpray 이온 소스 자세한 정보는 TripleTOF 시스템용
DuoSpray 이온 소스 작업자 안내서
를 참조하십시오.

3 주사기 펌프 자세한 정보는 통합형 주사기 펌프
위치 조정에서 확인하십시오.

작동 원리

시스템 사용자 안내서
RUO-IDV-05-8593-KR-D

TripleTOF 6600+ 시스템
19/138



항목 설명 자세한 정보...

4 질량 분석계 상태 LED 자세한 정보는 패널 기호에서 확인
하십시오.

5 통신 벌크헤드 SCIEX FSE(현장 서비스 직원)에게
문의하십시오.

6 주사기 펌프용 직렬(RS-232) 케이
블 연결

FSE에게 문의하십시오.

7 USB-GPIB 카드용 USB 케이블 연
결

FSE에게 문의하십시오.

8 ADC 카드용 InfiniBand 케이블 연결 FSE에게 문의하십시오.

작동 원리
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그림 2-2 좌측면도

항목 설명 자세한 정보...

1 가스 및 진공 벌크헤드 FSE에게 문의하십시오.

2 러핑 펌프 진공 연결 FSE에게 문의하십시오.

3 교정물질 제어 연결 CDS 작업자 안내서를 참조하십시
오.

4 AUX IO 연결. 옵션 LC 시스템 시작
신호가 이 포트에 연결됩니다.

FSE에게 문의하십시오.

작동 원리
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항목 설명 자세한 정보...

5 외부 제어 연결. 이 포트는 향후 사
용을 위한 것입니다.

FSE에게 문의하십시오.

6 소스 연결. 일부 이온 소스가 이 포
트에 연결됩니다.

FSE에게 문의하십시오.

7 AC 배전반 FSE에게 문의하십시오.

8 기기 전원 스위치 자세한 정보는 시스템 시작에서 확
인하십시오.

9 회로 차단기 위의 커버 자세한 정보는 시스템 시작에서 확
인하십시오. 회로 차단기보다는 전
원 스위치를 사용하여 시스템을 종
료하십시오.

10 주 전원 공급 장치 연결부 자세한 정보는 시스템 시작에서 확
인하십시오.

11 Curtain Gas(질소) 공급 연결부 FSE에게 문의하십시오.

12 가스 1과 가스 2(0) 공급 연결부 FSE에게 문의하십시오.

13 소스 배기 가스(0등급 공기 또는 질
소) 공급 연결부

FSE에게 문의하십시오.

14 CAD 가스(질소) 공급 연결부 FSE에게 문의하십시오.

15 소스 배출 폐기물 연결부 FSE에게 문의하십시오.

16 사용되지 않음 N/A.

17 사용되지 않음 N/A.

패널 기호
다음 표에서는 질량 분석계 상태 LED에 대해 설명합니다.

표 2-1 패널 기호

LED 색상 이름 설명

녹색 전원 시스템 전원을 켜면 켜집니다.

녹색 진공 작동 진공 수준에 도달하면 켜집니다. 진
공 수준이 올바르지 않은 경우, 즉 펌프
다운 및 환기 중일 때 깜박입니다.

녹색 준비 시스템이 Ready 상태가 되면 켜집니다.
시스템이 작동하려면 Ready 상태여야
합니다.

작동 원리
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표 2-1 패널 기호 (계속)

LED 색상 이름 설명

파란색 스캔 시스템에서 데이터를 획득 중일 때 깜박
입니다.

빨간색 오류 시스템 오류가 발생하면 켜집니다.

녹색 주사기 펌프 상태 주사기 펌프가 작동 중일 때 켜집니다.

시스템을 켜면 모든 LED가 켜집니다. 전원 LED는 계속 켜져 있습니다. 다른 LED는 2초간 깜
박이다가 꺼집니다. 진공 LED가 깜박이기 시작합니다. 이 LED는 작동 진공 수준에 도달하면
켜진 상태로 유지됩니다.

작동 이론
질량 분광분석법은 이온의 질량 대 전하비를 측정하여 알 수 없는 화합물을 식별하고, 알려진
화합물을 정량화하며, 분자의 구조 및 화학적 속성에 대한 정보를 제공합니다.

TripleTOF 6600+ 시스템에는 질량 대 전하비(m/z)에 따라 이온을 선택하거나 전송하는 일련
의 사중극자 필터가 있습니다. 여기서 첫 번째 사중극자는 QJet 이온 가이드이며, 오리피스 플
레이트와 Q0 영역 사이에 있습니다. QJet 이온 가이드는 이온을 필터링하지 않지만 이온이
Q0 영역으로 들어가기 전에 이온을 집속합니다. QJet 이온 가이드는 더 넓은 오리피스에 의해
생성된 더 큰 이온 플럭스를 사전 집중시킴으로써 기기 감도를 높이고 신호 대 잡음 비를 향상
시킵니다. Q0 영역에서는 이온이 Q1 사중극자로 전달되기 전에 다시 집속됩니다.

Q1 사중극자는 Q2 충돌 셀로 들어가기 전에 이온을 정렬합니다. Q1 사중극자는 두 작동 모드
에서 사용됩니다.

• 지정된 m/z 범위 내의 모든 이온을 Q2 충돌 셀에 전달합니다. 이는 TOF MS 스캔입니다. 모
든 이온이 시스템에서 분석됩니다.

• 지정된 m/z 비율을 가진 하나의 이온을 Q2 충돌 셀에 전달합니다. 이는 TOF MS/MS 스캔
입니다. 선택한 이온만 분석됩니다.

Q2 충돌 셀에서는 이온의 내부 에너지가 가스 분자와의 충돌을 통해 분자 결합이 깨지는 지점
까지 증가되어 생성 이온이 생성됩니다. 이 기법을 통해 사용자는 생성 이온의 m/z 비율을 측
정하는 실험을 설계하여 부모 이온의 구성을 결정하고 분자의 구조 및 화학적 속성에 대한 정
보를 제공할 수 있습니다.

Q2 충돌 셀을 통과한 이온은 추가 질량 분석을 위해 TOF 영역으로 들어갑니다. 이러한 이온은
m/z 비율에 따라 서로 다른 시간에 검출기에 도달합니다. 검출기에서 이온은 전압 펄스로 변환
되는 전류를 생성합니다. 이러한 전압 펄스는 횟수가 측정되며 펄스 횟수는 검출기로 들어가
는 이온의 양과 정비례합니다. 질량 분석계는 전압 펄스를 신호로 변환한 다음 이 신호를 각 이
온이 검출기에 도달하는 시간과 상호 연관시킵니다. 신호는 이온 강도를 나타내고 검출기에
도달하는 시간은 특정 m/z 값을 나타냅니다. 질량 분석계는 이 데이터를 질량 스펙트럼으로 표
시합니다.
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데이터 처리
Analyst TF 소프트웨어를 사용하려면 Windows 7(64비트) 또는 Windows 10(64비트) 운영 체
제를 실행하는 컴퓨터가 필요합니다. 컴퓨터와 관련 시스템 소프트웨어는 시스템 컨트롤러 및
관련 펌웨어와 함께 작동하여 시스템과 데이터 획득을 제어합니다. 시스템 작동 중에 획득한
데이터는 Analyst TF 소프트웨어에 전송되어 전체 질량 스펙트럼, 이온 크로마토그램/이온 스
펙트럼 또는 시간에 따른 총 이온 전류로 표시될 수 있습니다.
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작동 지침 3
경고! 신체 부상 위험. 시스템을 사용할 때에는 설명서에 있는 지침을 따르십시오.
SCIEX에서 지정하지 않은 방식으로 장비를 사용하면 장비가 제공하는 보호 기능이 손
상될 수 있습니다.

시스템 시작
경고! 감전 위험. 비상시에 주 전원 공급 콘센트에서 시스템을 분리할 수 있는지
확인하십시오. 주 전원 공급 콘센트를 막지 마십시오.

경고! 들어올리기 위험. FSE(현장 서비스 직원)와 상의 없이 시스템을 이동하지
마십시오. 신체 부상 또는 시스템 손상 위험. 시스템을 이동해야 하는 경우 FSE에
게 문의하십시오.

참고: 기기를 작동하기 전에 작동 주의 사항 및 제한 섹션의 안전 정보를 읽으십시오.

선행 조건

• 현장 계획 안내서에 명시된 현장 요구 사항을 충족합니다. 현장 계획 안내서에는 주 전원
공급 장치와 연결부, 압축 공기, 질소, 러핑 펌프, 환기, 배기 및 현장 정리 요구 사항에 대
한 정보가 포함되어 있습니다. 필요한 경우 SCIEX에 현장 계획 안내서 복사본을 요청할
수 있습니다. 연락처 정보를 보려면 sciex.com/contact-us로 이동하십시오..

• 소스 배기 가스, 압축 공기 및 질소 가스가 질량 분석계에 연결되어 있습니다.

• 4L 소스 배기 배출 용기가 질량 분석계 후면에 있는 배출 폐기물 연결부와 실험실 환기 시
스템에 연결되어 있습니다.

• 소스 배출 호스가 질량 분석계, 소스 배기 배출 용기 및 환기 연결부에 클램프로 단단히 고
정되어 있습니다.

• 기기 전원 스위치가 꺼져 있고 주 전원 공급 케이블이 질량 분석계에 연결되어 있습니다.

• 질량 분석계 및 러핑 펌프 주 전원 공급 케이블이 200VAC~240VAC 주 전원 공급 장치에
연결되어 있습니다.

• 이더넷 케이블이 질량 분석계와 컴퓨터에 모두 연결되어 있습니다.

1. 러핑 펌프를 켭니다.
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2. 앞에서 볼 때 질량 분석계 왼쪽의 회로 차단기 스위치 커버를 제거한 후 회로 차단기를 켭
니다. 자세한 정보는 그림 2-2에서 확인하십시오.

3. 회로 차단기 스위치 커버를 교체한 후 커버를 잡고 손으로 조일 수 있을 때까지 나사를 돌
립니다.

4. 기기 전원 스위치를 켭니다. 자세한 정보는 그림 2-2에서 확인하십시오.

5. 컴퓨터를 켭니다.

6. 제어 소프트웨어를 엽니다.

시스템 종료
일부 절차를 수행하려면 시스템을 종료해야 합니다. 다른 절차에서는 환기도 필요합니다. 다
음 단계에 따라 시스템을 종료하고 필요한 경우 환기하십시오.

참고: 가스 배관을 분리해야 할 경우에는 분리 전에 가스 라인의 압력을 낮추십시오.

팁! 질량 분석계를 오랫동안 사용하지 않을 경우 이온 소스를 제자리에 두고 Standby 상태로
두십시오. 질량 분석계를 종료해야 하는 경우 다음 지침을 따르십시오.

1. 진행 중인 스캔을 완료하거나 중지합니다.

주의: 잠재적 시스템 손상. 시스템을 종료하기 전에 샘플 유량을 끕니다.

2. 시스템으로 전달되는 샘플 흐름을 끕니다.

3. Analyst TF 소프트웨어에서 하드웨어 프로필을 비활성화합니다(활성화된 경우).

4. 소프트웨어를 닫습니다.

5. 기기 왼쪽에 있는 기기 전원 스위치를 끕니다. 자세한 정보는 하드웨어 개요에서 확인하
십시오.

6. (필요한 경우) 다음 단계에 따라 시스템을 환기합니다.

참고: 올바른 환기를 위해 이온 소스를 설치된 상태로 두십시오.

a. 러핑 펌프를 끕니다.

b. 시스템이 환기될 때까지 기다리십시오. 이 작업은 15분 ~ 25분 정도 걸립니다.

7. 질량 분석계 왼쪽의 회로 차단기 스위치 커버를 제거한 후 회로 차단기를 끕니다. 자세한
정보는 그림 2-2에서 확인하십시오.

8. 회로 차단기 스위치에 커버를 설치한 후 손으로 조일 수 있을 때까지 커버 고정 나사를 돌
립니다.

9. (시스템을 환기한 경우) 러핑 펌프 주 전원 공급 케이블을 주 전원 공급 콘센트에서 분리합
니다.
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통합형 주사기 펌프 위치 조정
경고! 자상 위험. 주사기 취급 시 주의하십시오. 주사기 팁이 매우 날카롭습니다.

경고! 자상 위험. 주사기를 주사기 펌프에 올바르게 장착하고 자동 주사기 펌프가
올바르게 멈추도록 조절하여 유리 주사기가 깨지거나 손상되지 않도록 하십시오.
주사기가 파손된 경우 규정된 안전 절차에 따라 날카로운 조각을 폐기하십시오.

질량 분석계에서 주사기 펌프의 위치는 다음 그림을 참조하십시오. 그림 2-1.

1. 주사기 펌프의 오른쪽에 있는 Release 버튼을 눌러 받침대를 내린 다음 주사기를 삽입합
니다.

그림 3-1 주사기 내리기
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항목 설명

1 주사기 플런저

2 Release 버튼. 이 버튼을 눌러 받침대를 올리거나 내립니다.

2. 주사기 끝부분이 받침대와 같은 높이가 되고 주사기의 샤프트가 단면에 놓여 있는지 확인
합니다.

3. 주사기 플런저가 유리 주사기 하부에 닿기 전에 자동 주사기 중지장치가 작동하도록 포스
트를 조정합니다.

그림 3-2 자동 주사기 중지장치
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항목 설명

1 자동 주사기 중지장치. 포스트가 자동 주사기 중지장치에 닿으면 주사기
펌프가 중지됩니다.

2 포스트. 샘플 주입 중에 주사기 플런저가 주사기에 닿지 않도록 높이를
조정합니다.

3 포스트 잠금 나사. 포스트 높이를 조정한 후 나사를 조입니다.

4. 주사기 펌프 나사를 돌려 주사기를 고정합니다.

그림 3-3 주사기 펌프 나사

5. 질량 분석계와 통합형 주사기 펌프가 소프트웨어에서 활성화되었는지 확인합니다.

6. Analyst TF 소프트웨어의 탐색 모음에서 Manual Tuning을 두 번 클릭합니다.

7. Start Syringe를 클릭합니다.

8. 주사기 펌프를 중지하려면 Stop Syringe를 클릭합니다.

주사기 펌프 재설정
Analyst TF 소프트웨어와 주사기 펌프의 통신이 중지되면 주사기 펌프를 재설정합니다.

종이 클립이나 이와 유사한 도구를 사용하여 그림 3-4에 표시된 재설정 버튼을 누릅니다.
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그림 3-4 재설정 버튼
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작동 지침 — 샘플 워크플로 4
표 4-1 기기 설정

단계 수행할 작업 참조할 정보 기능

1 하드웨어 프로필을 생성
합니다.

하드웨어 프로필 생성 각 하드웨어 프로필에
질량 분석계 및 기타
장치(예: LC 시스템)가
포함되어야 합니다.
활성 하드웨어 프로필
에 포함된 장치만 획
득 방법을 생성할 때
사용할 수 있습니다.

2 데이터를 저장할 프로젝
트를 생성합니다.

프로젝트 및 하위 프로젝트 생
성

프로젝트 및 하위 프
로젝트를 사용하면 데
이터 관리가 용이하고
결과를 더 쉽게 비교
할 수 있습니다.

3 질량 분석계를 최적화합
니다.

질량 분석계 최적화 이 작업은 분해능과
질량 분석계 매개 변
수를 최적화하고, 시
스템의 감도와 성능을
최대화하도록 질량 분
석계를 교정하는 프로
세스입니다.

표 4-2 샘플 획득 워크플로

단계 수행할 작업... 참조할 정보 기능

1 데이터를 저장할 프로젝
트를 생성합니다.

프로젝트 및 하위 프로젝트 생
성

실험을 시작하기 전에
실험과 관련된 파일의
저장 위치를 결정합니
다. 프로젝트 및 하위
프로젝트를 사용하면
데이터 관리가 향상되
어 결과를 더 쉽게 비
교할 수 있습니다.
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표 4-2 샘플 획득 워크플로 (계속)

단계 수행할 작업... 참조할 정보 기능

2 획득 방법을 생성합니다. 작동 지침 — 획득 방법 샘플을 분석하려면 질
량 분석계 및 LC 장치
에 대한 획득 방법을
생성합니다. 획득 방
법은 사용할 주변 장
치, 이를 사용하여 데
이터를 획득할 시기
및 관련 매개 변수를
지정합니다.

3 배치를 생성하고 제출합
니다.

배치에 세트 및 샘플 추가 및 샘
플 또는 샘플 세트 제출

획득 방법을 생성한
후 획득 배치를 생성
하고 획득 대기열에
배치를 제출하여 샘플
을 실행합니다.

4 데이터 획득을 위해 샘플
을 실행합니다.

데이터 획득 샘플 실행에는 획득
대기열을 관리하고 기
기 및 장치 상태를 모
니터링하는 작업이 포
함됩니다. 샘플을 제
출하고 데이터를 획득
하려면 대기열 관리자
를 사용합니다. 대기
열 관리자에는 대기
열, 배치 및 샘플 상태
가 표시되므로 대기열
의 샘플과 배치를 쉽
게 관리할 수 있습니
다.

5 데이터를 탐색 모드에서
분석합니다.

—또는—

작동 지침 — 데이터 분석 및 탐
색

탐색 모드에서는 획득
한 데이터를 검토하고
처리하는 다양한 도구
를 사용할 수 있습니
다. 피크 레이블과 캡
션으로 그래프를 사용
자 지정할 수 있으며
등고선 플롯을 표시하
고 스펙트럼을 라이브
러리에 저장할 수 있
습니다.
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표 4-2 샘플 획득 워크플로 (계속)

단계 수행할 작업... 참조할 정보 기능

6 지원 소프트웨어를 사용
하여 데이터를 분석하고
보고서를 인쇄합니다.

MultiQuant 소프트웨어/
PeakView 소프트웨어

MultiQuant 소프트웨
어 또는 PeakView 소
프트웨어를 사용하여
데이터를 분석할 수
있습니다. 자세한 내
용은 소프트웨어와 함
께 제공된 문서를 참
조하십시오.

표 4-3 숙련된 사용자 워크플로

단계 수행할 작업 참조할 정보

1 기기를 질량 교정합니다. 다음 위치의 질량 교정 자습서
• Windows 7 운영 체제: Start > All Program >

SCIEX > Analyst TF > Software Guides.를 클릭합
니다.

• Windows 10 운영 체제: Start > SCIEX Analyst TF
> Analyst TF Documentation,을 클릭한 후
Software Guides 폴더를 두 번 클릭합니다.

2 질량 분석계를 최적화합
니다.

다음 위치의 수동 최적화 자습서
• Windows 7 운영 체제: Start > All Program >

SCIEX > Analyst TF > Software Guides.를 클릭합
니다.

• Windows 10 운영 체제: Start > SCIEX Analyst TF
> Analyst TF Documentation,을 클릭한 후
Software Guides 폴더를 두 번 클릭합니다.
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작동 지침 — 하드웨어 프로필 및 프로
젝트 5
하드웨어 프로필
하드웨어 프로필은 질량 분석계와 장치를 구성하는 방법 및 컴퓨터에 연결하는 방법을 소프트
웨어에 알려줍니다. 하드웨어 프로필을 여러 개 구성할 수 있지만 언제든 하나의 프로필만 활
성화할 수 있습니다.

하드웨어 구성 편집기에서 하드웨어 프로필을 생성하는 경우 소프트웨어가 통신할 수 있도록
주변 장치를 구성해야 합니다. 주변 장치를 구성하려면 다음 두 가지 절차가 필요합니다.

• 물리적 연결 설정. 장치에 물리적 연결을 설정하는 방법에 대한 자세한 정보는 주변 장치 설
치 안내서 문서를 참조하십시오.

• 주변 장치와 통신하도록 소프트웨어 구성. 지원되는 장치 목록은 Analyst TF 소프트웨어의
소프트웨어 설치 안내서 문서를 참조하십시오.

소프트웨어가 설치되면 각 주변 장치에 필요한 드라이버도 설치됩니다. 주변 장치를 컴퓨터에
물리적으로 연결한 후 적절한 구성 정보를 설정합니다.

각 하드웨어 프로필에는 질량 분석계가 포함되어야 합니다. 획득 방법을 생성하기 전에 주사
기 펌프를 비롯하여 방법에 사용할 모든 장치가 하드웨어 프로필에 포함되어 있는지 확인합니
다. 활성 하드웨어 프로필에 구성되고 Add/Remove Device Method 대화 상자에서 선택한 장
치는 획득 방법 창에 아이콘으로 표시됩니다. 활성 하드웨어 프로필에 포함된 주변 장치만 획
득 방법에 사용할 수 있습니다.

하드웨어 프로필 생성
사용자는 여러 하드웨어 프로필을 생성할 수 있지만 한 번에 하나의 프로필만 활성화할 수 있
습니다.

1. 탐색 모음에서 Configure 아래의 Hardware Configuration을 두 번 클릭합니다.

작동 지침 — 하드웨어 프로필 및 프로젝트

TripleTOF 6600+ 시스템
34/138

시스템 사용자 안내서
RUO-IDV-05-8593-KR-D



그림 5-1 하드웨어 구성 편집기 대화 상자

2. New Profile을 클릭합니다.
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그림 5-2 새 하드웨어 프로필 생성 대화 상자

3. Profile Name 필드에 이름을 입력합니다.

4. Add Device를 클릭합니다.
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그림 5-3 사용 가능한 장치 대화 상자

Available Devices 대화 상자에서 Mass Spectrometer는 Device Type 필드의 사전 설정
값입니다.

5. Devices 목록에서 적절한 질량 분석계를 선택한 후 OK를 클릭합니다.

6. Create New Hardware Profile 대화 상자에서 Setup Device를 클릭합니다.

7. (선택 사항) 통합 주사기 펌프를 사용하는 질량 분석계를 구성하려면 Configuration 탭에
서 Use integrated syringe pump 확인란을 선택합니다.
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그림 5-4 CDS 및 주사기 펌프가 구성된 구성 탭

8. (선택 사항) CDS에 대한 질량 분석계를 구성하려면 Configuration 탭에서 Use calibrant
delivery system (CDS)을 선택합니다.

9. (선택 사항) 필요에 따라 Configuration 및 Communication 탭에서 추가 기능을 선택합니
다.

10. OK를 클릭합니다.

11. Create New Hardware Profile 대화 상자에서 Add Device를 클릭한 후 질량 분석계와 함
께 사용되는 각 장치를 추가하고 설정합니다. 자세한 정보는 하드웨어 프로필에 장치 추
가 섹션을 참조하십시오.

12. Create New Hardware Profile 대화 상자에서 OK를 클릭합니다.

13. Hardware Configuration Editor에서 활성화할 하드웨어 프로필을 클릭합니다.

14. Activate Profile을 클릭합니다.
확인 표시가 녹색이 됩니다. 빨간색 x가 표시되면 하드웨어 프로필 활성화에 문제가 있는
것입니다.
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팁! 다른 프로필을 활성화하기 전에 하드웨어 프로필을 비활성화할 필요가 없습니다. 하
드웨어 프로필을 클릭한 후 Activate Profile을 클릭합니다. 그러면 활성 프로필이 자동으
로 비활성화됩니다.

15. Close를 클릭합니다.

하드웨어 프로필에 장치 추가
소프트웨어와 통신할 수 있도록 장치를 구성해야 합니다. 소프트웨어를 설치할 때 각 장치에
필요한 드라이버도 설치됩니다. 장치를 구성하려면 먼저 장치가 물리적으로 컴퓨터에 연결되
어 있어야 합니다. 자세한 정보는 주변 장치 설치 안내서 문서를 참조하십시오.

1. Hardware Configuration Editor를 엽니다.

2. Hardware Profiles 목록에서 하드웨어 프로필을 비활성화합니다.

3. Edit Profile을 클릭합니다.

4. Add Device를 클릭합니다.
Available Devices 대화 상자가 열립니다.

5. Device Type 목록에서 장치를 선택한 후 OK를 클릭합니다.

그림 5-5 사용 가능한 장치 대화 상자

6. OK를 클릭합니다.

7. Devices 목록에서 장치를 선택한 후 OK를 클릭합니다.
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8. Setup Device를 클릭합니다.
장치에 대한 구성 값이 포함된 대화 상자가 열립니다.

9. (선택 사항) Communication 탭의 Alias 필드에 장치에 대한 이름 또는 기타 식별자를 입
력합니다.

참고: 직렬 통신을 사용하는 장치의 경우 선택한 직렬 포트가 장치가 물리적으로 연결된
직렬 포트와 일치하는지 확인하십시오.

참고: Alias 필드는 Name 상자라고도 하며 Alias의 다른 탭에서 찾아볼 수 있습니다.

• 장치에서 Serial Port를 통신 인터페이스로 사용하는 경우 COM Port Number 목록에
서 장치가 연결된 COM 포트를 선택합니다.

• 장치에서 Ethernet을 통신 인터페이스로 사용하는 경우 관리자가 장치에 할당한 IP
Address를 입력하거나 주소의 해당 Host Name을 사용합니다.

• 장치에서 GPIB Board를 통신 인터페이스로 사용하는 경우 GPIB 보드에 대한 설정을
변경하지 마십시오.

장치에 대한 나머지 사전 설정 값은 대부분 적절합니다. 이러한 설정 값을 변경하지 마십
시오. Configuration 및 Communication 탭에 대한 자세한 정보는 도움말을 참조하십시오.

10. 장치 사전 설정 값을 복원하려면 Communication 탭에서 Set Defaults를 클릭합니다.

11. 구성을 저장하려면 OK를 클릭합니다.

12. 각 장치에 대해 4단계 ~ 11단계를 반복합니다.

13. Create New Hardware Profile 대화 상자에서 OK를 클릭합니다.

14. 하드웨어 프로필을 활성화하려면 다음을 수행합니다.

a. Hardware Configuration Editor에서 하드웨어 프로필을 클릭합니다.

b. Activate Profile을 클릭합니다.

확인 표시가 녹색이 됩니다. 빨간색 x가 표시되면 하드웨어 프로필 활성화에 문제가 있는
것입니다. 자세한 정보는 하드웨어 프로필 활성화 문제 해결 섹션을 참조하십시오.

팁! 다른 프로필을 활성화하기 전에 활성 하드웨어 프로필을 비활성화할 필요가 없습니
다. 비활성 하드웨어 프로필을 클릭한 후 Activate Profile을 클릭합니다. 그러면 다른 프
로필이 자동으로 비활성화됩니다.

15. Close를 클릭합니다.

하드웨어 프로필 활성화 문제 해결
하드웨어 프로필이 활성화되지 않으면 프로필에서 활성화하지 못한 장치를 나타내는 대화 상
자가 열립니다. 통신 오류 때문에 장치를 활성화되지 않을 수도 있습니다.

1. 생성된 오류 메시지를 읽습니다. 메시지에 따라 장치 또는 통신 설정 방법에 문제가 있을
수 있습니다.

2. 장치가 주 전원 공급 장치에 연결되어 있고 켜져 있는지 확인합니다.

작동 지침 — 하드웨어 프로필 및 프로젝트

TripleTOF 6600+ 시스템
40/138

시스템 사용자 안내서
RUO-IDV-05-8593-KR-D



3. 장치에 할당된 COM 포트가 올바른지 확인합니다.

4. DIP(이중 인라인 패키지) 스위치 설정과 같은 장치의 통신 설정이 올바르고
Communication 탭의 설정과 일치하는지 확인합니다.

5. 장치를 끕니다.

6. 10초 정도 기다립니다.

7. 장치를 켭니다.
장치에 대한 모든 전원 공급 동작이 완료될 때까지 기다렸다가 하드웨어 프로필을 다시
활성화합니다. 일부 장치의 경우 전원 공급 동작을 완료하는 데 30초 이상 걸릴 수 있습니
다.

8. 하드웨어 프로필을 활성화합니다.

9. 문제가 계속되면 실패한 프로필을 삭제하고 새 프로필을 생성합니다.

10. 그래도 문제가 계속되면 sciex.com/request-support로 이동합니다.

프로젝트 및 하위 프로젝트
실험을 시작하기 전에 실험과 관련된 파일을 저장할 위치를 결정합니다. 각 실험에 대한 프로
젝트 및 하위 프로젝트를 사용하여 데이터를 보다 효과적으로 관리하고 결과를 비교할 수 있
습니다. 예를 들면 하위 프로젝트를 사용하여 특정 날짜에 대한 결과를 저장할 수 있습니다.

프로젝트 및 하위 프로젝트 생성
프로젝트 내에서 하위 프로젝트 구조를 사용하려면 프로젝트가 생성될 때 하위 프로젝트를 생
성합니다.

1. Tools > Project > Create Project.를 클릭합니다.
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그림 5-6 새 프로젝트/하위 프로젝트 생성 대화 상자

참고: 원래 하위 프로젝트를 사용하여 생성된 것이 아닌 프로젝트에 대해서는 새 하위 프
로젝트를 생성할 수 없습니다.

2. Project name 필드에 프로젝트 이름을 입력합니다.

3. (선택 사항) 하위 프로젝트를 사용하려면 다음을 수행합니다.

a. 필요한 폴더를 선택한 후 화살표 버튼을 사용하여 Subproject folders 목록으로 이동
합니다.

b. Subproject name 필드에 첫 번째 하위 프로젝트 이름을 입력하거나 기존 날짜를 사
용합니다.

4. (선택 사항) 모든 새 프로젝트에 대해 이 프로젝트 및 하위 프로젝트 폴더 구성을 사용하려
면 Set configuration as default for new projects 확인란을 선택합니다.
모든 새 프로젝트가 이 폴더 구성으로 생성됩니다.

5. OK를 클릭합니다.
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하위 프로젝트 생성
하위 프로젝트는 기존 하위 프로젝트 구조가 있는 프로젝트에만 생성할 수 있습니다.

1. Project도구 모음의 Project목록에서 프로젝트를 선택합니다.

2. Tools > Project > Create Subproject를 클릭합니다.

3. Subproject name상자에 하위 프로젝트 이름을 입력하거나 기존 날짜를 사용합니다.

4. OK를 클릭합니다.

하위 프로젝트 복사
하위 프로젝트는 기존 하위 프로젝트를 포함하는 다른 프로젝트에서 복사할 수 있습니다. 복
사된 하위 프로젝트에 대상 프로젝트 폴더에도 있는 폴더가 포함된 경우 프로젝트 수준 폴더
가 사용됩니다.

1. Tools > Project > Copy Subproject.를 클릭합니다.
Copy Subproject 대화 상자가 열립니다.

2. Browse를 클릭하여 하위 프로젝트 소스를 찾습니다.

3. OK를 클릭합니다.

4. Source Subproject 목록에서 하위 프로젝트를 선택합니다.

5. Browse를 클릭하여 하위 프로젝트 대상을 찾습니다.

6. Target Subproject 필드에 이름을 입력합니다.

7. OK를 클릭합니다.

8. 다음 중 하나를 수행합니다.

• Subproject Source의 모든 폴더와 파일을 Subproject Destination에 복사하려면
Copy Contents 확인란을 선택합니다.

• 동일한 구조의 폴더만 Subproject Destination에 복사하려면 Copy Contents 확인란
의 선택을 취소해야 합니다.

9. Copy를 클릭합니다.

프로젝트와 하위 프로젝트 간 변경
소프트웨어 도구 모음의 프로젝트 목록에서 필요한 프로젝트 또는 하위 프로젝트를 클릭합니
다.
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그림 5-7 프로젝트 목록

이 그림의 프로젝트 목록에는 API Instrument, Default 및 Example 폴더가 표시됩니다.

설치된 프로젝트 폴더
API Instrument, Default 및 Example이라는 세 개의 프로젝트 폴더가 소프트웨어와 함
께 설치됩니다.

API Instrument 폴더
API Instrument 폴더는 고유하며 질량 분석계가 올바르게 작동하는 데 매우 중요합니다. API
Instrument 폴더에는 질량 분석계를 조정 및 교정하는 데 필요한 정보가 포함되어 있습니다.
이 정보에는 다음이 포함됩니다.

• 매개 변수 설정 파일

• 참조 파일

• 교정 및 분해능 정보를 포함하는 기기 데이터 파일

• 자동 조정 중에 사용되는 획득 방법

API Instrument 폴더에는 Acquire 버튼이 아니라 Start 버튼을 사용하여 수행된 수동 조정 실
행에 대한 데이터 파일도 포함됩니다. 이러한 데이터 파일은
API Instrument\Tuning Cache 폴더에 자동으로 저장되고 생성된 날짜 및 시간으로 이
름이 지정됩니다. Tuning Cache 폴더는 정기적으로 자동 삭제됩니다.

Default 폴더
Default 폴더에는 새 프로젝트에 있는 폴더가 포함되며 새 프로젝트용 템플릿으로 사용됩니다.

Example 폴더
Example 폴더에는 샘플 방법과 데이터 파일이 포함되어 있습니다. 예제 데이터 파일

API Instrument 폴더 백업
API Instrument 폴더는 정기적으로 백업하고 정기 유지보수를 수행한 후에도 백업하십시
오.

API Instrument 폴더를 복사하여 다른 위치(가급적 다른 컴퓨터)에 붙여 넣은 후 폴더 이름
을 변경합니다. 질량 분석계가 두 개 이상인 경우에는 폴더 이름을 지정할 때 날짜 및 질량 분
석계 참조를 사용합니다. 예를 들면 API Instrument_QT6500plus3_010121과 같습니다
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API Instrument 폴더 복구
API Instrument 폴더는 정기적으로 백업하고 정기 유지보수를 수행한 후에도 백업하십시
오.

1. 현재 API Instrument 폴더의 이름을 변경합니다.

2. 백업 폴더를 Projects 폴더에 복사합니다.

3. 백업 폴더의 이름을 API Instrument로 변경합니다.
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작동 지침 — 조정 및 교정 6
Verify Performance Only 옵션은 언제든지 실행할 수 있습니다. 하지만 감도 또는 분해능 손
실이 파악된 경우에만 기기를 조정합니다. 조정 및 교정에 대한 자세한 정보는 고급 사용자 안
내서를 참조하십시오.

시스템 조정의 경우 설치 키트와 함께 제공되는 다음 용액을 사용하십시오.

양성 모드의 경우:

• TOF MS - 생성 이온 고분해능 또는 생성 이온 고감도 최적화의 경우 조정 용액을 사용합니
다.

• Q1 교정의 경우 PPG POS 용액을 사용합니다.

음성 모드의 경우:

• TOF MS - 생성 이온 고분해능 또는 생성 이온 고감도 최적화의 경우 타우로콜린산을 사용
합니다.

참고: 타우로콜린산을 사용한 후에는 PPG POS 용액을 사용하여 채널 정렬을 반복하는 것
이 좋습니다.

• Q1 교정의 경우 PPG POS 용액을 사용합니다.

팁! 질량 분석계가 최적의 상태로 작동할 수 있도록 유지보수 작업을 정기적으로 수행하십시
오.

선행 조건

• 분무가 안정적이며 올바른 조정 용액을 사용 중입니다.

• 프린터가 구성되었습니다.

필요한 품목

• 시스템과 함께 제공되는 표준 화학 키트에 동봉된 조정 용액. 필요한 경우 SCIEX에서 새
키트를 주문할 수 있습니다.

• 기밀형 주사기(1mL 권장)

• 빨간색 PEEK 샘플 배관.

• (옵션) 주사기 펌프(통합 주사기 펌프가 없는 시스템을 사용하는 경우)
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질량 분석계 최적화
다음 절차에서는 질량 분석계의 성능을 확인하는 방법을 설명합니다. 다른 기기 성능 옵션의
사용에 대한 자세한 정보는 도움말을 참조하십시오.

1. 탐색 모음에서 Tune and Calibrate 아래의 Manual Tuning을 두 번 클릭합니다.

2. TOF MS 또는 생성 이온 스캔 유형을 실행한 후 안정적인 TIC가 있는지 그리고 관심 피크
가 스펙트럼에 있는지 확인합니다.

3. 탐색 모음에서 Tune and Calibrate 아래의 Instrument Optimization을 두 번 클릭합니
다.
Instrument Optimization 대화 상자가 열립니다.

4. 조정 용액을 선택합니다. 조정 용액이 참조 테이블과 일치하는지 확인합니다.

5. Verify Performance Only 확인란이 미리 선택되어 있습니다. Next를 클릭합니다.
이 예에서는 이 옵션을 선택한 상태로 둡니다. 보고서에 기기 조정이 필요하다고 나타나
면 기기 최적화를 다시 실행하고 최적화할 스캔 모드를 하나 이상 선택합니다.

6. 이온 소스 및 주사기 매개 변수가 적절한지 확인합니다.

참고: 사용자는 CDS를 사용하여 용액을 주입할 수도 있습니다. 조정 용액이 참조 테이블
의 구성과 일치하는지 확인합니다. 적절한 유속을 설정한 후 CDS 주입을 클릭합니다.

참고: Reference Table Editor에서 선택한 참조 테이블에 대해 올바른 Calibrant Valve
Position이 선택되어 있는지 확인합니다. CDS는 최대 4개의 다른 위치(A~D)를 선택할 수
있습니다.

7. GO를 클릭합니다.
Verifying or Adjusting Performance 화면이 열립니다. 프로세스가 완료되면 Results
Summary가 열립니다. 자세한 정보는 도움말을 참조하십시오.

성능 확인 또는 조정 대화 상자
왼쪽 위에 조정 중인 기기의 부분이 표시됩니다.

현재 스펙트럼 그래프에는 현재 스캔, 소프트웨어에서 선택한 최적 스캔 또는 소프트웨어 결
과를 대화식 모드로 볼 때 현재 매개 변수 값의 스캔에 대한 스펙트럼이 표시됩니다.

오른쪽 위 그래프의 Instrument Optimization Decision Plots에는 현재 최적화 중인 매개 변수
의 강도 대 전압 곡선이 동적으로 표시됩니다.

결과 요약
결과 요약은 Instrument Optimization 마법사에서 수행된 기기 설정 변경 내용을 기록한 것입
니다.
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그림 6-1 결과 요약: TripleTOF 6600 시스템

결과 요약은
<drive>:\Analyst Data\Projects\API Instrument\Data\Instrument
Optimization\yyyy-mm-dd\results.pdf 경로에 자동으로 저장됩니다. 여기서 yyyy-
mm-dd는 보고서가 생성된 날짜입니다. 사용자는 결과 요약을 인쇄하거나 이전에 저장한 결과
요약을 열 수 있습니다.
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작동 지침 — 획득 방법 7
획득 방법은 실험과 기간으로 구성됩니다. Acquisition Method Editor를 사용하여 활성 하드웨
어 프로필에 있는 질량 분석계 및 장치에 대한 일련의 기간 및 실험을 생성할 수 있습니다.

획득 방법은 질량 분석계의 방법과 LC(액체 크로마토그래피) 장치의 방법으로 구성됩니다.
Method Wizard를 사용하여 획득 방법을 쉽게 생성할 수 있습니다.

Acquisition Method Editor를 사용하여 획득 방법을 생성하고 기기 및 장치에 대한 일련의 기간
과 실험을 추가할 수도 있습니다.

Method Wizard와 Acquisition Method Editor에서 모두 이용할 수 있는 SWATH 획득 기능을 사
용하여 SWATH 획득 방법을 생성합니다. 또한 Method Wizard 또는 Acquisition Method Editor
를 사용하여 SWATH 가변 폭 기간 방법을 생성할 수도 있습니다. 자세한 정보는 고급 사용자
안내서, Analyst TF 도움말 및 Method Wizard 도움말을 참조하십시오.

방법 개발에 능숙한 사용자만 획득 및 정량화 방법을 생성하거나 수정할 것을 권장합니다. 역
할 및 보안에 대한 자세한 정보는 실험실 책임자 안내서 문서를 참조하십시오.

획득 방법 편집기를 사용하여 획득 방법 생성
팁! 기존 파일에서 새 획득 방법 파일을 생성하는 경우 획득 방법의 일부 또는 모든 주변 장치
방법을 사용할 수 있습니다.

활성 하드웨어 프로필에 구성된 장치만 Acquisition method 창에 표시됩니다. 하드웨어 프로필
에 추가된 장치를 기존 획득 방법에도 추가해야 합니다. 장치에 대한 자세한 정보는 주변 장치
설치 안내서 문서를 참조하십시오.

1. 질량 분석계 및 주변 장치를 포함하는 하드웨어 프로필이 활성 상태인지 확인합니다.

2. 탐색 모음에서 Acquire 아래의 Build Acquisition Method를 두 번 클릭합니다.

3. Acquisition Method Properties 탭에서 Synchronization Mode를 선택합니다.

4. (선택 사항) Auto-Equilibration 확인란을 선택한 후 필요한 평형화 시간(분)을 입력합니
다.

5. Acquisition Method 창에서 Mass Spec 아이콘을 클릭합니다.

6. MS 탭에서 Scan type을 선택합니다.

7. 필요에 따라 다른 필드에 값을 입력합니다.

8. Advanced MS 탭에서 필요에 따라 필드에 값을 입력합니다.

9. MS 탭에서 Edit Parameters를 클릭합니다.

10. Source/Gas 탭에서 필요에 따라 필드에 값을 지정합니다.

11. Compound 탭에서 필요에 따라 필드에 값을 지정합니다.

12. OK를 클릭합니다.
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13. 장치 아이콘을 클릭한 후 장치 매개 변수를 설정합니다.

14. 기간 및 실험을 더 추가합니다. 자세한 정보는 실험 추가 및 기간 추가 섹션을 참조하십시
오.

15. File > Save.를 클릭합니다.

실험 추가
1. Acquisition Method 창에서 실험을 추가할 기간을 마우스 오른쪽 버튼을 클릭한 후 Add

experiment를 클릭합니다.

그림 7-1 실험 추가

기간의 마지막 실험 아래에 실험이 추가됩니다.

참고: 실험, IDA 기준 또는 기간 사이에 실험을 삽입할 수 없습니다. 사용자는 기간 끝에만
실험을 추가할 수 있습니다.

2. MS 탭에서 적절한 매개 변수를 선택합니다.

기간 추가
Acquisition method창에서 Mass Spec 아이콘을 마우스 오른쪽 버튼으로 클릭한 다음 Add
period를 클릭합니다.
기간이 생성된 마지막 기간 아래에 추가됩니다.

참고: IDA 실험 하나에서 여러 기간을 사용할 수 없습니다.

실험을 기간으로 복사
1. 다중 기간 방법을 엽니다.

2. Acquisition method창에서 Ctrl 키를 누른 상태로 실험을 기간으로 끌어갑니다.
실험이 기간의 마지막 실험 아래에 복사됩니다.
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기간 내 실험 복사
매개 변수가 대부분 또는 모두 동일한 경우 이 절차를 이용하여 동일하거나 유사한 실험을 기
간에 추가할 수 있습니다.

실험을 마우스 오른쪽 버튼으로 클릭한 다음 Copy this experiment를 클릭합니다.
마지막으로 생성된 실험 아래에 실험 복사본이 추가됩니다.

방법 마법사를 사용하여 획득 방법 생성
획득 방법을 기존 프로젝트에 저장할 수 있습니다.

팁! Method Wizard 템플릿 방법을 프로젝트 폴더의 Acquisition Methods 폴더에 복사하려
면 Create New Project or Subproject 대화 상자의 Copy method templates 확인란을 선택
합니다. 이 대화 상자를 열려면 Tools > Project > Create Project or Create Subproject.를
클릭합니다.

1. 질량 분석계 및 주변 장치를 포함하는 하드웨어 프로필이 활성 상태인지 확인합니다.

2. 소프트웨어 도구 모음에서 적절한 프로젝트가 선택되었는지 확인합니다.

3. 탐색 모음의 Acquire 모드에서 Method Wizard를 두 번 클릭합니다.
Method Wizard가 열립니다.

팁! 커서를 인터페이스 위로 이동하면 도구 팁과 절차를 볼 수 있습니다.

4. Choose MS Method 목록에서 TOF MS (+)를 선택합니다.

5. Choose LC Method 목록에서 하드웨어 프로필에 대해 생성된 LC 방법을 선택합니다.

6. 방법 이름을 입력한 후 Enter 키를 누릅니다.

7. Next를 클릭합니다.

8. Ion Source Parameters 탭에서 값을 확인하고 필요한 경우 편집한 후 Next를 클릭합니
다.

9. TOF MS 탭에서 값을 확인하고 필요한 경우 편집한 후 Finish를 클릭합니다.

팁! 필요한 경우 Acquisition Method Editor를 사용하여 획득 방법을 추가로 편집할 수
있습니다. Acquire 모드에서 File > Open을 클릭한 후 Method Wizard를 사용하여 생성
한 방법을 엽니다.

다음 단계: 이제 새로 생성된 획득 방법을 사용하여 예비 분석을 위한 데이터를 획득할 수
있습니다.

스캔 기술
이 시스템은 액상 샘플 스트림에 대한 액체 크로마토그래피 질량 분광분석법 분석을 수행하여
화합물을 식별, 정량화 및 검사하는 안정된 다용도 시스템입니다.

이 시스템은 다음과 같은 질량 분광분석법 기술을 이용하여 샘플을 분석합니다.
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• 단일 질량 분광분석법(Mass Spectrometry, MS)의 두 가지 모드:

• 사극자 기반 단일 질량 분광분석법(Q1 교정에만 해당)

• 비행 시간법 기반 단일 질량 분광분석법

• 두 가지 모드의 직렬식 질량 분광분석법(MS/MS):

• 생성 이온 질량 분광분석법

• 전구체 이온 질량 분광분석법

단일 질량 분광분석법
단일 MS(질량 분광분석법) 분자량과 검출된 이온의 양을 찾기 위해 대전된 분자를 분석하는
데 사용됩니다. MS에서 검출된 개별 이온은 대상 분석 물질의 존재 여부를 나타낼 수 있습니
다.

사중극자 기반 단일 질량 분광분석법
사극중자 기반 단일 질량 분광분석법(Q1 MS) 스캔에서는 시스템이 기존의 사극중자 질량 분
석계로 작동합니다. 이 모드에서 시스템은 기기의 Q1(첫 번째 사중극자) 섹션을 사용하여 단
일 질량 스펙트럼 정보를 생성합니다.

TOF 단일 질량 분광분석법
TOF MS(Time-of-Flight 단일 질량 분광분석법) 스캔에서 시스템은 이온을 비행 튜브 안으로
펄싱하고 검출기에서 정확한 도착 시간을 기록하여 질량 스펙트럼 정보를 생성합니다. 이온의
질량 대 전하비가 클수록 비행 튜브를 이동하는 데 시간이 더 오래 걸립니다.

직렬 질량 분광분석법
생성 이온의 m/z 비율이 고유하다고 가정할 때 MS/MS 기법은 다른 성분의 간섭 없이 혼합물
의 각 성분에 대해 특징적인 생성 이온 스펙트럼을 얻을 수 있으므로 분석을 결합하기에 매우
적합합니다.

샘플이 용리되는 동안 특정 전구체/생성 이온을 모니터링하는 방식으로 특화된 분석에 대해
MS/MS를 사용하십시오. 이 분석 유형은 단일 MS보다 더 구체적입니다. 단일 MS의 경우 질량
대 전하비에 따라서만 구별합니다.

생성 이온 질량 분광분석법
생성 이온 스캔(Product Ion)에서 시스템은 Q1에서 특정 전구체 이온 범위를 선택하고,
Q2(충돌 셀)에서 단편화한 후 이온(단편 이온)을 비행 튜브 안으로 펄싱하고, 검출기에서 정확
한 도착 시간을 기록하는 방법을 통해 질량 스펙트럼 정보를 생성합니다. 생성 이온은 원래(전
구체) 이온의 분자 구조에 대한 정보를 제공할 수 있습니다.

전구체 이온 질량 분광분석법
전구체 이온 스캔에서는 특정 생성 이온을 생성하는 전구체 이온이 검출됩니다. 기기가 질량
분해 모드에서 Q1을 사용하여 관심 질량 범위를 스캔하는 동안 각 전구체 이온에 대한 생성 이
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온 스펙트럼이 TOF 섹션에 기록됩니다. Q1 질량 스펙트럼에는 관심 생성 이온을 생성하는 모
든 전구체 이온이 표시됩니다.

스펙트럼 데이터 획득 정보
스펙트럼 데이터를 획득할 수 있는 모드에 대한 설명은 테이블 표 7-1에서 확인하십시오.

스펙트럼 데이터는 Q1 및 전구체 이온 스캔 유형에서만 획득할 수 있습니다.

표 7-1 스펙트럼 데이터

모드 설명

프로필 사전 설정 값은 0.1 Da입니다. 프로필 데이터는 질량 분석계에서 생성된
데이터이며 균등한 간격의 개별 질량 값에서 기록된 강도에 해당합니다.
예를 들어 질량 범위가 100Da ~ 200Da이고 스텝 크기가 0.1인 경우 기기
는 100Da에서 200Da까지 0.1Da 단위로 증분하여 스캔합니다(예: 최대
200.0까지 100.0, 100.1, 100.2, 100.3 등).

피크 호핑 사전 설정 값은 1.0 Da입니다. 피크 호핑은 큰 스텝(약 1Da)이 설정되는
질량 분석계의 작동 모드입니다. 빠른 속도(데이터 단계가 더 적음)가 장
점이지만 피크 모양 정보가 손실됩니다.

MS 매개 변수
작업 매개 변수는 현재 사용 중인 질량 분석계(MS) 매개 변수의 집합입니다.

화합물 매개 변수와 소스 및 가스 매개 변수는 방법과 함께 저장됩니다. 분해능 및 검출기 매개
변수는 질량 분석계에 종속적이며 기기 데이터로 저장됩니다. 조정 및 교정 모드를 사용하여
방법을 생성하는 경우 최상의 기기 성능을 위해 작업 매개 변수를 최적화할 수 있습니다. 아니
면 실험을 순환하는 동안 한 번에 하나씩 각 매개 변수를 증가하십시오.

• 소스 및 가스 매개 변수: 이러한 매개 변수는 사용되는 이온 소스에 따라 변경될 수 있습니
다.

• 화합물 매개 변수: 이러한 매개 변수는 대부분 이온 경로의 전압으로 구성됩니다. 화합물 종
속 매개 변수의 최적 값은 분석 중인 화합물에 따라 다릅니다.

• 분해능 매개 변수: 이러한 매개 변수는 분해능과 교정에 영향을 줍니다.

• 검출기 매개 변수: 이러한 매개 변수는 검출기에 영향을 줍니다. 다중 채널 플레이트는 TOF
기기의 검출기이며 이온 검출을 위한 4개의 채널로 구성됩니다. 채널의 합계는 이온 강도와
같습니다. Instrument Optimization을 사용하여 이 매개 변수를 최적화할 수 있습니다.

이 표의 매개 변수는 시스템과 함께 제공되는 이온 소스에 적용됩니다. 다른 이온 소스에 대한
자세한 정보는 이온 소스와 함께 제공되는 작업자 안내서를 참조하십시오. 다음 그림은 이온
광학장치 경로에서 매개 변수의 위치를 보여줍니다.
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그림 7-2 이온 광학장치 경로 및 매개 변수

위치 매개 변수 매개 변수
유형

용도 스캔 유형

1 IonSpray
Voltage
Floating(IS
VF)

소스와 가
스

ISVF 매개 변수는 분무 안정성, 즉 신
호 감도에 영향을 줍니다. 이 매개 변수
는 샘플을 분사하는 바늘에 적용되는
전압입니다.

모두

1 Ion Source
Gas
1(GS1)

소스와 가
스

GS1 매개 변수는 ESI 프로브의 분무기
가스를 제어합니다.

모두

1 Ion Source
Gas
2(GS2)

소스와 가
스

GS2 매개 변수는 ESI 프로브의 히터
가스와 APCI 프로브의 분무기 가스를
제어합니다.

모두

1 Temperatur
e(TEM)

소스와 가
스

TEM 매개 변수는 TurboIonSpray 프로
브에 대한 히터 가스 온도 또는 APCI
프로브 온도를 제어합니다.

모두
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위치 매개 변수 매개 변수
유형

용도 스캔 유형

1 Curtain
Gas(CUR)

소스와 가
스

CUR 매개 변수는 Curtain Gas 인터페
이스의 가스 유량을 제어합니다.
Curtain Gas 인터페이스는 커튼 플레
이트와 오리피스 사이에 있습니다. 이
인터페이스는 이온 광학장치의 오염을
방지합니다.

모두

1 Declusterin
g
Potential(D
P)

화합물 DP 매개 변수는 오리피스의 전압을 제
어함으로써, 오리피스와 QJet 이온 가
이드 사이의 이온을 디클러스터링하는
기능을 제어합니다. 진공 챔버로 들어
간 이후 샘플 이온에 남아 있을 수 있는
용매 클러스터를 최소화하고 필요할
경우 이온을 단편화하는 데 사용됩니
다. 전압이 높을수록 이온에 전달되는
에너지도 커집니다. DP 매개 변수가
너무 높으면 원치 않는 단편화가 발생
할 수 있습니다.

사전 설정 값을 사용하고 화합물에 대
해 최적화하십시오.

모두

2 CAD Gas 소스와 가
스

CAD 매개 변수는 충돌 셀에서 CAD 가
스의 압력을 제어합니다. 충돌 가스는
Q2 충돌 셀을 통과하는 이온을 집속하
는 데 도움이 되며 CAD 매개 변수의
사전 설정 값은 고정 모드입니다.
MS/MS 스캔 유형의 경우 CAD 가스는
전구체 이온을 단편화하는 데 도움이
됩니다. 전구체 이온이 충돌 가스와 충
돌할 때 이온이 분리되어 생성 이온을
형성합니다.

사전 설정 값을 사용하고 화합물에 대
해 최적화하십시오.

모두
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위치 매개 변수 매개 변수
유형

용도 스캔 유형

2 Collision
Energy(CE)

화합물 CE 매개 변수는 Q0 영역과 Q2 충돌 셀
사이의 전위차를 제어합니다. 이 매개
변수는 MS/MS 스캔 유형에서만 사용
됩니다. 이 매개 변수는 전구체 이온이
Q2 충돌 셀에서 가속화될 때 수신하는
에너지 양입니다. 충돌 셀에서 전구체
이온은 가스 분자와 충돌하고 단편화
됩니다.

사전 설정 값을 사용하고 화합물에 대
해 최적화하십시오.

TOF MS,
TOF
MS/MS

2 Collision
Energy
Spread(CE
S)

화합물 CES 매개 변수는 CE 매개 변수와 함
께 사용되어 생성 이온 스캔에서 전구
체 질량에 적용되는 세 가지 개별 충돌
에너지를 결정합니다. 충돌 에너지는
낮은 값에서 높은 값으로 증가합니다.
예를 들어 양성 모드에서는 충돌 에너
지가 CE – CES에서 CE + CES로 증가
합니다. CES 값을 입력하면 충돌 에너
지 확산이 자동으로 켜집니다.

사전 설정 값을 사용하고 화합물에 대
해 최적화하십시오.

TOF
MS/MS

3 Ion
Release
Delay(IRD)

화합물 이온 펄스 전의 시간(밀리초)입니다.
기본값(11msec)은 TOF 질량을 기준으
로 계산되며 작업자가 조정할 수 있습
니다. 범위는 일반적으로
6msec~333msec입니다.

이 매개 변수는 Advanced 옵션에서
Enhanced Ion 옵션을 선택한 경우
Instrument Optimization 마법사를
사용하여 최적화됩니다. 일반적으로
기본값을 변경할 필요는 없습니다.

MS/MS만,
고급
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위치 매개 변수 매개 변수
유형

용도 스캔 유형

3 Ion
Release
Width(IRW)

화합물 이 매개 변수는 이온 펄스의 폭 또는 기
간(밀리초)이며 IRD를 기준으로 계산
됩니다. 범위는 일반적으로
5msec~328msec이며 기본값은
10msec입니다.

이 매개 변수는 Advanced 옵션에서
Enhanced Ion 옵션을 선택한 경우
Instrument Optimization 마법사를
사용하여 최적화됩니다. 일반적으로
기본값을 변경할 필요는 없습니다.

MS/MS만,
고급

4 MCP(CEM) 검출기 CEM 매개 변수는 검출기에 적용되는
전압을 제어합니다. 이 전압은 검출기
응답에 영향을 줍니다.

모두
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작동 지침 — Batches 8
주의: 잠재적 시스템 손상. 질량 분석계에 연결된 LC 시스템이 소프트웨어에 의해 제어되지
않는 경우 질량 분석계를 무인 상태로 작동하지 마십시오. 질량 분석계가 Standby 상태가 되
면 LC 시스템의 액체 스트림으로 인해 이온 소스가 넘칠 수 있습니다.

배치는 분석할 샘플에 대한 정보 모음입니다. 일반적으로 샘플은 제출을 간소화하기 위해 세
트로 그룹화됩니다. 샘플을 하나의 세트로 그룹화하면 수동으로 입력해야 하는 데이터의 양
또한 감소시킵니다. 세트는 단일 샘플 또는 여러 샘플로 구성될 수 있습니다. 배치 내의 모든
세트는 같은 하드웨어 프로필을 사용합니다. 그러나 세트 내의 샘플 들은 각기 다른 획득 방법
을 가질 수 있습니다. 배치는 획득 컴퓨터에서만 제출할 수 있습니다.

배치에 다음 정보가 포함됩니다.

• 이름, ID 및 설명과 같은 샘플 정보

• 오토샘플러 랙 정보, 바이알 위치 및 주입량

• 획득 방법

• 처리 방법 또는 스크립트(선택 사항)

• 정량화 정보(선택 사항)

• 사용자 지정 샘플 데이터(선택 사항)

• 세트 정보

대기열 옵션 설정
소프트웨어에서는 대기열의 샘플 목록을 하나씩 살펴보고 선택한 획득 방법으로 각 샘플을 획
득합니다. 모든 샘플이 획득된 후 대기열 옵션에 설정된 Max. Idle Time이 경과하면 획득이 중
지되고 질량 분석계가 Standby(대기) 상태로 전환됩니다. Standby(대기) 상태에서는 LC 펌프
가 중지되고 일부 기기 전압이 꺼집니다.

사용자는 마지막 샘플 획득과 Standby(대기) 상태로 전환 사이의 시간을 변경할 수 있습니다.
Queue Options 대화 상자의 다른 필드에 대한 자세한 정보는 도움말 문서를 참조하십시오.

1. 탐색 모음에서 Configure를 클릭합니다.

2. Tools > Settings > Queue Options.를 클릭합니다.
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그림 8-1 대기열 옵션 대화 상자

3. Max. Num. Waiting Samples 필드에서 최대 샘플 수를 대기열에 제출할 샘플 수보다 큰
값으로 설정합니다.

4. Max. Idle Time 필드에 획득이 완료된 후 Standby(대기) 상태로 전환될 때까지 기다리는
시간을 입력합니다. 사전 설정 값은 60분입니다.

가스 실린더를 사용하는 경우 실린더의 가스가 고갈되지 않도록 이 시간을 조정하십시오.

LC 방법을 사용하는 경우 실행을 시작하기 전에 1차 유속 및 최대 유휴 시간에서 모든 샘
플이 실행될 수 있도록 저장소에 충분한 용매가 있는지 확인하십시오.

5. Leave Mass Spec on in Standby 확인란을 선택하여 분석이 완료된 후에도 질량 분석계
가 계속 실행되도록 설정합니다.
이 기능을 사용하면 장치가 유휴 상태로 전환된 후에도 히터와 가스가 계속 작동하여 이
온 소스와 질량 분석계 입구의 오염을 방지할 수 있습니다.

6. Fail Whole Batch in Case of Missing Vial 확인란을 선택하여 바이알이 없는 경우 전체
배치가 실패하도록 설정합니다.
이 옵션을 선택하지 않으면 현재 샘플만 실패하고 소프트웨어에서 다음 샘플로 작업을 계
속합니다.

7. Fail Whole Batch if Auto Calibration Fails 확인란을 선택하여 자동 교정이 실패할 경우
배치를 중지하도록 설정합니다.
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8. Keep Calibration Data File 확인란을 선택하여 샘플을 제출하는 프로젝트에 대한 Data
폴더의 하위 폴더에 교정 데이터 파일을 유지하도록 설정합니다.

9. Continue Whole Batch if Missing Sync found 확인란을 선택하여 동기화 신호 누락이
발생할 경우에도 전체 배치 획득을 계속하도록 설정합니다. 이 확인란을 선택하지 않으면
이 신호가 발생할 경우 현재 샘플이 실패하고 대기열이 다음 샘플로 진행되지 않습니다.

배치에 세트 및 샘플 추가
세트는 단일 샘플 또는 여러 샘플로 구성될 수 있습니다.

참고: 배치에 정량화 정보를 추가하는 방법에 대한 자세한 정보는 고급 사용자 안내서 문서를
참조하십시오.

1. 탐색 모음에서 Acquire 아래의 Build Acquisition Batch을 두 번 클릭합니다.

그림 8-2 배치 편집기 대화 상자

2. Sample 탭의 Set 목록에서 이름을 입력합니다.

3. Add Set를 클릭합니다.

4. Add Samples를 클릭하여 새 세트에 샘플을 추가합니다.
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그림 8-3 샘플 추가 대화 상자

5. Sample name 섹션의 Prefix 필드에 이 세트의 샘플 이름을 입력합니다.

6. 샘플 이름 끝에 증분 번호를 추가하려면 Sample number 확인란을 선택합니다.

7. Sample number 확인란을 선택한 경우 Number of digits 필드에 샘플 이름에 포함할 자
릿수를 입력합니다.
예를 들어 3을 입력하면 샘플 이름이 samplename001, samplename002,
samplename003이 됩니다.

8. Data file 섹션의 Prefix 필드에 샘플 정보를 저장할 데이터 파일의 이름을 입력합니다.

9. Set name 확인란을 선택하여 세트 이름을 데이터 파일 이름의 일부로 사용합니다.

10. Auto Increment 확인란을 선택하여 데이터 파일 이름을 자동으로 증가시킵니다.

참고: 각 샘플에 대한 데이터를 동일한 데이터 파일 또는 별도의 데이터 파일에 저장할 수
있습니다. 데이터 파일 이름에는 1부터 시작하는 숫자 접미사가 붙습니다.

11. Sub Folder 필드에 이름을 입력합니다.
해당 폴더가 현재 프로젝트의 Data 폴더에 저장됩니다. Sub Folder 필드를 비워두면 데
이터 파일이 Data 폴더에 저장되고 하위 폴더가 생성되지 않습니다.

12. New samples 섹션의 Number 필드에 추가할 새 샘플 수를 입력합니다.

13. OK를 클릭합니다.
샘플 테이블에 샘플 이름 및 데이터 파일 이름이 입력됩니다.

팁! Fill Down 및 Auto Increment 옵션은 단일 열 머리글 또는 열의 여러 행을 선택한 후
마우스 오른쪽 버튼 클릭 메뉴에서 사용할 수 있습니다.
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14. Sample 탭의 Acquisition 섹션에 있는 목록에서 방법을 선택합니다.
시스템 설정 방식에 따라 오토샘플러에 대한 특정 정보를 입력해야 합니다. 주입량이 방
법에 설정되어 있더라도 사용자가 주입량 열의 값을 변경하여 하나 이상의 샘플에 대한
주입량을 변경할 수 있습니다.

참고: 이 세트의 일부 샘플에 대해 다른 방법을 사용하려면 Use Multiple Methods 확인
란을 선택합니다. 그러면 Acquisition Method 열이 Sample 테이블에 표시됩니다. 이 열
의 각 샘플에 대한 획득 방법을 선택합니다.

15. 방법에 나열된 양에서 주입량을 변경하려면 Inj. Volume (µL) 열에 각 샘플의 주입량을 입
력합니다.

16. 샘플 위치를 설정하려면 다음 중 하나를 수행합니다.

• 배치 편집기에서 샘플 위치 설정

• 위치 탭에서 바이알 위치 선택(선택 사항)

17. Submit 탭을 엽니다.

참고: 샘플을 대기열에 제출하기 전에 샘플 순서를 편집할 수 있습니다. 샘플 순서를 변경
하려면 Submit 탭에서 테이블 맨 왼쪽에 있는 번호(매우 작은 정사각형이 표시됨)를 두 번
클릭한 후 새 위치로 끌어옵니다.

18. Submit Status 섹션에 배치 상태에 대한 메시지가 포함된 경우 다음 중 하나를 수행합니
다.

• 배치 제출 준비가 완료되었다는 메시지가 표시되면 19단계로 이동합니다.

• 배치 제출 준비가 완료되지 않았다는 메시지가 표시되면 메시지에 설명된 대로 변경합
니다.

19. 모든 배치 정보가 올바른지 확인한 후 Submit을 클릭합니다.
배치가 대기열에 제출되고 대기열 관리자에서 볼 수 있습니다.

20. 파일을 저장합니다.

샘플 또는 샘플 세트 제출
참고: 샘플 획득 중 비정상적인 종료가 발생하면 샘플을 다시 실행하십시오. 전원 오류로 인해
비정상 종료가 발생하면 오토샘플러 트레이 온도가 유지되지 않으며 샘플 무결성이 손상될 수
있습니다.

1. 하나의 샘플이나 일련의 샘플을 선택합니다.

2. Batch Editor에서 Submit 탭을 엽니따.

3. Submit Status 그룹에 배치 상태에 대한 메시지가 포함된 경우 다음 중 하나를 수행합니
다.

• 배치 제출 준비가 완료되었다는 메시지가 표시되면 다음 단계로 이동합니다.

• 배치 제출 준비가 완료되지 않았다는 메시지가 표시되면 메시지에 설명된 대로 변경합
니다.
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4. Submit를 클릭합니다.

샘플 교정 설정
샘플이 배치 모드에서 획득되는 동안 소프트웨어에서 외부 자동 교정을 자동으로 예약하여 실
행할 수 있습니다. 이렇게 하면 획득 프로세스 전체에 대해 질량 정확도가 양호하게 유지됩니
다.

CDS를 구성하지 않은 경우 교정은 오토샘플러를 사용하여 수행되고 사용자는 교정 방법
(*.dam) 및 교정물질 샘플의 바이알 위치를 제공해야 합니다.

1. Batch Editor에서 Calibrate 탭을 클릭합니다.

2. Calibrate Every _ Samples 필드에 교정 샘플 사이에 획득할 샘플 수를 입력합니다.

3. Calibrant Reference Table에서 현재 극성에 대해 사용할 수 있는 모든 교정물질 참조 테
이블 목록에 있는 테이블을 선택합니다. 선택한 참조 테이블에 올바른 Calibrant Valve
Position이 있는지 확인합니다.

4. CDS Inject Flow Rate를 설정합니다.
배치가 제출될 때 교정 샘플이 대기열에 삽입됩니다. 각 세트는 교정 샘플로 시작합니다.
교정 방법 이름은 AnalystCal_ + 획득 방법 이름입니다(예: AnalystCal_TOF.dam). CDS를
구성한 경우 대기열의 다음 샘플에 사용되는 획득 방법과 일치하는 교정 방법이 자동으로
생성됩니다. 교정 데이터가 각 교정 샘플에 대한 별도의 데이터 파일에 저장됩니다.
Queue Options 대화 상자에서 Keep Calibration Data File을 선택한 경우 교정 보고서와
함께 교정 데이터 파일이 Cal Data 하위 폴더에 저장되고 Cal, 타임스탬프 및 교정 샘플 인
덱스를 사용하여 이름이 지정됩니다(예: Cal200906261038341.wiff). 교정 보고서 이름은
Cal, 타임스탬프, 교정 샘플 인덱스 및 report라는 단어를 사용하여 지정됩니다(예:
Cal20130822154447030_report.txt). 보고서에는 피크 찾기 기준, 매개 변수 및 교정에 사
용되는 질량이 표시됩니다. 보고서는 교정 성공 여부를 사용자에게 알려줍니다. 또한 교
정에 사용되는 매개 변수도 요약되어 있습니다.

샘플 순서 변경
샘플을 Queue에 제출하기 전에 순서를 변경할 수 있습니다.

Submit 탭에서 테이블 맨 왼쪽에 있는 번호(매우 작은 정사각형이 표시됨)를 두 번 클릭한 후
새 위치로 끌어옵니다.

데이터 획득
샘플 획득이 시작될 때 소프트웨어가 조정 및 교정 모드에 있으면 안 됩니다. 또한 시스템이 그
이전에 실행되었고 아직 Standby(대기) 상태로 설정되지 않은 경우 샘플 획득이 자동으로 시
작됩니다.

1. 컬럼 오븐 온도에 도달했는지 확인합니다.

2. Reserve Instrument for Tuning ( ) 아이콘이 눌려져 있지 않은지 확인합니다.

3. 탐색 모음에서 Acquire를 클릭합니다.
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4. View > Sample Queue.를 클릭합니다.
제출된 모든 샘플과 함께 Queue Manager가 열립니다.

그림 8-4 대기열 관리자

항목 설명

1 Reserve Instrument for Tuning 아이콘을 누르면 안 됩니다.

2 대기열 상태는 Ready(준비)여야 합니다.

3 Queue Server 상태는 Normal(일반)이어야 합니다. 자세한 정보는 대기
열 상태 섹션을 참조하십시오.

5. Acquire > Start Sample.을 클릭합니다.

배치 편집기에서 샘플 위치 설정
획득 방법에 오토샘플러가 사용되는 경우 획득 배치에 샘플의 바이알 위치를 정의해야 합니
다. Sample 탭 또는 Locations 탭에서 위치를 정의합니다. 배치를 생성하는 방법에 대한 자세
한 정보는 배치에 세트 및 샘플 추가 섹션을 참조하십시오.

1. Sample 탭의 Set 목록에서 세트를 선택합니다.

2. 해당되는 경우 세트의 각 샘플에 대해 다음을 수행합니다.

• Rack Code 열에서 랙 유형을 선택합니다.

• Rack Position 열에서 오토샘플러의 랙 위치를 선택합니다.

• Plate Code 열에서 플레이트 유형을 선택합니다.

• Plate Position 열에서 랙의 플레이트 위치를 선택합니다.

• Vial Position 열에서 플레이트 또는 트레이의 바이알 위치를 입력합니다.

3. 파일을 저장합니다.

위치 탭에서 바이알 위치 선택(선택 사항)
1. Batch Editor에서 Locations 탭을 엽니다.

2. Set 목록에서 세트를 선택합니다.

3. Autosampler 목록에서 오토샘플러를 선택합니다.

4. 랙과 연결된 공간에서 마우스 오른쪽 버튼을 클릭한 후 랙 유형을 선택합니다.
플레이트 또는 트레이가 랙에 표시됩니다.
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5. 랙 유형이라고 레이블이 지정된 공백을 두 번 클릭합니다. 시각적 샘플 랙 레이아웃이 표
시됩니다.
오토샘플러에 대한 적절한 랙 공간 수가 그래픽 랙 보기에 표시됩니다.

6. 사각형 중 하나를 두 번 클릭합니다.
플레이트 또는 트레이의 웰이나 바이알을 나타내는 원이 표시됩니다.

팁! 그래픽 표현에서 해당 바이알 번호를 보려면 샘플 위치 위로 커서를 이동합니다. 이 정
보를 사용하여 소프트웨어의 바이알 위치가 오토샘플러의 바이알 위치와 일치하는지 확
인합니다.

그림 8-5 위치 탭

참고: 사용 중인 오토샘플러에 따라 추가 열에 세부 정보를 입력할 필요가 없을 수도 있습
니다.

7. 샘플을 행으로 표시할지 아니면 열로 표시할지를 선택하려면 Row/Column selection 선
택기 버튼을 클릭합니다.
버튼에 빨간색 가로선이 표시되는 경우 Batch Editor에서 샘플이 행별로 표시됩니다. 버튼
에 빨간색 세로선이 표시되는 경우 Batch Editor에서 샘플이 열별로 표시됩니다.

8. 샘플 웰 또는 바이알을 분석 순서대로 클릭합니다.

팁! 지우려면 선택한 웰 또는 바이알을 다시 클릭합니다.

팁! 샘플을 자동으로 채우려면 Shift 키를 누른 채 세트의 첫 번째 바이알과 마지막 바이알
을 클릭합니다. 동일한 바이알에서 여러 번 주입하려면 Ctrl 키를 누른 채 바이알 위치를
클릭합니다. 빨간색 원이 녹색 원으로 변경됩니다.

샘플 획득 중지
샘플 획득이 중지되면 소프트웨어에서 획득을 중지하기 전에 현재 스캔을 완료합니다.

1. Queue Manager의 대기열에서 획득을 중지할 지점 이후의 샘플을 클릭합니다.

2. 탐색 모음에서 Acquire를 클릭합니다.

3. Acquire > Stop Sample.을 클릭합니다.
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선택한 샘플의 현재 스캔이 획득된 후 획득이 중지됩니다. Queue Manager (Local) 창의
샘플 상태가 Terminated로 변경되고 대기열에서 다음에 나오는 다른 모든 샘플이
Waiting 상태가 됩니다.

4. 배치를 계속 처리하려면 Acquire > Start Sample.을 클릭합니다.

대기열 상태와 장치 상태
Queue Manager에는 대기열, 배치 및 샘플 상태가 표시됩니다. 대기열의 특정 샘플에 대한 세
부 정보도 볼 수 있습니다.

팁! 대기열을 표시하려면 View Queue( )를 클릭합니다.

Queue 오른쪽 클릭 메뉴 사용에 대한 자세한 정보는 대기열 섹션을 참조하십시오.

대기열 상태
대기열의 현재 상태가 Queue Server 그룹에 표시됩니다.

그림 8-6 일반 모드를 표시하는 대기열 서버 표시기

그림 8-7 조정 모드를 표시하는 대기열 서버 표시기

첫 번째 아이콘은 대기열 상태를 나타냅니다. 두 번째 아이콘은 대기열이 조정을 위한 Tune(조
정) 모드인지 아니면 샘플 실행을 위한 Normal(일반) 모드인지를 나타냅니다. 아이콘 및 대기
열 상태에 대한 설명은 표 8-1에서 확인하십시오.

표 8-1 대기열 상태

아이콘 상태 정의

Not
Ready

하드웨어 프로필이 비활성화되고 대기열에서 샘플
제출을 허용하지 않습니다.

Stand By 하드웨어 프로필이 활성화되었지만 모든 장치가 유
휴 상태입니다. 펌프가 작동하지 않으며 가스가 꺼
져 있습니다.
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표 8-1 대기열 상태 (계속)

아이콘 상태 정의

Warming
Up

질량 분석계와 장치가 평형화되고 컬럼이 조절되며
오토샘플러 바늘이 세척되고 컬럼 오븐이 온도에 도
달합니다. 평형화 기간은 작업자가 선택합니다. 이
상태부터는 시스템이 Ready 상태로 전환될 수 있습
니다.

Ready 시스템에서 샘플 실행을 시작할 준비가 완료되었으
며 장치가 평형화되었고 실행 준비가 완료되었습니
다. 이 상태에서는 대기열이 샘플을 수신할 수 있고
샘플이 제출된 후 실행됩니다.

Waiting 다음 샘플이 제출되면 시스템에서 자동으로 획득이
시작됩니다.

PreRun 방법을 각 장치로 다운로드 중이며 장치가 평형화되
고 있습니다. 이 상태는 배치의 각 샘플을 획득하기
전에 발생합니다.

Acquiring 방법이 실행되고 데이터 획득이 발생합니다.

Paused 시스템이 획득 중에 일시 중지되었습니다.

기기 및 장치 상태 아이콘 보기
활성 하드웨어 구성의 질량 분석계 및 각 장치를 나타내는 아이콘은 창 오른쪽 아래에 있는 상
태 표시줄에 표시됩니다. 사용자는 LC 펌프의 세부 상태를 검토하여 LC 펌프 압력이 적절한지
확인하거나 질량 분석계의 세부 상태를 검토하여 이온 소스 온도를 모니터링할 수 있습니다.

참고: 각 상태에 대해 배경색이 빨간색일 수 있습니다. 빨간색 배경은 해당 상태에서 장치에 오
류가 발생했음을 나타냅니다.

상태 표시줄에서 장치 또는 질량 분석계의 아이콘을 두 번 클릭합니다.
Instrument Status 대화 상자가 열립니다.
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표 8-2 기기 및 장치 상태 아이콘

상태 아이콘 배경색 설명

유휴
 

녹색 또는 노
란색

장치가 실행되고 있지 않습니다. 배경색이 노
란색이면 실행 준비가 완료되기 전에 장치를
평형화해야 합니다. 배경색이 녹색이면 장치
를 실행할 수 있습니다.

평형화 중
 

녹색 또는 노
란색

장치 평형화가 진행 중입니다.

대기 중 녹색 장치가 소프트웨어 또는 다른 장치의 명령이
나 작업자의 조작을 기다리고 있습니다.

실행 중 녹색 장치에서 배치를 실행 중입니다.

중단 중 녹색 장치에서 실행을 중단하는 중입니다.

다운로드 중 녹색 방법을 장치로 전송하는 중입니다.

준비 녹색 장치가 실행되고 있지 않지만 실행 준비가 완
료되었습니다.

오류 빨간색 장치에서 살펴보아야 할 오류가 발생했습니
다.
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작동 지침 — 데이터 분석 및 탐색 9
Example 폴더에 설치된 샘플 파일을 사용하면 가장 일반적인 분석 및 처리 도구로 데이터를
검토하고 분석하는 방법을 학습할 수 있습니다. 다음 항목에 대한 자세한 정보는 고급 사용자
안내서 문서를 참조하십시오.

• 그래프에 레이블 지정

• 스펙트럼 또는 크로마토그램 오버레이 및 합산

• 배경 감산 수행

• 다듬기 알고리즘

• 다듬기 처리된 데이터 작업

• 중심 데이터 작업

• 등고선 플롯 작업

• 단편 해석 도구 작업

• 라이브러리 데이터베이스 및 라이브러리 레코드 작업

데이터 파일 열기
팁! 질량 스펙트럼에 대한 자동 업데이트를 끄려면 질량 스펙트럼을 마우스 오른쪽 버튼으로
클릭한 다음 Show Last Scan을 클릭합니다. Show Last Scan 옆에 확인 표시가 있는 경우
스펙트럼이 실시간으로 업데이트됩니다.

1. Navigation 모음의 Explore에서 Open Data File을 두 번 클릭합니다.
Select Sample 대화 상자가 나타납니다.

2. Data Files 목록에서 열 데이터 파일로 이동하고 샘플을 선택한 다음에 OK를 클릭합니다.
샘플에서 획득한 데이터가 표시됩니다. 데이터를 여전히 획득 중인 경우 질량 스펙트럼,
DAD/UV 추적선 및 TIC가 계속 자동으로 업데이트됩니다.

팁! 예제 데이터 파일을 표시하기 위해 Example 프로젝트가 선택됩니다. TOF 폴더를 열
고 나서 TOFMS PPGs3000.wiff 파일을 엽니다. Sample 목록에서 TOFMS를 선택합니다.

데이터 파일에서 샘플 간 이동
참고: 개별 데이터 파일에 샘플이 저장된 경우 각 파일을 개별적으로 여십시오.

이 절차에 사용되는 탐색 아이콘에 대한 설명은 표 C-4에서 확인하십시오.

여러 개의 샘플이 포함된 데이터 파일을 연 후 다음 중 하나를 수행합니다.

• 데이터 파일의 다음 샘플로 건너뛰려면 Show Next Sample 아이콘( )을 클릭합니다.
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• 비순차 샘플로 건너뛰려면 Go to Sample 아이콘( )을 클릭합니다.

• Select Sample 대화 상자의 Sample 목록에서 보려는 샘플을 선택합니다.

• 데이터 파일의 이전 샘플로 이동하려면 Show Previous Sample 아이콘( )을 클릭합니
다.

실험 조건 보기
데이터를 수집하는 데 사용되는 실험 조건은 결과와 함께 데이터 파일에 저장됩니다. 이 정보
에는 사용된 획득 방법에 대한 세부 정보가 포함됩니다. 예를 들어 기기 매개 변수를 포함한
MS 획득 방법의 기간, 실험 및 주기 수와 LC 펌프 유속을 포함한 LC 장치 방법에 대한 내용입
니다. 또한 샘플 획득에 사용되는 MS 분해능 및 질량 교정 테이블도 포함됩니다. 사용자가 파
일 정보를 볼 때 사용할 수 있는 소프트웨어 기능은 파일 정보 표시 창 오른쪽 클릭 메뉴 섹션
을 참조하십시오.

참고: 둘 이상의 샘플에서 동일한 wiff 파일로 데이터를 획득한 경우 사용자가 샘플을 스크롤할
때 파일 정보 창이 자동으로 새로 고쳐지지 않습니다. wiff 파일에서 다음 샘플에 대한 세부 사
항을 보려면 파일 정보 창을 닫았다가 다시 여십시오.

Explore > Show > Show File Information.을 클릭합니다.
그래프 아래에 File Information 창이 열립니다.

팁! File Information 창에서 획득 방법을 생성하려면 File Information 창을 마우스 오른쪽 버튼
으로 클릭한 후 Save Acquisition Method를 클릭합니다.

테이블에 데이터 표시
1. 데이터 파일을 엽니다.

2. Explore > Show > Show List Data.를 클릭합니다.
데이터가 그래프 아래의 창에 표시됩니다.
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그림 9-1 피크 목록 탭(TripleTOF 시스템)

표 9-1 스펙트럼 피크 목록 탭의 오른쪽 클릭 메뉴

메뉴 기능

Column Options (열 옵션) Select Columns for Peak List 대화 상자를 엽니다.

Save As Text (텍스트로 저장) 데이터를 .txt 파일로 저장합니다.

Delete Pane (창 삭제) 선택한 창을 삭제합니다.

표 9-2 크로마토그래픽 피크 목록 탭의 오른쪽 클릭 메뉴

메뉴 기능

Show Peaks in Graph (그래프에 피크 표시) 그래프에 두 가지 색상으로 피크를 표시합
니다.

IntelliQuan Parameters (IntelliQuan 매개 변수) Intelliquan 대화 상자를 엽니다.

Save As Text (텍스트로 저장) 데이터를 txt 파일로 저장합니다.

Delete Pane (창 삭제) 선택한 창을 삭제합니다.
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ADC 데이터 표시
ADC(아날로그-디지털 변환기) 데이터는 보조 검출기에서(예: ADC 카드를 통해 UV 검출기에
서) 획득되며 질량 분석계 데이터와 비교하는 데 유용합니다. ADC 데이터를 사용할 수 있게
하려면 ADC 데이터와 질량 분석계 데이터를 동시에 획득하십시오. 그러면 두 가지 유형의 데
이터가 동일한 파일에 저장됩니다.

1. ADC 데이터가 저장된 프로젝트 폴더가 선택되었는지 확인합니다. 예를 들어 Example
폴더를 클릭합니다.

2. 탐색 모음에서 Explore 아래의 Open Data File을 두 번 클릭합니다.
Select Sample 대화 상자가 열립니다.

3. Data Files 필드에서 하위 데이터 폴더(해당하는 경우)를 두 번 클릭한 후 열려는 데이터
파일을 클릭합니다. 예를 들어 Example 폴더에서 Devices를 두 번 클릭한 후
Adc16chan.wiff를 클릭합니다.

4. Samples 목록에서 샘플을 선택한 후 OK를 클릭합니다.

5. Explore > Show > Show ADC Data를 클릭합니다.

그림 9-2 ADC 채널 선택 대화 상자

6. Channel 목록에서 채널을 선택한 후 OK를 클릭합니다.
ADC 데이터가 활성 창 아래의 새 창에 표시됩니다.

기본 정량적 데이터 표시
1. 데이터 파일을 엽니다.

2. Explore > Show > Show List Data를 클릭합니다.
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그림 9-3 데이터 목록

3. Peak List 탭에서 마우스 오른쪽 버튼을 클릭한 후 Show Peaks in Graph를 선택합니다.
피크가 두 가지 색상으로 표시됩니다.

4. 피크 찾기 알고리즘 설정을 변경하려면 마우스 오른쪽 버튼을 클릭한 후 Analyst Classic
Parameters 또는 Intelliquan Parameters 중 활성 항목을 선택합니다.

5. (선택 사항) 색상이 지정된 피크를 제거하려면 Peak List 탭을 마우스 오른쪽 버튼으로 클
릭한 후 Show Peaks in Graph를 선택 취소합니다.

크로마토그램
크로마토그램은 샘플 분석에서 얻은 데이터를 그래프로 표현한 것입니다. 시간 또는 스캔 번
호를 나타내는 축을 따라 신호 강도가 표시됩니다. 크로마토그램에 사용할 수 있는 소프트웨
어 기능 및 크로마토그램 창 오른쪽 클릭 메뉴 사용에 대한 자세한 정보는 크로마토그램 창 섹
션을 참조하십시오.

소프트웨어는 X축의 시간에 따라 Y축에 cps(초당 카운트 횟수) 단위의 강도를 표시합니다. 설
정된 임계값보다 높은 피크에는 자동으로 레이블이 지정됩니다. LC-MS의 경우 크로마토그램
은 대개 시간의 함수로 표시됩니다. 크로마토그램 유형에 대한 설명은 표 9-3에서 확인하십시
오.

제공되는 아이콘 사용에 대한 자세한 정보는 표 9-5에서 확인하십시오.
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표 9-3 크로마토그램 유형

크로마토그램 유
형

용도

TIC(총 이온 크로
마토그램)

시간 또는 스캔 번호에 대해 스캔의 모든 이온 강도를 표시하여 생성된 크
로마토그램입니다.

데이터 파일을 열 때 TIC로 열리도록 사전 설정되어 있습니다. 실험에 스
캔이 하나만 포함된 경우에는 스펙트럼으로 표시됩니다.

데이터 파일을 획득하는 동안 MCA 확인란을 선택하면 데이터 파일이 질
량 스펙트럼으로 열립니다. MCA 확인란을 선택하지 않으면 데이터 파일
이 TIC로 열립니다.

XIC(추출된 이온
크로마토그램)

단일 개별 질량 값 또는 일련의 질량 스펙트럼 스캔의 질량 범위에서 강도
값을 구하여 생성된 크로마토그램입니다. XIC는 지정된 질량 또는 질량
범위의 동작을 시간 함수로 나타냅니다.

BPC(기준 피크
크로마토그램)

시간 또는 스캔 번호에 대한 스캔 내 가장 강한 이온의 강도를 표시하는 크
로마토그램입니다.

TWC(총 파장 크
로마토그램)

획득한 파장 범위의 모든 흡광도 값을 합산한 후 시간에 대한 값을 플롯에
표시하여 생성된 크로마토그램입니다. 이는 크로마토그래픽 창에서 시간
에 따라 표시된 스캔의 모든 이온에 대한 합산된 흡광도로 구성됩니다.

XWC(추출된 파
장 크로마토그램)

TWC의 부분 집합입니다. XWC는 단일 파장에 대한 흡광도 또는 파장 범
위에 대한 흡광도 합계를 표시합니다.

DAD(다이오드
어레이 검출기)

하나 이상의 파장에서 용리 화합물의 흡수 스펙트럼을 표시하는 크로마토
그램입니다.

스펙트럼에서 TIC 표시
Explore > Show > Show TIC.를 클릭합니다.
TIC가 새 창에 열립니다.

팁! 스펙트럼을 포함하는 창 내부를 마우스 오른쪽 버튼으로 클릭한 후 Show TIC를 클릭합니
다.

Spectra Panes 오른쪽 클릭 메뉴 사용에 대한 자세한 정보는 스펙트럼 창 섹션을 참조하십시
오.

TIC의 스펙트럼 표시
TIC는 일련의 질량 스캔에서 얻은 모든 이온의 강도 기여도를 합산하여 생성됩니다. TIC를 사
용하여 단일 창에서 전체 데이터 세트를 볼 수 있습니다. TIC는 크로마토그래픽 창에서 시간에
따라 표시되는 스캔의 모든 이온에 대한 강도 합계로 구성됩니다. 데이터에 여러 실험 결과가
포함된 경우 모든 실험의 합계를 나타내는 TIC 아래에 각 실험에 대한 TIC가 생성될 수 있습니
다.
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데이터 파일을 열면 TIC로 표시되도록 사전 설정되어 있습니다. 그러나 실험에 스캔이 하나만
포함된 경우에는 스펙트럼으로 표시됩니다. 사용자가 데이터 파일을 획득하기 전에 MCA 확
인란을 선택하면 데이터 파일이 질량 스펙트럼으로 열립니다. MCA 확인란을 선택하지 않으
면 데이터 파일이 TIC와 함께 열립니다.

Spectra Panes 오른쪽 클릭 메뉴 사용에 대한 자세한 정보는 스펙트럼 창 섹션을 참조하십시
오.

1. TIC가 포함된 창에서 범위를 선택합니다.

2. Explore > Show > Show Spectrum.을 클릭합니다.
스펙트럼이 새 창에 열립니다.

팁! 특정 시간에 TIC 창을 두 번 클릭하여 스펙트럼을 표시합니다.

그림 9-4 TIC의 예

XIC 생성
XIC는 단일 기간, 단일 실험 크로마토그램 또는 스펙트럼에서만 생성할 수 있습니다. 다중 기
간 또는 다중 실험 데이터에서 XIC를 가져오려면 X축 아래의 삼각형을 클릭하여 데이터를 개
별 창으로 분할합니다. 제공되는 아이콘 사용에 대한 자세한 정보는 표 9-5에서 확인하십시오.

사용되는 데이터가 크로마토그래픽 데이터인지 아니면 스펙트럼 데이터인지에 따라 XIC를 생
성하기 위해 이온을 추출하는 몇 가지 방법을 사용할 수 있습니다. 다음 테이블에는 크로마토
그램 및 스펙트럼에 사용할 수 있는 방법이 요약되어 있습니다.

작동 지침 — 데이터 분석 및 탐색

시스템 사용자 안내서
RUO-IDV-05-8593-KR-D

TripleTOF 6600+ 시스템
75/138



표 9-4 XIC 생성 방법 요약

방법 크로마토그램과
함께 사용

스펙트럼과 함께
사용

추출

선택한 범위 아니요 예 스펙트럼의 선택한 영역에서 이온을
추출합니다.

최대 아니요 예 선택한 영역의 최대 강도 피크를 사
용하여 스펙트럼의 선택 영역에서
이온을 추출합니다. 이 옵션은 선택
한 스펙트럼 범위의 최대 질량을 사
용하여 XIC를 생성합니다.

기준 피크 질량 예 예 BPC(기준 피크 크로마토그램)에만
사용할 수 있습니다. Use Base
Peak Masses 명령을 사용하여 이
온을 추출하면 각 질량에 대해 서로
다른 색상의 트레이스가 있는 XIC가
생성됩니다. 선택 영역에 여러 피크
가 포함된 경우에는 결과 XIC에 각
질량에 대해 하나씩 동일한 개수의
색상 트레이스가 있습니다.

지정된 질량 예 예 모든 유형의 스펙트럼 또는 크로마
토그램에서 이온을 추출합니다. XIC
를 생성할 시작 및 중지 질량을 최대
10개까지 선택합니다.

선택한 범위를 사용하여 XIC 생성
1. 스펙트럼을 포함하는 데이터 파일을 엽니다.

2. 범위 시작 부분에서 마우스 왼쪽 버튼을 누르고 커서를 범위 끝까지 끌어온 후 마우스 왼
쪽 버튼을 놓아 범위를 선택합니다.
선택 영역이 파란색으로 표시됩니다.

3. Explore > Extract Ions > Use Range.를 클릭합니다.
선택 영역의 XIC가 스펙트럼 창 아래에 있는 창에 열립니다. 창 맨 위의 실험 정보에는 질
량 범위 및 최대 강도(초당 카운트 횟수)가 포함됩니다.

최대 피크를 사용하여 XIC 생성
1. 스펙트럼을 포함하는 데이터 파일을 엽니다.

2. 스펙트럼에서 범위를 선택합니다.
선택 영역이 파란색으로 표시됩니다.

3. Explore > Extract Ions > Use Maximum.을 클릭합니다.
지정된 최대 피크의 XIC가 스펙트럼 창 아래에 열립니다. 창 맨 위의 실험 정보에는 질량
범위 및 최대 강도(초당 카운트 횟수)가 포함됩니다.
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기준 피크 질량을 사용하여 XIC 생성
1. 스펙트럼을 포함하는 데이터 파일을 엽니다.

2. BPC에서 이온을 추출할 피크를 선택합니다.
선택 영역이 파란색으로 표시됩니다.

3. Explore > Extract Ions > Use Base Peak Masses.를 클릭합니다.
지정된 선택 영역의 XIC가 스펙트럼 창 아래에 열립니다. 창 맨 위의 실험 정보에는 질량
범위 및 최대 강도(초당 카운트 횟수)가 표시됩니다.

질량을 선택하여 이온 추출
1. 스펙트럼 또는 크로마토그램을 엽니다.

2. Explore > Extract Ions > Use Dialog.를 클릭합니다.

그림 9-5 이온 추출 대화 상자

3. 생성할 각 XIC의 값을 입력합니다.

• Start 필드에 질량 범위의 시작 값(하한 값)을 입력합니다.

• Stop 필드에 질량 범위의 중지 값(상한 값)을 입력합니다.

참고: 중지 값을 입력하지 않으면 시작 값으로 범위가 정의됩니다.

4. OK를 클릭합니다.
선택 영역의 XIC가 크로마토그램 창 아래에 열립니다. 창 맨 위의 실험 정보에는 질량 및
최대 강도(초당 카운트 횟수)가 포함됩니다.
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BPC 생성
BPC는 단일 기간, 단일 실험 데이터에서만 생성할 수 있습니다.

1. 데이터 파일을 엽니다.

2. TIC 내에서 영역을 선택합니다.
선택 영역이 파란색으로 표시됩니다.

3. Explore > Show > Show Base Peak Chromatogram.을 클릭합니다.
선택 항목이 Start Time 및 End Time 필드에 표시됩니다.

그림 9-6 기준 피크 크로마토그램 옵션

4. Mass Tolerance 필드에 값을 입력하여 피크를 찾는 데 사용되는 질량 범위를 지정합니
다.
소프트웨어는 입력된 범위(± 질량 값)의 두 배 값을 사용하여 피크를 찾습니다.

5. Minimum Intensity 필드에 알고리즘에서 피크가 무시되는 강도 하한 값을 입력합니다.

6. Minimum Mass 필드에 스캔 범위의 시작 부분 질량을 입력합니다.

7. Maximum Mass 필드에 스캔 범위의 끝부분 질량을 입력합니다.

8. 시작 및 종료 시간을 설정하려면 Use Limited Range 확인란을 선택하고 다음을 수행합
니다.

• Start Time 필드에 실험의 대상 범위가 시작되는 시간을 입력합니다.
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• End Time 필드에 실험의 대상 범위가 끝나는 시간을 입력합니다.

9. OK를 클릭합니다.
BPC가 새 창에 생성됩니다.

XWC 생성
XWC는 단일 파장의 강도 값을 구하거나 여러 파장 범위에 대한 흡광도 합계를 구하여 생성된
파장 크로마토그램입니다. 최대 세 개의 범위를 DAD 스펙트럼에서 추출하여 XWC를 생성할
수 있습니다. 제공되는 아이콘 사용에 대한 자세한 정보는 표 9-5에서 확인하십시오.

1. DAD 스펙트럼을 포함하는 데이터 파일을 엽니다.

2. 창의 아무 곳이나 마우스 오른쪽 버튼으로 클릭한 후 Extract Wavelengths를 클릭합니
다.

그림 9-7 파장 추출 대화 상자

3. Start 및 Stop 값을 입력합니다.

4. OK를 클릭합니다.
XWC가 DAD 스펙트럼 아래의 창에 표시됩니다.

DAD 데이터 표시
질량 분석계 데이터와 마찬가지로, DAD 데이터도 크로마토그램이나 스펙트럼 형태로 볼 수
있습니다. 단일 시점이나 총 파장 크로마토그램(TWC)으로서의 시간 범위에 대한 DAD 스펙트
럼을 볼 수 있습니다.

1. DAD를 사용하여 획득한 데이터가 포함된 데이터 파일을 엽니다.
TWC는 TIC와 유사하지만 TIC 아래의 창에 열립니다.

2. TWC 창에서 한 포인트를 클릭하여 단일 시점을 선택하거나 스펙트럼 영역을 강조 표시
하여 시간 범위를 선택합니다.

3. Explore > Show > Show DAD Spectrum.을 클릭합니다.
DAD 스펙트럼이 TWC 아래 창에 열립니다. Y축에는 흡수가 표시되며 X축에는 파장이 표
시됩니다.

팁! TWC가 표시된 창이 닫히면 TWC에서 아무 지점이나 클릭하여 다시 열 수 있습니다.
Explore > Show > Show DAD TWC.를 클릭합니다.
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TWC 생성
TWC는 잘 사용하지 않는 크로마토그램입니다. TWC는 총 흡광도(mAU)를 시간의 함수로 표
시합니다. TWC는 전체 데이터 세트를 단일 창에서 볼 수 있게 합니다. 이는 크로마토그램에서
시간에 따라 표시된 스캔의 모든 이온에 대한 합산된 흡광도로 구성됩니다. 데이터에 여러 실
험의 결과가 포함된 경우 모든 실험의 합계를 나타내는 TWC 아래에 각 실험에 대한 TWC가
생성될 수 있습니다.

TWC에는 X축의 시간에 따라 Y축에 총 흡광도(mAU)가 표시됩니다. 제공되는 아이콘 사용에
대한 자세한 정보는 표 9-5에서 확인하십시오.

1. DAD 스펙트럼을 포함하는 데이터 파일을 엽니다.

2. Explore > Show > Show DAD TWC.를 클릭합니다.
TWC가 DAD 스펙트럼 아래의 창에 표시됩니다.

팁! DAD 스펙트럼을 포함하는 창 내부를 마우스 오른쪽 버튼으로 클릭하고 Show DAD
TWC를 클릭합니다.

임계값 조정
임계값은 소프트웨어에서 스펙트럼에 피크를 포함하지 않는 하한을 설정하며 그래프의 X축과
평행하게 그려진 보이지 않는 선입니다. 이 선에는 Y축 왼쪽에 파란색 삼각형으로 표시되는
핸들이 있습니다. 임계값을 나타내는 점선을 보려면 파란색 삼각형을 클릭합니다. 임계값을
높이거나 낮출 수 있지만 임계값을 변경해도 데이터는 변경되지 않습니다. 임계값보다 낮은
영역의 피크에는 레이블이 지정되지 않습니다.

1. 데이터 파일을 엽니다.

2. 다음 중 하나를 수행합니다.

• 임계값을 올리려면 파란색 삼각형을 Y축 위로 끌어옵니다.

• 임계값을 내리려면 파란색 삼각형을 아래로 끌어옵니다.

• Explore > Set Threshold.를 클릭합니다. Threshold Options 대화 상자가 열리면 임계
값을 입력한 후 OK를 클릭합니다.

• Explore > Threshold.를 클릭합니다.

그래프가 업데이트되어 새 임계값이 표시됩니다. 피크 레이블과 피크 목록도 업데이트됩
니다.

팁! 현재 임계값을 보려면 마우스 포인터를 임계값 핸들 위로 이동합니다.

그래픽 데이터 처리
그래픽 데이터는 여러 가지 방법으로 처리할 수 있습니다. 이 섹션에서는 일반적으로 사용되
는 몇 가지 도구 사용과 관련된 정보와 절차를 제공합니다.
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그래프
그래픽 데이터를 여러 가지 방법으로 살펴볼 수 있습니다. 이 섹션에서는 일반적으로 사용되
는 몇 가지 기능의 사용과 관련된 정보와 절차를 제공합니다.

다듬기나 감산 같은 처리 작업을 수행하기 전에 비교 목적으로 데이터를 유지할 수도 있습니
다.

창에는 모두 완전히 표시되고 겹치지 않는 방식으로 배열된 하나 이상의 내부 창이 포함됩니
다.

내부 창은 가변 또는 고정 크기일 수 있습니다. 내부 창은 창 내부에 바둑판 형태로 자동 배열
되며 열과 행 형태로 배열됩니다. 창의 크기가 변경되면 창 안에 있는 내부 창의 크기도 새 크
기에 맞게 변경됩니다. 내부 창이 최소 크기보다 작아지는 포인트까지 창 크기를 조정할 수 없
습니다.

유사한 데이터를 포함하는 두 개 이상의 창 또는 내부 창을 연결할 수 있습니다(예: 질량 범위
가 유사한 스펙트럼). 내부 창 또는 창을 확대하면 다른 내부 창도 동시에 확대됩니다. 예를 들
어 XIC가 추출된 BPC에 XIC를 연결할 수 있습니다. BPC를 확대하면 XIC도 확대되므로 두 크
로마토그램이 동일한 배율을 표시합니다.

데이터 관리
다음 메뉴 옵션 또는 아이콘을 사용하여 그래프의 데이터를 관리합니다.

표 9-5 그래프 옵션

수행할 작업 이 메뉴 옵션 사용 또는 이 아이콘 클
릭

그래프를 새 창에 복
사

복사할 그래프를 선택합니다. Explore >
Duplicate Data > In New Window.를 클릭합니
다.

그래프를 원래 크기
로 조정

그래프를 선택합니다. Explore > Home Graph.
를 클릭합니다.
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표 9-5 그래프 옵션 (계속)

수행할 작업 이 메뉴 옵션 사용 또는 이 아이콘 클
릭

내부 창 이동 • 그래프를 선택합니다. Window > Move
Pane.을 클릭합니다.

• 창 또는 내부 창을 선택한 후 새 위치로 끌어
옵니다. 이 위치는 동일한 창 또는 다른 창의
내부일 수 있습니다.

커서가 활성 창 또는 내부 창의 경계에 있으면 4
방향 화살표가 표시됩니다.

• 내부 창이 대상 창의 상단 또는 하단에 있으면
해당 내부 창의 위 또는 아래로 각각 이동합니
다.

• 내부 창이 대상 창의 왼쪽 또는 오른쪽에 있으
면 해당 내부 창의 왼쪽 또는 오른쪽으로 각각
이동합니다.

• 내부 창이 다른 위치에 있으면 대상 행으로 이
동합니다. 내부 창이 이동할 때 창의 그림자는
새 위치를 나타냅니다.

내부 창 연결 a. 두 그래프가 열린 상태에서 하나를 클릭하여
해당 창을 활성화합니다.

b. Explore > Link를 클릭한 후 다른 창을 클릭
합니다.

연결 제거 내부 창 중 하나를 닫습니다. Explore > Remove
Link.를 클릭합니다.

내부 창 삭제 그래프를 선택합니다. Window > Delete Pane.
을 클릭합니다.

내부 창 잠그기 그래프를 선택합니다. Window > Lock Panes.
를 클릭합니다.

내부 창 숨기기 그래프를 선택합니다. Window > Hide Pane.을
클릭합니다.

내부 창 최대화 그래프를 선택합니다. Window > Maximize
Pane.을 클릭합니다.

내부 창 바둑판식 배
열

그래프를 선택합니다. Window > Tile all Panes.
를 클릭합니다.
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Y축 확대
1. Y축 왼쪽의 포인터를 확장할 영역의 한 쪽으로 이동한 후 마우스 왼쪽 버튼을 누른 채 시

작점에서 수직 방향으로 끌어옵니다.
새 배율을 나타내는 상자가 Y축을 따라 그려집니다.

참고: 기준선을 확대할 때는 각별히 주의하십시오. 너무 많이 확대하면 확대 상자가 닫힙
니다.

2. 마우스 버튼을 놓으면 그래프가 새 배율로 표시됩니다.

팁! 그래프의 Y축을 원래 배율로 되돌리려면 아무 축이나 두 번 클릭합니다. 전체 그래프
를 원래 배율로 되돌리려면 Explore > Home Graph.를 클릭합니다.

X축 확대
1. X축 아래의 포인터를 확장할 영역의 한 쪽으로 이동한 후 마우스 왼쪽 버튼을 누른 채 시

작점에서 수평 방향으로 끌어옵니다.

2. 마우스 버튼을 놓으면 그래프가 새 배율로 표시됩니다.

팁! 그래프의 X축을 원래 배율로 되돌리려면 X축을 두 번 클릭합니다. 전체 그래프를 원래
배율로 되돌리려면 Explore > Home Graph.를 클릭합니다.
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서비스 및 유지보수 정보 10
최적의 성능을 위해 시스템을 정기적으로 청소하고 유지보수하십시오.

경고! 감전 위험. 커버를 분리하지 마십시오. 커버를 분리하면 부상 또는 시스템 오
작동이 발생할 수 있습니다. 커버는 정기 유지보수, 검사 또는 조정 시 분리할 필요
가 없습니다. 커버를 제거해야 하는 수리 작업은 SCIEX 현장 서비스 직원(FSE)에게
문의하십시오.

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 청소 또는 유지
보수를 수행하기 전에 오염 물질 제거가 필요한지 확인하십시오. 방사성 물질, 생
물학적 작용제 또는 독성 화학물질을 시스템에 사용한 경우 고객은 청소나 유지보
수를 수행하기 전에 시스템의 오염 물질을 제거해야 합니다.

권장 유지보수 일정
다음 표에서는 시스템 청소 및 유지보수 작업을 위한 권장 일정을 보여줍니다.

팁! 시스템이 최적의 상태로 작동하도록 유지보수 작업을 정기적으로 수행하십시오.

• 시스템을 안전하게 작동할 수 있도록 가스 누출 및 일반적인 유지보수 검사를 주기적으로
수행하십시오.

• 작업 조건을 양호한 상태로 유지할 수 있도록 시스템을 정기적으로 청소하십시오.

• 시스템 유지보수 중 장비에 연결된 배관을 포함하여 외부 가스 공급 시스템의 부품을 자세
히 조사하여 상태가 양호한지 확인하십시오. 금이 가거나 끼어 있거나 접힌 배관을 교체하
십시오.

이온 소스 유지보수에 대한 자세한 정보는 DuoSpray Ion Source 작업자 안내서 문서를 참조
하십시오.

질량 분석계와 이온 소스의 청소 또는 유지보수 주기를 결정하려면 다음 요인을 고려하십시
오. 이러한 요인으로 인해 질량 분석계의 성능이 변경될 수 있으며 이는 유지보수가 필요함을
나타냅니다.

• 화합물 검사 수행

• 샘플 청결도 및 샘플 준비 방법

• 프로브가 샘플에 노출되는 시간

• 전체 시스템 실행 시간
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소모품을 주문하거나 기본 서비스 및 유지보수 요구 사항에 대해 알아보려면 QMP에게 문의
하거나 부품 및 장비 안내서 문서를 참조하십시오. 기타 서비스 및 유지보수 요구 사항은
SCIEX FSE에게 문의하십시오.

표 10-1 질량 분석계 유지보수 작업

구성품 주기 작업 자세한 정보

시스템 매일 누출 검사 자세한 정보는 화학물질 주의 사
항 섹션을 참조하십시오.

커튼 플레이트 매일 청소 자세한 정보는 커튼 플레이트 청
소 섹션을 참조하십시오.

러핑 펌프 오일 매주 수준 검사 자세한 정보는 러핑 펌프 오일양
검사 섹션을 참조하십시오. 필요
한 경우 현지 QMP 또는 FSE에
게 문의하여 오일을 추가하십시
오.

러핑 펌프 오일 3년마다 또는
필요시.

교체 현지 QMP 또는 FSE에게 문의하
십시오.

러핑 펌프 오일 필요 시 재충전 현지 QMP 또는 FSE에게 문의하
십시오.

오리피스 플레이트(전
면)

필요 시 청소 자세한 정보는 오리피스 플레이
트의 전면 청소 섹션을 참조하십
시오.

오리피스 플레이트(전면
및 후면)

필요 시 청소 현지 QMP 또는 FSE에게 문의하
십시오.

QJet 이온 가이드 필요 시 청소 현지 QMP 또는 FSE에게 문의하
십시오.

Q0 로드 세트 및 IQ1 렌
즈

필요 시 청소 현지 QMP 또는 FSE에게 문의하
십시오.

기기 표면 필요 시 청소 자세한 정보는 표면 청소 섹션을
참조하십시오.

소스 배기 배출 용기 필요 시 비우기 자세한 정보는 소스 배기 배출
용기 비우기 섹션을 참조하십시
오.

인터페이스 히터 필요 시 교체 현지 QMP 또는 FSE에게 문의하
십시오.
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표 10-2 이온 소스 유지보수 작업

구성품 주기 작업 자세한 정보

TurboIonSpray 및 APCI
프로브

필요 시 검사 및 교체 자세한 정보는 DuoSpray 이온
소스 작업자 안내서 문서를 참조
하십시오.

MICRO 1~50µL,
MICRO 50–200µL 및
NANO 프로브(OptiFlow
Turbo V 이온 소스)

필요 시 검사 및 교체 자세한 정보는 OptiFlow Turbo V
이온 소스 작업자 안내서 문서를
참조하십시오.

TurboIonSpray 및 APCI
프로브용 전극

필요 시 검사 및 교체 자세한 정보는 DuoSpray 이온
소스 작업자 안내서 문서를 참조
하십시오.

OptiFlow Turbo V 이온
소스 프로브용 전극

필요 시 검사 및 교체 자세한 정보는 OptiFlow Turbo V
이온 소스 작업자 안내서 문서를
참조하십시오.

코로나 방전 바늘 필요 시 교체 자세한 정보는 DuoSpray 이온
소스 작업자 안내서 문서를 참조
하십시오.

터보 히터 필요 시 교체 현지 QMP 또는 FSE에게 문의하
십시오.

터보 히터 필요 시 교체 현지 QMP 또는 FSE에게 문의하
십시오.

샘플 배관 필요 시 교체 자세한 정보는 DuoSpray 이온
소스 작업자 안내서 문서를 참조
하십시오.

"필요 시" 작업의 경우 다음 지침을 따르십시오.

• 유출되었거나 더러워진 경우 질량 분석계 표면을 청소합니다.

• 소스 배기 배출 용기가 가득 차기 전에 비웁니다.

• 시스템 감도가 저하되면 오리피스 플레이트, QJet 이온 가이드 및 Q0 영역을 청소합니다.

팁! Q0 영역을 정기적으로 청소하여 충전이 사중극자 및 렌즈에 미치는 영향(짧은 시간 동
안 관련 이온의 감도가 크게 손실됨)을 최소화하십시오. 자세한 정보는 QMP 또는 FSE에게
문의하십시오.

• 러핑 펌프 오일양이 최소 수준 미만이면 오일을 재충전합니다.

• 모든 배기 연결부를 주기적으로 검사하여 무결성이 유지되고 고객 실험실에서 배기물이 제
거되었는지 확인합니다.
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표면 청소
유출되었거나 더러워지면 질량 분석계의 외부 표면을 청소하십시오.

주의: 잠재적 시스템 손상. 장비가 손상되지 않도록 권장 청소 방법과 재료만 사용하십시오.

1. 따뜻한 비눗물에 적신 부드러운 티슈나 천으로 외부 표면을 닦습니다.

2. 물에 적신 부드러운 티슈나 천으로 외부 표면을 닦아 비누 잔여물을 제거합니다.

프론트 엔드 청소
다음 경고는 이 절의 모든 절차에 적용됩니다.

경고! 고온 표면 위험. DuoSpray 이온 소스를 최소 20분 동안 냉각시키십시오. 작
동 중에 이온 소스와 진공 인터페이스의 일부 표면이 뜨거워집니다.

정기 청소 방법으로 질량 분석계 프론트 엔드를 청소하면 다음과 같은 이점을 얻을 수 있습니
다.

• 갑작스런 시스템 중단 시간 최소화

• 최적 감도 유지.

• 서비스 방문이 필요한 집중 청소 횟수 감소.

오염이 발생할 경우 초기 정기 청소를 실시하십시오. 오리피스 플레이트의 전면까지(포함) 청
소하십시오. 정기 청소로 감도 문제가 해결되지 않으면 전체 청소가 필요할 수 있습니다.

이 절에서는 질량 분석계를 환기한 후 진공을 차단하지 않은 상태에서 정기 청소를 수행하기
위한 지침을 제공합니다.

참고: 해당되는 모든 현지 규정을 따르십시오. 보건 안전 지침은 화학물질 주의 사항 섹션을 참
조하십시오.

오염 증상
다음 중 하나가 관찰되는 경우 시스템이 오염되었을 수 있습니다.

• 심각한 감도 손실

• 배경 노이즈 증가

• 전체 스캔 또는 조사 스캔 방법에 샘플의 일부가 아닌 추가 피크가 있음

이러한 문제가 관찰되면 질량 분석계의 프론트 엔드를 청소하십시오.
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필요한 품목
참고: 미국 고객은 877-740-2129로 전화하여 주문 정보를 확인하거나 문의할 수 있습니다. 해
외 고객은 sciex.com/contact-us를 방문하십시오.

• 무분말 장갑(니트릴 또는 네오프렌 권장)

• 보안경

• 실험복

• LC-MS 등급 민물. 오래된 물에는 질량 분석계를 더럽힐 수 있는 오염 물질이 포함될 수 있
습니다.

• LC-MS 등급 메탄올, 이소프로판올(2-프로판올) 또는 아세토니트릴

• 세정액. 다음 중 하나를 사용하십시오.

• 100% 메탄올

• 100% 이소프로판올

• 1:1의 아세토니트릴: 수용액(새로 준비)

• 1:1의 아세토니트릴: 0.1% 아세트산이 포함된 수용액(새로 준비)

• 세정액을 담을 1L 또는 500mL의 깨끗한 유리 비커

• 사용한 용매를 담을 1L 비커

• 유기성 폐기액 용기

• 보풀 없는 티슈 또는 천. 자세한 정보는 제조업체에서 구입 가능한 도구 및 소모품 섹션을
참조하십시오.

• (선택 사항) 폴리에스테르(폴리) 면봉

제조업체에서 구입 가능한 도구 및 소모품
표 10-3

설명 부품 번호

소형 폴리 면봉(열 접합형). 청소 키트에 포함됩니다. 1017396

보풀 없는 티슈 또는 천(11 cm x 21 cm, 4.3 inch x 8.3 inch). 청소 키트에
포함됩니다.

018027

청소 키트. 소형 폴리 면봉, 보풀 없는 티슈 또는 천, Q0 청소 도구, 테이
퍼형 QJet 이온 가이드 청소 브러시 및 Alconox가 들어 있습니다.

5020763
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청소 실무 지침
경고! 고온 표면 위험. DuoSpray 이온 소스를 최소 20분 동안 냉각시키십시오. 작
동 중에 이온 소스와 진공 인터페이스의 일부 표면이 뜨거워집니다.

경고! 독성 화학물질 위험. 화학물질을 취급, 보관 및 폐기할 때는 화학 제품 안전 보건
자료를 참조하고 권장된 모든 안전 절차를 따르십시오.

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 청소 또는 유지
보수를 수행하기 전에 오염 물질 제거가 필요한지 확인하십시오. 방사성 물질, 생
물학적 작용제 또는 독성 화학물질을 시스템에 사용한 경우 고객은 청소나 유지보
수를 수행하기 전에 시스템의 오염 물질을 제거해야 합니다.

경고! 환경 위험. 시스템 구성품을 도시 폐기물로 폐기하지 마십시오. 구성품을 폐
기할 때는 현지 규정을 따르십시오.

• 이온 소스를 제거하기 전에 열을 식히십시오.

• 청소할 때는 항상 깨끗한 무분말 장갑(니트릴 또는 네오프렌 권장)을 착용하십시오.

• 질량 분석계 구성품을 청소한 후 다시 조립하기 전에 깨끗한 새 장갑을 착용하십시오.

• 이 절차에 지정되지 않은 청소 용품을 사용하지 마십시오.

• 가능한 경우 청소 전에 세척액을 준비하십시오.

• 모든 유기 용액 및 유기 포함 용액을 매우 깨끗한 유리 용기에만 준비 및 보관하십시오. 플
라스틱 병은 절대 사용하지 마십시오. 플라스틱 병에서 오염 물질이 침출되어 질량 분석계
도 오염될 수 있습니다.

• 세정액 오염을 방지하기 위해 용액을 티슈나 천 또는 면봉에 부으십시오.

• 티슈 또는 천의 가운데 부분만 질량 분석계 표면에 닿게 하십시오. 절단면에 섬유질이 남을
수 있습니다.

팁! 열 접합형 폴리 면봉을 티슈 또는 천으로 감쌉니다.

그림 10-1 예: 티슈 또는 천 접기
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• 교차 오염을 방지하기 위해 표면에 한 번 닿은 티슈나 천 또는 면봉은 폐기하십시오.

• 필요한 경우 커튼 플레이트와 같은 진공 인터페이스의 대형 부품은 티슈 또는 천을 한 장 이
상 사용하여 여러 번 청소하십시오.

• 티슈나 천 또는 면봉에 물 또는 세정액을 바를 때 약간만 묻히십시오. 물은 대부분의 경우
유기 용매보다 티슈 또는 천을 잘 닳게 하여 질량 분석계에 잔류물을 남길 수 있습니다.

• 티슈 또는 천으로 구경 전체를 문지르지 마십시오. 구경 주변을 닦아서 티슈 또는 천의 섬유
가 질량 분석계로 들어가지 않게 하십시오.

• 커튼 플레이트 또는 오리피스 플레이트의 구경에 브러시를 넣지 마십시오.

질량 분석계 준비
경고! 고온 표면 위험. DuoSpray 이온 소스를 최소 20분 동안 냉각시키십시오. 작
동 중에 이온 소스와 진공 인터페이스의 일부 표면이 뜨거워집니다.

주의: 잠재적 시스템 손상. 이온 소스를 제거할 때 소스 배출부 안으로 아무 것도 떨어뜨리지
마십시오.

그림 10-2 진공 인터페이스의 소스 배출부

참고: NanoSpray 이온 소스가 있는 질량 분석계에서 최상의 결과를 얻으려면 전체 청소가 필
요할 수 있습니다. 현지 QMP 또는 FSE에게 문의하십시오.
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1. 하드웨어 프로필을 비활성화합니다. 자세한 정보는 소프트웨어 사용자 안내서 문서를 참
조하십시오.

2. 이온 소스를 제거합니다. 자세한 정보는 이온 소스 작업자 안내서 문서를 참조하십시오.
이온 소스를 사용하지 않을 때는 손상을 방지하고 작동 무결성을 유지하기 위해 이온 소
스를 보관해 둡니다.

커튼 플레이트 청소
주의: 잠재적 시스템 손상. 구경 팁 위에 커튼 플레이트나 오리피스 플레이트를 놓지 마십시오.
커튼 플레이트의 원뿔 쪽이 위를 향하게 해야 합니다.

주의: 잠재적 시스템 손상. 구경 손상을 방지하기 위해 커튼 플레이트, 오리피스 플레이트 또는
인터페이스 히터의 구경에 와이어나 금속 브러시를 삽입하지 마십시오.

1. 커튼 플레이트를 진공 인터페이스에서 빼낸 후 깨끗하고 평평한 곳에 원뿔 쪽이 위로 향
하게 놓습니다.

참고: 나노셀 히터 어셈블리가 설치된 경우 이온 소스 작업자 안내서의 지침에 따라 분리
하여 청소합니다.

그림 10-3 커튼 플레이트 분리

커튼 플레이트는 오리피스 플레이트에 설치된 유지 볼 캐치 3개에 의해 고정됩니다.

팁! 커튼 플레이트가 오리피스 플레이트에서 바로 분리되지 않으면 커튼 플레이트를 90도
미만으로 약간 돌려서 볼 스프링 래치를 푸십시오.

2. 보풀 없는 티슈 또는 천을 LC-MS 등급 물에 적셔 커튼 플레이트의 양면을 청소합니다.

참고: 필요한 경우 티슈나 천을 여러 장 사용하십시오.

3. 세정액을 사용하여 2단계를 반복합니다.
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4. 젖은 티슈나 천 또는 작은 폴리 면봉을 사용하여 구경을 청소합니다.

5. 커튼 플레이트가 마를 때까지 기다립니다.

6. 커튼 플레이트에 용매 얼룩이나 보풀이 있는지 검사하면서 잔류물이 있으면 살짝 적신 보
풀이 없는 깨끗한 티슈나 천으로 닦아 냅니다.

참고: 얼룩이나 막이 지속적으로 생성되면 용매가 오염되었음을 나타냅니다.

오리피스 플레이트의 전면 청소
주의: 잠재적 시스템 손상. 오리피스 플레이트 표면을 청소할 때 인터페이스 히터를 분리하지
마십시오. 인터페이스 히터를 자주 분리하면 인터페이스 히터가 손상될 수 있습니다. 인터페
이스 히터 표면은 정기 청소에 적합합니다.

주의: 잠재적 시스템 손상. 구경 손상을 방지하기 위해 커튼 플레이트, 오리피스 플레이트 또는
인터페이스 히터의 구경에 와이어나 금속 브러시를 삽입하지 마십시오.

1. 보풀 없는 티슈 또는 천을 LC-MS 등급 물에 적셔 인터페이스 히터를 포함한 오리피스 플
레이트의 전면을 닦습니다.

2. 세정액을 사용하여 1단계를 반복합니다.

3. 오리피스 플레이트가 마를 때까지 기다립니다.

4. 오리피스 플레이트에 용매 얼룩이나 보풀이 있는지 검사하면서 잔류물이 있으면 살짝 적
신 보풀이 없는 깨끗한 티슈나 천으로 닦아 냅니다.

참고: 얼룩이나 막이 지속적으로 생성되면 용매가 오염되었음을 나타냅니다.

질량 분석계 다시 사용
1. 커튼 플레이트를 설치합니다.

2. 질량 분석계에 이온 소스를 설치합니다. 자세한 정보는 이온 소스 작업자 안내서 문서를
참조하십시오.
소스 래치를 잠금 위치로 돌려 이온 소스를 조입니다.

3. 하드웨어 프로필을 활성화합니다. 자세한 정보는 소프트웨어 사용자 안내서 문서를 참조
하십시오.

소스 배기 배출 용기 비우기
경고! 고온 표면 위험. DuoSpray 이온 소스를 최소 20분 동안 냉각시키십시오. 작
동 중에 이온 소스와 진공 인터페이스의 일부 표면이 뜨거워집니다.
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경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 적절한 레
이블이 부착된 폐기물 용기에 위험 물질을 넣고 현지 규정에 따라 폐기하십시
오.

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 배기 가스를
전용 실험실 흄후드 또는 배기 시스템으로 환기할 때는 각별히 주의해야 하며 환기
배관을 클램프로 고정해야 합니다. 작업이 이루어지는 동안 실험실이 적절하게 환
기되어야 합니다.

참고: 소스 폐기물 라인에 꼬임, 처짐 또는 비틀어짐이 없는지 확인하십시오.

소스 배기 배출 용기를 정기적으로 검사하여 용기가 가득 차기 전에 내용물을 비웁니다. 또한
용기와 부품의 누출 여부를 검사하고 필요에 따라 연결부를 조이거나 구성품을 교체합니다.
용기를 비우려면 이 절차의 단계를 따르십시오.

1. 이온 소스를 제거합니다. 자세한 정보는 DuoSpray Ion Source 작업자 안내서 문서를 참
조하십시오.

2. 호스를 소스 배기 배출 용기의 캡에 연결하는 클램프를 느슨하게 풉니다.
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그림 10-4 소스 배기 배출 용기

항목 설명

1 환기구에 연결

2 소스 배기가스 배출 배관: 2.5cm(1.0인치) 내경(i.d.)

3 러핑 펌프 배출 호스: 3.2cm(1.25인치) 내경

4 소스 배기 배출 용기
이 그림에서는 캡이 장착된 배출 용기가 질량 분석계의 뒷면에 표시되어
연결 지점을 볼 수 있습니다. 배출 용기는 질량 분석계 측면의 배출 용기
홀더에 있습니다. 엎지르지 않도록 용기가 단단히 고정되어 있어야 합니
다.

5 질량 분석계와 소스 배기 연결부: 1.6cm(0.625인치) 내경
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항목 설명

6 러핑 펌프 진공 주입구 호스

참고: 배출 용기, 질량 분석계 및 실험실 환기구의 소스 배출 호스 연결부는 호스 클램프로
고정됩니다.

3. 해당하는 경우 홀더에서 배출 용기를 들어냅니다.

4. 호스를 캡에서 분리합니다.

5. 배출 용기에서 캡을 제거합니다.

6. 실험실 절차와 현지 폐기물 처리 규정에 따라 배출 용기를 비우고 폐기물을 폐기합니다.

7. 용기에 캡을 끼우고 용기를 홀더에 설치합니다.

8. 호스를 캡에 부착하고 클램프로 단단히 고정합니다.

러핑 펌프 오일양 검사
러핑 펌프의 확인창을 검사하여 오일양이 최소 수준을 초과하는지 확인합니다.

오일양이 최소 수준보다 낮으면 인증된 유지보수 직원(QMP) 또는 SCIEX 현장 서비스 직원
(FSE)에게 문의하십시오.
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그림 10-5 확인창

질량 분석계 냉각 팬 필터 교체
질량 분석계 냉각 팬은 질량 분석계의 왼쪽에 있습니다.

선행 절차

• 시스템 사용자 안내서의 절차에 따라 시스템을 종료합니다.

경고! 환경 위험. 시스템 구성품을 도시 폐기물로 폐기하지 마십시오. 구성품을 폐
기할 때는 현지 규정을 따르십시오.
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1. 냉각 팬 커버에 있는 엄지 나사 네 개를 분리합니다.

그림 10-6 냉각 팬 필터

2. 필터를 분리한 후 새 필터를 장착합니다.
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그림 10-7 냉각 팬 필터

항목 설명

1 냉각 팬 커버

2 필터

3. 필터 커버를 설치합니다.

보관 및 취급에 대한 환경 요구 사항
경고! 환경 위험. 시스템 구성품을 도시 폐기물로 폐기하지 마십시오. 구성품을 폐
기할 때는 현지 규정을 따르십시오.

질량 분석계를 장기간 보관하거나 배송 준비를 해야 할 경우 SCIEX FSE에게 문의하여 해체
정보를 확인하십시오. 질량 분석계에서 전원을 분리하려면 AC 주 전원 공급 장치에서 주 전원
공급 커넥터를 제거하십시오.
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참고: 이온 소스와 질량 분석계는 –30°C~+60°C(–22°F~140°F)의 온도와 99% 이하의 상대 습
도(비응결)를 유지한 상태로 운송 및 보관되어야 합니다. 해발고도가 2,000m(6,562피트) 이하
인 곳에 시스템을 보관하십시오.
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질량 분석계 문제 해결 11
이 절에는 기본적인 시스템 문제를 해결하기 위한 정보가 포함되어 있습니다. SCIEX 교육을
받은 인증된 유지보수 직원(QMP)만 실험실에서 특정 작업을 수행할 수 있습니다. 고급 문제
해결의 경우 SCIEX 현장 서비스 직원(FSE)에게 문의하십시오.

표 11-1 시스템 문제

증상 가능한 원인 수정 조치

QJet 이온 가이드가 너무 더
럽거나 자주 더러워집니다.

Curtain Gas 인터페이스의 가
스 유속이 너무 낮습니다.

Curtain Gas 인터페이스의 가
스 설정을 검토하고 가능한 경
우 값을 높이십시오.

진공 압력이 너무 높아 시스템
오류가 발생했습니다.

1. 오일양이 너무 낮습니다.

2. 누출이 있습니다.

3. 잘못된 오리피스 플레이
트가 설치되었습니다.

1. 러핑 펌프의 오일양을 검
사한 후 현지 QMP 또는
FSE에게 문의하여 오일
을 추가하십시오. 자세한
정보는 러핑 펌프 오일양
검사 섹션을 참조하십시
오.

2. 누출 여부를 검사하고 수
리합니다.

3. 올바른 오리피스 플레이
트를 설치합니다.

QPS Exciter 모듈 온도가 너
무 높아 시스템 오류가 발생했
습니다.

1. 주변 온도가 너무 높습니
다.

1. 현지 QMP 또는 FSE에게
문의하십시오.

2. 시스템 현장 계획 안내서
문서에서 주변 온도 사양
을 확인합니다.
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표 11-1 시스템 문제 (계속)

증상 가능한 원인 수정 조치

제어 소프트웨어가 이온 소스
때문에 질량 분석계가
Fault(오류) 상태라고 보고합
니다.

1. 프로브가 설치되지 않았
습니다.

2. 프로브가 단단히 연결되
지 않았습니다.

장치 세부 정보 페이지의
Status 패널에서 오류를 확인
하십시오.

1. 프로브를 설치합니다. 자
세한 정보는 DuoSpray
이온 소스 작업자 안내서
문서를 참조하십시오.

2. 프로브를 제거한 후 설치
합니다. 그런 다음 고정
링을 단단히 조입니다. 자
세한 정보는 DuoSpray
이온 소스 작업자 안내서
문서를 참조하십시오.

제어 소프트웨어에서 APCI
프로브가 사용 중이지만
TurboIonSpray 프로브가 설
치되었음을 나타냅니다.

F3 퓨즈가 나갔습니다. FSE에게 문의하십시오.

분무가 균일하지 않습니다. 전극이 막혔습니다. 전극을 청소하거나 교체합니
다. 자세한 정보는 DuoSpray
이온 소스 작업자 안내서 문서
를 참조하십시오.

인터페이스 히터가 준비되지
않았습니다.

인터페이스 히터에 결함이 있
습니다.

현지 QMP 또는 FSE에게 문
의하십시오.

질량 분석계 분해능이 좋지 않
습니다.

질량 분석계가 조정되지 않았
습니다.

Instrument Optimization 마법
사를 사용하여 질량 분석계를
최적화합니다. 자세한 정보는
소프트웨어 사용자 안내서 또
는 도움말 시스템을 참조하십
시오.
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표 11-1 시스템 문제 (계속)

증상 가능한 원인 수정 조치

질량 분석계 성능이 저하되었
습니다.

1. 이온 소스 상태가 최적화
되지 않았습니다.

2. 샘플이 올바르게 준비되
지 않았거나 분해되었습
니다.

3. 샘플 주입구 부품이 누출
되고 있습니다.

1. 이온 소스 상태를 최적화
합니다. 자세한 정보는
DuoSpray 이온 소스 작
업자 안내서 문서를 참조
하십시오.

2. 샘플이 올바르게 준비되
었는지 확인합니다.

3. 부품의 크기와 종류가 맞
는지 확인하고 단단히 조
입니다. 부품을 너무 꽉
조이지 마십시오. 누출이
계속되면 부품을 교체하
십시오.

4. 대체 이온 소스를 설치하
고 최적화합니다.

5. 문제가 계속되는 경우
FSE에 문의하십시오.

아크 또는 스파크가 발생합니
다.

코로나 방전 바늘 위치가 잘못
되었습니다.

TurboIonSpray 프로브를 사
용 중인 경우 코로나 방전 바
늘을 히터 가스 스트림에서 멀
리 커튼 플레이트 쪽으로 돌립
니다. 자세한 정보는
DuoSpray 이온 소스 작업자
안내서 문서를 참조하십시오.

표 11-2 감도 문제

가능한 원인 수정 조치

감도가 감소됨

이온 소스 매개 변수가 최적화되지 않았습니
다.

이온 소스 매개 변수를 최적화합니다.

질량 분석계가 최적화되지 않았습니다. Instrument Optimization 마법사를 사용하여
질량 분석계를 최적화합니다.

커튼 플레이트가 더럽습니다. 커튼 플레이트를 청소합니다. 자세한 정보는
커튼 플레이트 청소 섹션을 참조하십시오.

오리피스 플레이트가 더럽습니다. 자세한 정보는 오리피스 플레이트의 전면 청
소 섹션을 참조하거나 현지 QMP 또는 FSE에
게 문의하십시오.

질량 분석계 문제 해결
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표 11-2 감도 문제 (계속)

가능한 원인 수정 조치

QJet 이온 가이드 또는 IQ0 렌즈가 더럽습니
다.

QJet 이온 가이드 및 IQ0 렌즈를 청소합니다.
현지 QMP 또는 FSE에게 문의하십시오.

Q0 영역이 더럽습니다. Q0 영역이 오염되었는지 검사합니다. 현지
QMP 또는 FSE에게 문의하십시오.

샘플이 분해되었거나 농도가 낮습니다. 샘플 농도를 확인합니다. 갓 추출한 샘플을 사
용하십시오.

프로브가 올바르게 설치되지 않았습니다. 프로브를 제거하고 설치합니다.

이온 소스가 올바르게 설치되지 않았거나 결
함이 있습니다.

래치가 적절히 고정되었는지 확인하여 이온
소스를 제거하고 설치합니다. 문제가 해결되
지 않은 경우, 다른 이온 소스를 설치한 후 최
적화하십시오.

진공 인터페이스에서 한 개 이상의 O-링이 누
락되었습니다.

O-링이 이온 소스에 있는 경우 진공 인터페이
스에 설치합니다. 없으면 교체하십시오.

LC 시스템 또는 연결에 문제가 있습니다. LC 시스템 문제를 해결합니다.

DP(디클러스터링 전위)가 최적화되지 않았습
니다.

DP를 최적화합니다.

전극이 더럽거나 막혔습니다. 전극을 교체합니다. 자세한 정보는 DuoSpray
이온 소스 작업자 안내서 문서를 참조하십시
오.

신호가 없거나 불안정함

배관이 막혔습니다. 샘플 배관을 교체하십시오.

표 11-3 배경 노이즈 문제

가능한 원인 수정 조치

Temperature (TEM), IonSpray 전압(IS) 또는
히터 가스 유속(GS2)이 너무 높습니다.

이온 소스 매개 변수를 최적화합니다. 자세한
정보는 DuoSpray 이온 소스 작업자 안내서
문서를 참조하십시오.

커튼 플레이트가 더럽습니다. 커튼 플레이트를 청소합니다. 자세한 정보는
커튼 플레이트 청소 섹션을 참조하십시오.

오리피스 플레이트가 더럽습니다. 오리피스 플레이트의 전면을 청소합니다. 자
세한 정보는 오리피스 플레이트의 전면 청소
섹션을 참조하십시오.

QJet 이온 가이드 또는 IQ0 렌즈가 더럽습니
다.

질량 분석계의 프론트 엔드 구성품에 대해 전
체 청소를 수행합니다. 현지 QMP 또는 FSE
에게 문의하십시오.

질량 분석계 문제 해결
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표 11-3 배경 노이즈 문제 (계속)

가능한 원인 수정 조치

Q0 영역이 더럽습니다. Q0 영역을 청소합니다. 자세한 정보는 QMP
또는 FSE에게 문의하십시오.

이동상이 오염되었습니다. 이동상을 교체합니다.

이온 소스가 오염되었습니다. 이온 소스 구성품을 청소하거나 교체한 후 다
음과 같이 이온 소스 및 프론트 엔드를 조정하
십시오.
1. 프로브를 수평/수직 모두 구경에서 가장

먼 위치로 이동합니다.

2. (Analyst TF 소프트웨어) 인터페이스 히
터가 켜져 있는지 확인합니다.

3. 1mL/min의 펌프 유속으로 50:50의 메탄
올:물을 주입합니다.

4. 제어 소프트웨어에서 온도를 650으로,
이온 소스 가스 1을 60으로, 이온 소스 가
스 2를 60으로 각각 설정합니다.

5. Curtain Gas 인터페이스의 가스 유속을
45 또는 50으로 설정합니다.

6. 최상의 결과를 위해 최소 2시간 정도 실
행합니다(하룻밤 동안이면 더 좋음).

판매, 기술 지원 또는 서비스 문제가 있으면 FSE에게 문의하거나 SCIEX 웹사이트(sciex.com)
에서 연락처 정보를 확인하십시오.

질량 분석계 문제 해결
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권장 교정 이온 A
주의: 결과가 잘못될 수 있음. 기한이 지났거나, 표시된 보관 온도에서 보관하지 않은 용액은
사용하지 마십시오.

다음 테이블에는 TripleTOF 6600+ 시스템 교정을 위해 SCIEX에서 권장하는 표준 물질이 나
열되어 있습니다. 조정 용액에 대한 자세한 정보는 작동 지침 — 조정 및 교정에서 확인하십시
오.

표 A-1 Q1 PPG 양극 교정 이온

질량

59.0491
4

233.174
72

442.337
40

674.504
84

906.672
28

1196.88
158

1545.13
274

1952.42
576

2242.63
506

표 A-2 Q1 PPG 음극 교정 이온

질량

44.9981
9

411.259
91

585.385
49

933.636
65

1165.80
409

1572.09
711

1863.30
641

1979.39
013

2211.55
757

표 A-3 APCI 양극 교정 용액 및 ESI 양극 교정 용액: TOF MS

TOF MS 질량

아미노헵탄산 146.11756

아미노-dPEG 4-산 266.15981

클로미프라민 315.16225

아미노-dPEG 6-산 354.21224

아미노-dPEG 8-산 442.26467

레세르핀 609.28066

아미노-dPEG 12-산 618.36953

헥사키스(2,2,3,3-테트라플루오로프로폭시)
포스파젠

922.0098

헥사키스(1H,1H,5H-옥타플루오로펜톡시) 포
스파젠

1521.97148

권장 교정 이온
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표 A-4 APCI 양극 교정 용액 및 ESI 양극 교정 용액: MSMS(클로미프라민)

MSMS(클로미프라민) 질량

C3H8N 58.0651

C5H12N 86.0964

C16H14N 220.1121

C14H10NCl 227.0496

C17H17N 235.1356

C15H13NCl 242.0731

C17H17ClN 270.1044

C19H23ClN2 315.16225

표 A-5 APCI 음극 교정 용액 및 ESI 음극 교정 용액: TOF MS

TOF MS 질량

7-아미노헵탄산 144.103

아미노-dPEG 4-산 264.14526

설핀피라존 단편 277.09825

아미노-dPEG 6-산 352.19769

설핀피라존 403.11219

아미노-dPEG 8-산 440.25012

아미노-dPEG 12-산 616.35498

아미노-dPEG 16-산 792.45984

표 A-6 APCI 음극 교정 용액 및 ESI 음극 교정 용액: MSMS(설핀피라존)

MSMS(설핀피라존) 질량

C6H5O 93.0344

C6H5OS 125.0067

C10H8NO 158.06114

C17H13N2O2 277.0983

C23H2ON2OS3 403.11219

권장 교정 이온
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표 A-7 APCI 음극 교정 용액 및 ESI 음극 교정 용액: MSMS(설핀피라존 단편)

MSMS(설핀피라존 단편) 질량

C6H5 77.03967

C8H6N 116.0506

C9H8N 130.0662

C10H8NO 158.0611

C11H8N2O2 200.0591

C15H9N2 217.0771

C16H13N2O 249.1033

C17H13N2O2 277.09825

권장 교정 이온
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정확한 질량 및 화학식 B
PPG

표 B-1에는 PPG(폴리프로필렌 글리콜) 교정 용액을 사용하여 관측된 정확한 단일 동위 원소
질량 및 하전된 종(양극/음극)이 포함되어 있습니다. 질량과 이온은 M = H[OC3H6]nOH 식을 사
용하여 계산되었으며 양이온 MSMS 단편은 [OC3H6]n(H+) 식을 사용했습니다. 모든 계산에서
H = 1.007825, O = 15.99491, C = 12.00000, N = 14.00307입니다.

참고: PPG 용액을 사용하여 교정을 수행할 때 올바른 동위 원소 피크를 사용하십시오.

표 B-1 PPG 정확한 질량

n 정확한 질량(M) (M + NH4)+ MSMS 단편 (M + NH4)2+ (M + COOH)–

1 76.05242 94.08624 59.04914 56.06003 121.05061

2 134.09428 152.12810 117.09100 85.08096 179.09247

3 192.13614 210.16996 175.13286 114.10189 237.13433

4 250.17800 268.21182 233.17472 143.12282 295.17619

5 308.21986 326.25368 291.21658 172.14375 353.21805

6 366.26172 384.29554 349.25844 201.16468 411.25991

7 424.30358 442.33740 407.30030 230.18561 469.30177

8 482.34544 500.37926 465.34216 259.20654 527.34363

9 540.38730 558.42112 523.38402 288.22747 585.38549

10 598.42916 616.46298 581.42588 317.24840 643.42735

11 656.47102 674.50484 639.46774 346.26933 701.46921

12 714.51288 732.54670 697.50960 375.29026 759.51107

13 772.55474 790.58856 755.55146 404.31119 817.55293

14 830.59660 848.63042 813.59332 433.33212 875.59479

15 888.63846 906.67228 871.63518 462.35305 933.63665

16 946.68032 964.71414 929.67704 491.37398 991.67851

17 1004.72218 1022.75600 987.71890 520.39491 1049.72037

18 1062.76404 1080.79786 1045.76076 549.41584 1107.76223

19 1120.80590 1138.83972 1103.80262 578.43677 1165.80409

20 1178.84776 1196.88158 1161.84448 607.45770 1223.84595

21 1236.88962 1254.92344 1219.88634 636.47863 1281.88781

정확한 질량 및 화학식
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표 B-1 PPG 정확한 질량 (계속)

n 정확한 질량(M) (M + NH4)+ MSMS 단편 (M + NH4)2+ (M + COOH)–

22 1294.93148 1312.96530 1277.92820 665.49956 1339.92967

23 1352.9733 1371.0072 1335.9701 694.5205 1397.9715

24 1411.0152 1429.0490 1394.0119 723.5414 1456.0134

25 1469.0571 1487.0909 1452.0538 752.5624 1514.0553

26 1527.0989 1545.1327 1510.0956 781.5833 1572.0971

27 1585.1408 1603.1746 1568.1375 810.6042 1630.1390

28 1643.1826 1661.2165 1626.1794 839.6251 1688.1808

29 1701.2245 1719.2583 1684.2212 868.6461 1746.2227

30 1759.2664 1777.3002 1742.2631 897.6670 1804.2646

31 1817.3082 1835.3420 1800.3049 926.6879 1862.3064

32 1875.3501 1893.3839 1858.3468 955.7089 1920.3483

33 1933.3919 1951.4258 1916.3887 984.7298 1978.3901

34 1991.4338 2009.4676 1974.4305 1013.7507 2036.4320

35 2049.4757 2067.5095 2032.4724 1042.7717 2094.4739

36 2107.5175 2125.5513 2090.5142 1071.7926 2152.5157

37 2165.5594 2183.5932 2148.5561 1100.8135 2210.5576

38 2223.6012 2241.6351 2206.5980 1129.8344 2268.5994

레세르핀

표 B-2 레세르핀 정확한 질량 (C33H40N2O9)

설명 질량

분자 이온 C33H41N2O9 609.28066

단편 C23H30NO8 448.19659

단편 C23H29N2O4 397.21218

단편 C22H25N2O3 365.18597

단편 C13H18NO3 236.12812

단편 C10H11O4 195.06519

단편 C11H12NO 174.09134

정확한 질량 및 화학식
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타우로콜린산

표 B-3 타우로콜린산 정확한 질량 (C26H45NO7S)

설명 질량

분자 이온 C26H44NO7S 514.28440

단편 C2H3O3S 106.98084

단편 C2H6NO3S 124.00739

단편 SO3 79.95736

TOF 교정 용액

표 B-4 TOF 교정 용액 정확한 질량

설명 질량

분자 이온 Cs+ 132.90488

분자 이온 펩타이드
ALILTLVS

829.53933

펩타이드 ALILTLVS

표 B-5 펩타이드 ALILTLVS 정확한 질량

이름 시퀀스 질량 전하 상태

전구체 이온 ALILTLVS 829.5393 1+

b8 ALILTLVS 811.5288 1+

b7 ALILTLV 724.4967 1+

b7-18 ALILTLV 706.4862 1+

b6-18 ALILTLV 607.4178 1+

y5 LTLVS 532.3341 1+

b5 ALILT 512.3443 1+

b5-18 ALILT 494.3337 1+

b4 ALIL 411.2966 1+

b3 ALI 298.2125 1+

내부 단편 y|b IL 또는 LI 227.1754 1+

내부 단편 y|b LT 또는 TL 215.139 1+

b2 AL 185.1285 1+

a2 AL 157.1335 1+

정확한 질량 및 화학식
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표 B-5 펩타이드 ALILTLVS 정확한 질량 (계속)

이름 시퀀스 질량 전하 상태

임모늄 이온 I 또는 L 86.09643 1+

정확한 질량 및 화학식

시스템 사용자 안내서
RUO-IDV-05-8593-KR-D

TripleTOF 6600+ 시스템
111/138



도구 모음 아이콘 C
추가 도구 모음 아이콘은 고급 사용자 안내서를 참조하십시오.

표 C-1 도구 모음 아이콘

아이콘 이름 설명

New
Subproject

하위 프로젝트를 생성합니다. 프로젝트가 처음에 하위 프로젝트
와 함께 생성된 경우에만 프로세스 뒷부분에서 하위 프로젝트를
생성할 수 있습니다.

Copy
Subproject

하위 프로젝트 폴더를 복사합니다.

하위 프로젝트는 기존 하위 프로젝트가 있는 다른 프로젝트에서
만 복사할 수 있습니다. 동일 폴더가 프로젝트와 하위 프로젝트
수준 모두에 존재하는 경우 프로젝트 수준의 폴더가 사용됩니
다.

표 C-2 Acquisition Method Editor(획득 방법 편집기) 아이콘

아이콘 이름 설명

Mass Spec Acquisition Method Editor에 MS 탭을 표시합니다.

Period 실험(IDA Criteria Level)을 추가하거나 기간을 삭제합니다.

Autosampler Autosampler Properties 탭을 엽니다.

Syringe
Pump

Syringe Pump Properties 탭을 엽니다.

Column Oven Column Oven Properties 탭을 엽니다.

Valve Valve Properties 탭을 엽니다.

DAD DAD Method Editor를 엽니다. 자세한 정보는 DAD 데이터 표시
섹션을 참조하십시오.

ADC ADC Properties 탭을 엽니다. 자세한 정보는 ADC 데이터 표시
섹션을 참조하십시오.
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표 C-3 획득 모드 아이콘

아이콘 이름 설명

View Queue 샘플 대기열을 표시합니다.

Instrument
Queue

원격 기기 스테이션을 표시합니다.

Status for
Remote
Instrument

원격 기기의 상태를 표시합니다.

Start Sample 대기열에서 샘플을 시작합니다.

Stop Sample 대기열에서 샘플을 중지합니다.

Abort Sample 샘플을 처리하는 중에 해당 샘플 획득을 중단합니다.

Stop Queue 모든 샘플 처리를 완료하기 전에 대기열을 중지합니다.

Pause
Sample Now

대기열에 일시 중지를 삽입합니다.

Insert Pause
before
Selected
Sample(s)

특정 샘플 앞에 일시 중지를 삽입합니다.

Continue
Sample

샘플 획득을 계속 진행합니다.

Next Period 새 기간을 시작합니다.

Extend
Period

현재 기간을 연장합니다.

Next Sample 현재 샘플 획득을 중지하고 다음 샘플 획득을 시작합니다.

Equilibrate 장치를 평형화하는 데 사용할 방법을 선택합니다. 이 방법은 대
기열의 첫 번째 샘플과 함께 사용된 것과 동일해야 합니다.

Standby 기기를 Standby 상태로 설정합니다.

Ready 기기를 Ready 상태로 설정합니다.
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표 C-3 획득 모드 아이콘 (계속)

아이콘 이름 설명

Reserve
Instrument
for Tuning

질량 분석계의 조정 및 교정을 예약합니다.

Method
Wizard

Method Wizard를 시작합니다.

Purge
Modifier

변형제 펌프에서 변형제 정화를 시작합니다.

아이콘 이름 설명

Calibrate
from
spectrum

Mass Calibration Option 대화 상자를 열고 활성 스펙트럼을 사
용하여 질량 분석계를 교정합니다.

Manual Tune Manual Tune Editor를 엽니다.

Instrument
Optimization

기기 성능을 확인하거나, 질량 교정을 조정하거나, 질량 분석계
설정을 조정합니다.

View Queue 샘플 대기열을 표시합니다.

Instrument
Queue

원격 기기를 표시합니다.

Status for
Remote
Instrument

원격 기기의 상태를 표시합니다.

Reserve
Instrument
for Tuning

기기의 조정 및 교정을 예약합니다.

Purge
Modifier

변형제 펌프에서 변형제를 정화하거나 맑게 합니다.

표 C-4 탐색 빠른 참조: 크로마토그램 및 스펙트럼

아이콘 이름 설명

Open Data
File

파일을 엽니다.

Show Next
Sample

다음 샘플로 이동합니다.
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표 C-4 탐색 빠른 참조: 크로마토그램 및 스펙트럼 (계속)

아이콘 이름 설명

Show
Previous
Sample

이전 샘플로 이동합니다.

Go To
Sample

Select Sample 대화 상자를 엽니다.

List Data 데이터를 테이블로 표시합니다.

Show TIC 스펙트럼에서 TIC를 생성합니다.

Extract Using
Dialog

질량을 선택하여 이온을 추출합니다.

Show Base
Peak
Chromatogra
m

BPC를 생성합니다.

Show
Spectrum

TIC에서 스펙트럼을 생성합니다.

Copy Graph
to new
Window

활성 그래프를 새 창으로 복사합니다.

Baseline
Subtract

Baseline Subtract 대화 상자를 엽니다.

Threshold 임계값을 조정합니다.

Noise Filter Noise Filter Options 대화 상자를 표시합니다. 이 대화 상자에서
피크의 최소 폭을 정의할 수 있습니다. 이 최소 폭보다 작은 신호
는 노이즈로 간주됩니다.

Show ADC ADC 데이터를 표시합니다.

Show File
Info

데이터를 수집하는 데 사용된 실험 조건을 표시합니다.

Add arrows 활성 그래프의 X축에 화살표를 추가합니다.

Remove all
arrows

활성 그래프의 X축에서 화살표를 제거합니다.

Offset Graph ADC 데이터 및 질량 분석계 데이터가 기록되는 동안의 약간의
시간 차를 교정합니다. 이 기능은 비교를 위해 그래프를 중첩할
때 유용합니다.
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표 C-4 탐색 빠른 참조: 크로마토그램 및 스펙트럼 (계속)

아이콘 이름 설명

Force Peak
Labels

모든 피크에 레이블을 지정합니다.

Expand
Selection By

보다 세부적으로 표시할 그래프 부분에 대한 확장 인수를 설정
합니다.

Clear ranges 확장한 선택 영역을 일반 보기로 되돌립니다.

Set Selection 선택 영역의 시작점/중지점을 정의합니다. 이 기능을 사용하면
커서를 사용하여 영역을 선택할 때보다 더 정확히 선택할 수 있
습니다.

Normalize To
Max

그래프를 최대 크기로 조정하여 최대 강도 피크가 최대 배율로
조정되도록 합니다(표시 여부와 무관).

Show History 다듬기, 감산, 교정, 노이즈 필터링 등 특정 파일에 대해 수행되
는 데이터 처리 작업에 대한 요약을 표시합니다.

Open
Compound
Database

화합물 데이터베이스를 엽니다.

Set
Threshold

임계값을 조정합니다.

Show
Contour Plot

선택한 데이터를 스펙트럼 그래프 또는 XIC로 표시합니다. 또한
DAD에 의해 획득된 데이터의 경우에는 등고선 플롯에 선택한
데이터가 DAD 스펙트럼이나 XWC로 표시될 수 있습니다.

Show DAD
TWC

DAD 스펙트럼의 TWC를 생성합니다.

Show DAD
Spectrum

DAD 스펙트럼을 생성합니다.

Extract
Wavelength

DAD 스펙트럼에서 최대 세 개의 파장 범위를 추출하여 XWC를
표시합니다.

표 C-5 탐색 도구 모음 빠른 참조: 그래프 중첩

아이콘 이름 설명

Home Graph 그래프를 원래 배율로 되돌립니다.

Overlay 그래프를 중첩합니다.

Cycle
Overlays

중첩된 각 그래프를 번갈아 표시합니다.
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표 C-5 탐색 도구 모음 빠른 참조: 그래프 중첩 (계속)

아이콘 이름 설명

Sum
Overlays

그래프를 모두 함께 추가합니다.

표 C-6 탐색 도구 모음 빠른 참조: Fragment Interpretation 도구

아이콘 이름 설명

Show
Fragment
Interpretation
Tool

Fragment Interpretation 도구를 엽니다. 이 도구는 mol 파일에서
비순환적인 단일 결합 분열 단편을 계산합니다.

표 C-7 Explore 도구 모음의 탐색 아이콘

아이콘 이름 기능

Open File 파일을 엽니다.

Show Next
Sample

다음 샘플로 이동합니다.

Show
Previous
Sample

이전 샘플로 이동합니다.

GoTo Sample Select Sample 대화 상자를 엽니다.

List Data 데이터를 테이블로 표시합니다.

Show TIC 스펙트럼에서 TIC를 생성합니다.

Extract Using
Dialog

질량을 선택하여 이온을 추출하려면 클릭합니다.

Show Base
Peak
Chromatogra
m

BPC를 생성합니다.

Show
Spectrum

TIC에서 스펙트럼을 생성합니다.

Copy Graph
to new
Window

활성 그래프를 새 창으로 복사합니다.

Baseline
Subtract

Baseline Subtract 대화 상자를 엽니다.
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표 C-7 Explore 도구 모음의 탐색 아이콘 (계속)

아이콘 이름 기능

Threshold 임계값을 조정합니다.

Noise Filter 피크의 최소 폭을 정의할 수 있는 Noise Filter Options 대화 상자
를 엽니다. 이 최소 폭보다 작은 신호는 노이즈로 간주됩니다.

Show ADC ADC 데이터를 표시합니다.

Show File
Info

데이터를 수집하는 데 사용된 실험 조건을 표시합니다.

Add arrows 활성 그래프의 X축에 화살표를 추가합니다.

Remove all
arrows

활성 그래프의 X축에서 화살표를 제거합니다.

Offset Graph ADC 데이터 및 질량 분석계 데이터가 기록되는 동안의 약간의
시간 차를 교정합니다. 이 기능은 비교를 위해 그래프를 중첩할
때 유용합니다.

Force Peak
Labels

모든 피크에 레이블을 지정합니다.

Expand
Selection By

보다 세부적으로 표시할 그래프 부분에 대한 확장 인수를 설정
합니다.

Clear ranges 확장한 선택 영역을 일반 보기로 되돌립니다.

Set Selection 선택 영역의 시작점/중지점을 설정합니다. 이렇게 하면 커서를
사용하여 영역을 강조 표시할 때보다 더 정확히 선택할 수 있습
니다.

Normalize to
Max

그래프를 최대로 조정하여 최대 강도 피크가 최대 배율로 조정
되도록 합니다(표시 여부와 무관).

Show History 다듬기, 감산, 교정, 노이즈 필터링 등 특정 파일에 대해 수행되
는 데이터 처리 작업에 대한 요약을 표시합니다.

Open
Compound
Database

화합물 데이터베이스를 엽니다.

Set
Threshold

임계값을 조정합니다.

Show
Contour Plot

선택한 데이터를 스펙트럼 그래프 또는 XIC로 표시합니다. 또한
DAD에 의해 획득된 데이터의 경우에는 등고선 플롯에 선택한
데이터가 DAD 스펙트럼이나 XWC로 표시될 수 있습니다.
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표 C-7 Explore 도구 모음의 탐색 아이콘 (계속)

아이콘 이름 기능

Show DAD
TWC

DAD의 TWC를 생성합니다.

Show DAD
Spectrum

DAD 스펙트럼을 생성합니다.

Extract
Wavelength

DAD 스펙트럼에서 최대 세 개의 파장 범위를 추출하여 XWC를
표시합니다.

표 C-8 통합 탭 및 정량화 마법사 아이콘

아이콘 이름 설명

Set
parameters
from
Background
Region

선택한 피크를 사용합니다.

Select Peak 선택한 배경을 사용합니다.

Manual
Integration
Mode

피크를 수동으로 통합합니다.

Show or Hide
Parameters

피크 찾기 매개 변수를 표시하거나 숨깁니다.

Show Active
Graph

분석 물질 크로마토그램만 표시합니다.

Show Both
Analyte and
IS

분석 물질과 관련 크로마토그램을 표시합니다. 관련된 내부 표
준 물질이 있을 때만 사용할 수 있습니다.

Use Default
View for
Graph

사전 설정된 보기(모든 데이터 보기)로 돌아갑니다(예를 들어 사
용자가 크로마토그램을 확대한 경우).

표 C-9 결과 표 아이콘

아이콘 이름 설명

Sort
Ascending
by Selection

선택한 열을 오름차순으로 정렬합니다.
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표 C-9 결과 표 아이콘 (계속)

아이콘 이름 설명

Sort
Descending
by Selection

선택한 열을 내림차순으로 정렬합니다.

Lock Or
Unlock
Column

선택한 열을 잠그거나 잠금 해제합니다. 잠긴 열은 이동할 수 없
습니다.

Metric Plot
By Selection

선택한 열에서 메트릭 플롯을 생성합니다.

Show all
Samples

Results Table의 모든 샘플을 표시합니다.

Delete
Formula
Column

수식 열을 삭제합니다.

Report
Generator

Reporter 소프트웨어를 엽니다.

표 C-10 아이콘 빠른 참조: Quantitate 모드

아이콘 이름 설명

Add/Remove
Samples

Results Table의 샘플을 추가하거나 제거합니다.

Export as
Text

Results Table을 텍스트 파일로 저장합니다.

Modify
Method

wiff 파일을 엽니다.

Peak Review
- Pane

피크를 내부 창에 엽니다.

Peak Review
- Window

피크를 창에 엽니다.

Calibration -
Pane

교정 곡선을 내부 창에 엽니다.

Calibration -
Window

교정 곡선을 창에 엽니다.

Show First
Peak

창이나 내부 창에 첫 번째 피크를 표시합니다.

Show Last
Peak

창이나 내부 창에 마지막 피크를 표시합니다.
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표 C-10 아이콘 빠른 참조: Quantitate 모드 (계속)

아이콘 이름 설명

Show Audit
Trail

Results Table에 대한 감사 내역을 표시합니다.

Clear Audit
Trail

Results Table에 대한 감사 내역을 지웁니다. 이 기능은 사용할
수 없습니다.

Statistics Statistics 창을 엽니다.

Report
Generator

Reporter 소프트웨어를 엽니다.

표 C-11 획득 모드 아이콘

아이콘 이름 기능

Start Sample 대기열에서 샘플을 시작하려면 클릭
합니다.

Stop Sample 대기열에서 샘플을 중지하려면 클릭
합니다.

Equilibrate 질량 분석계를 평형화하는 데 사용
할 방법을 선택하려면 클릭합니다.
해당 방법에는 이온 소스, LC 컬럼
(사용되는 경우) 및 주변 장치가 포
함됩니다. 이 방법은 대기열의 첫 번
째 샘플과 함께 사용된 것과 동일해
야 합니다.
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오른쪽 클릭 메뉴 D
배치 편집기
Batch Editor 테이블을 마우스 오른쪽 버튼으로 클릭하여 옵션에 액세스합니다.

그림 D-1 배치 오른쪽 클릭 메뉴

메뉴 기능

Open (열기)배치 파일을 엽니다.

Import From (가져오기)파일에서 배치를 가져옵니다.

Save As Batch (배치로 저장)배치를 다른 이름으로 저장합니다.

Save As a
Template

(템플릿으로 저장)배치를 템플릿으로 저장합니다.

Hide/Show
Column

(열 숨기기/표시)열을 숨기거나 표시합니다.

Save Column
Settings

(열 설정 저장)배치 열 설정을 저장합니다.

Add Custom
Column

(사용자 지정 열 추가)사용자 지정 열을 추가합니다.
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메뉴 기능

Delete Custom
Column

(사용자 지정 열 삭제)사용자 지정 열을 삭제합니다.

Fill Down (아래로 채우기)동일한 데이터를 선택한 셀에 복사합니다.

AutoIncrement (자동 증가)선택한 셀의 데이터가 자동으로 증가합니다.

Delete Samples (샘플 삭제) 선택한 행을 삭제합니다.

Select
Autosampler

(오토샘플러 선택)오토샘플러를 선택합니다.

대기열
대기열 테이블을 마우스 오른쪽 버튼으로 클릭하여 옵션에 액세스합니다.

그림 D-2 대기열 관리자 오른쪽 클릭 메뉴

메뉴 기능

Sample Details (샘플 세부 정보)Sample Details 대화 상자를 엽니다.

Reacquire (다시 획득)샘플을 다시 획득합니다.

Insert Pause (일시 중지 삽입)두 샘플 사이에 일시 중지(초)를 삽입합
니다.

Delete (삭제)배치 또는 선택한 샘플을 삭제합니다.

Move Batch (배치 이동)대기열 내에서 배치를 이동합니다.

Sort (정렬)미리 선택된 열을 기준으로 정렬합니다.

Column Settings (열 설정)열 설정을 변경합니다.
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파일 정보 표시 창 오른쪽 클릭 메뉴
표 D-1 파일 정보 표시 창 오른쪽 클릭 메뉴

메뉴 기능

Copy (복사)선택한 데이터를 복사합니다.

Paste (붙여넣기)데이터를 붙여 넣습니다.

Select All (모두 선택)창의 모든 데이터를 선택합니다.

Save To File (파일에 저장)데이터를 rtf 파일로 저장합니다.

Font (글꼴)글꼴을 변경합니다.

Save Acquisition
Method

(획득 방법 저장)획득 방법을 dam 파일로 저장합니다.

Save Acquisition
Method to
CompoundDB

(획득 방법을 CompoundDB에 저장)Specify Compound
Information 대화 상자를 엽니다. 화합물 데이터베이스에 저장할
ID 및 분자량을 선택합니다.

Delete Pane (창 삭제) 선택한 창을 삭제합니다.

크로마토그램 창
표 D-2 크로마토그램 창의 오른쪽 클릭 메뉴

메뉴 기능

List Data 데이터 요소를 나열하고 크로마토그램에서 발견된 피크를 통합합니
다.

Show Spectrum 스펙트럼을 포함하는 새 창을 생성합니다.

Show Contour Plot 색상이 지정된 데이터 세트 플롯을 표시합니다. 여기서 색상은 해당
지점에서 데이터의 강도를 나타냅니다. 특정 MS 모드만 지원됩니다.

Extract Ions 선택한 창에서 특정 이온 또는 이온 세트를 추출한 후 특정 이온에 대
한 크로마토그램을 포함하는 새 창을 생성합니다.

Show Base Peak
Chromatogram

기준 피크 크로마토그램을 포함하는 새 창을 생성합니다.

Show ADC Data 획득한 경우 ADC 데이터 트레이스를 포함하는 새 창을 생성합니다.

Show UV Detector
Data

획득한 경우 UV 데이터 트레이스를 포함하는 새 창을 생성합니다.

Spectral Arithmetic
Wizard

스펙트럼 산술 마법사를 엽니다.

Save to Text File 창의 데이터를 포함하는 텍스트 파일을 생성합니다. 이 파일은
Microsoft Excel 또는 기타 프로그램에서 열 수 있습니다.
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표 D-2 크로마토그램 창의 오른쪽 클릭 메뉴 (계속)

메뉴 기능

Save Explore
History

탐색 모드에서 wiff 파일을 처리할 때 수행된 처리 매개 변수(처리 옵
션이라고도 함)의 변경 내용에 대한 정보를 저장합니다. 처리 기록은
확장자가 eph(explore processing history)인 파일에 저장됩니다.

Add Caption 창에서 커서 위치에 캡션을 추가합니다.

Add User Text 창에서 현재 커서 위치에 텍스트 상자를 추가합니다.

Set Subtract Range 창에서 제거 범위를 설정합니다.

Clear Subtract
Range

창에서 제거 범위를 지웁니다.

Subtract Range
Locked

제거 범위를 잠그거나 잠금을 해제합니다. 제거 범위가 잠겨 있지 않
은 경우 각 제거 범위를 개별적으로 이동할 수 있습니다. 제거 범위는
잠금 상태로 사전 설정되어 있습니다.

Delete Pane 선택한 창을 삭제합니다.

스펙트럼 창
표 D-3 스펙트럼 창의 오른쪽 클릭 메뉴

메뉴 기능

List Data 데이터 요소를 나열하고 크로마토그램을 통합합니다.

Show TIC TIC를 포함하는 새 창을 생성합니다.

Extract Ions (Use Range) 선택한 창에서 특정 이온 또는 이온 세트를 추출한 후 특
정 이온에 대한 크로마토그램을 포함하는 새 창을 생성
합니다.

Extract Ions (Use Maximum) 선택한 영역에서 강도가 가장 높은 피크를 사용하여 이
온을 추출합니다.

Save to Text File 창의 텍스트 파일을 생성합니다. 이 파일은 Microsoft
Excel 또는 기타 프로그램에서 열 수 있습니다.

Save Explore History 탐색 모드에서 wiff 파일을 처리할 때 수행된 처리 매개
변수(처리 옵션이라고도 함)의 변경 내용에 대한 정보를
저장합니다. 처리 기록은 확장자가 eph(explore
processing history)인 파일에 저장됩니다.

Add Caption 창에서 커서 위치에 캡션을 추가합니다.

Add User Text 창에서 현재 커서 위치에 텍스트 상자를 추가합니다.

Show Last Scan 선택 전 스캔을 표시합니다.

Select Peaks For Label 이 대화 상자에서 피크 레이블 지정을 줄이는 매개 변수
를 선택합니다.
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표 D-3 스펙트럼 창의 오른쪽 클릭 메뉴 (계속)

메뉴 기능

Re-Calibrate TOF TOF Calibration 대화 상자를 엽니다.

Abscissa (Time) x축에 TOF 값을 표시하도록 보기를 변경합니다.

Delete Pane 선택한 창을 삭제합니다.

Add a Record 스펙트럼을 포함하여 레코드 및 화합물 관련 데이터를
라이브러리에 추가합니다. 이 작업을 수행하려면 활성
스펙트럼이 필요합니다.

Search Library 이전에 저장한 제약 조건을 사용하거나 제약 조건 없이
라이브러리를 검색합니다.

Set Search Constraints Search Constraints 대화 상자에 입력한 기준을 사용하
여 라이브러리를 검색합니다.

결과 테이블
Results Table을 마우스 오른쪽 버튼으로 클릭하여 다음 테이블에 표시된 옵션에 액세스합니
다.

표 D-4 결과 테이블 오른쪽 클릭 메뉴

메뉴 기능

Full (전체) 모든 열을 표시합니다.

Summary (요약) 특정 열을 표시합니다.

Analyte (분석 물질) 특정 분석 물질을 표시합니다.

Analyte
Group

(분석 물질 그룹) 분석 물질 그룹을 생성합니다.

Sample Type (샘플 유형) 특정 유형의 샘플 또는 모든 샘플을 표시합니다.

Add Formula
Column

(수식 열 추가) 수식 열을 추가합니다. 수식 열을 사용하는 경우 결과의 유효
성을 검사하는 것이 좋습니다.

Table
Settings

(테이블 설정) 테이블 설정을 편집하거나 선택합니다.

Query (쿼리) 쿼리를 생성하거나 선택합니다.

Sort (정렬) 정렬을 생성하거나 인덱스별로 정렬합니다.

Metric Plot (메트릭 플롯) 메트릭 플롯을 생성합니다.

Delete Pane (창 삭제) 활성 창을 삭제합니다.

Fill Down (아래로 채우기) 동일한 데이터를 선택한 셀에 복사합니다.
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표 D-4 결과 테이블 오른쪽 클릭 메뉴 (계속)

메뉴 기능

Add Custom
Column

(사용자 지정 열 추가) 사용자 지정 열을 추가합니다.

Delete
Custom
Column

(사용자 지정 열 삭제) 사용자 지정 열을 삭제합니다.

피크 검토
Peak Review 창 또는 내부 창을 마우스 오른쪽 버튼으로 클릭하여 표 D-5에 표시된 옵션에
액세스합니다.

표 D-5 피크 검토 오른쪽 클릭 메뉴

메뉴 기능

Options (선택 사항) Peak Review Options 대화 상자를 엽니다.

Sample
Annotation

(샘플 주석) Sample Annotation 대화 상자를 엽니다.

Save Active to
Text File

(활성 항목을 텍스트 파일에 저장) 선택한 피크를 텍스트 파일로 저장합니
다.

Show First
Page

(첫 번째 페이지 표시) 첫 번째 샘플로 이동합니다.

Show Last
Page

(마지막 페이지 표시) 마지막 샘플로 이동합니다.

Slide Show
Peak Review

(슬라이드 쇼 피크 검토) 슬라이드 쇼를 엽니다.

Update Method (방법 업데이트) 모든 피크에 대한 알고리즘을 업데이트합니다.

Revert to
Method

(방법으로 되돌리기) 현재 정량화 방법에 따라 재정의된 피크를 선택합니
다.

Delete Pane (창 삭제) 활성 창을 삭제합니다.

교정 곡선
Calibration 창 또는 내부 창을 마우스 오른쪽 버튼으로 클릭하여 다음 테이블에 표시된 옵션에
액세스합니다.
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표 D-6 교정 곡선 오른쪽 클릭 메뉴

메뉴 기능

Exclude
(Include)

(제외 (포함)) 곡선에서 포인트를 제외하려면 해당 포인트를 마우스 오른
쪽 버튼으로 클릭한 후 Exclude를 클릭합니다. 포인트를 포함하려면 해당
포인트를 마우스 오른쪽 버튼으로 클릭한 후 Include를 클릭합니다.

Exclude All
Analytes
(Include All
Analytes)

(모든 분석 물질 제외 (모든 분석 물질 포함)) 곡선에서 모든 분석 물질을
제외하려면 한 포인트를 마우스 오른쪽 버튼으로 클릭한 후 Exclude All
Analytes를 클릭합니다. 분석 물질을 포함하려면 한 포인트를 마우스 오
른쪽 버튼으로 클릭한 후 Include All Analytes를 클릭합니다.

Show Peak (피크 표시) 개별 피크를 검토합니다.

Overlay (오버레이) 두 그래프를 오버레이합니다.

Active Plot (활성 플롯) 활성 플롯을 결정합니다.

Legend (범례) 그래프 범례를 표시합니다.

Log Scale X
Axis*

(로그 눈금 X축) X축에 로그 눈금을 사용합니다.

Log Scale Y
Axis*

(로그 눈금 Y축) Y축에 로그 눈금을 사용합니다.

Delete Pane (창 삭제) 활성 창을 삭제합니다.

Home Graph (홈 그래프) 그래프를 원래 크기로 조정합니다.

* 로그 눈금은 모든 포인트의 결과를 동시에 모니터링할 수 있도록 데이터 요소를 관리하기
쉬운 보기로 배열합니다. 이 보기의 경우 한 축의 로그뿐 아니라 Log Scale Y Axis 및 Log
Scale X를 모두 선택하십시오.
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기호 용어 E
참고: 다음 표의 모든 기호가 모든 기기에 적용되는 것은 아닙니다.

기호 설명

호주 Regulatory Compliance Mark. 제품이 ACMA(호주 통신 미디어청)
EMC 요구 사항을 준수함을 나타냅니다.

교류

A 암페어(전류)

질식 위험

유럽 공동체의 공식 대리인

생물학적 위험

적합성 평가 CE 마킹

cCSAus 마크. 캐나다와 미국의 전기 안전 인증을 나타냅니다.

카탈로그 번호

주의. 발생 가능한 위험에 대한 정보는 지침을 참조하십시오.
참고: SCIEX 문서에서 이 기호는 신체 부상 위험을 나타냅니다.

기호 용어
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기호 설명

중국 RoHS 주의 레이블. 전자 정보 제품에는 특정 독성 또는 위험 물질이
포함되어 있습니다. 가운데 숫자는 EFUP(친환경 사용 기간) 날짜이며 제
품이 작동할 수 있는 연도 수를 나타냅니다. EFUP가 만료되면 해당 제품
을 즉시 재활용해야 합니다. 순환하는 화살표는 제품을 재활용할 수 있음
을 나타냅니다. 레이블 또는 제품의 날짜 코드는 제조 일자를 나타냅니다.

중국 RoHS 로고. 해당 장치는 최대 농도 값을 초과하는 독성 및 위험 물질
이나 성분을 포함하지 않으며 재활용과 재사용이 가능한 친환경 제품입니
다.

사용 지침을 참조하십시오.

손가락 끼임 위험

북미의 TUV Rheinland에 대한 cTUVus 마크

바코드 판독기로 스캔하여 UDI(고유 장치 식별자)를 확인할 수 있는 데이
터 매트릭스 기호

환경 위험

이더넷 연결

폭발 위험

기호 용어
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기호 설명

눈 부상 위험

화재 위험

가연성 화학물질 위험

파손 위험

퓨즈

Hz Hertz

국제 안전 기호 "주의: 전기 감전 위험"(ISO 3864) - 고전압 기호라고도 함
주 커버를 분리해야 할 경우 SCIEX 담당자에게 문의하여 감전을 예방하
십시오.

고온 표면 위험

체외 진단 장치

이온화 방사선 위험

습기 주의

비에 노출하지 마십시오.

상대 습도가 99%를 초과하면 안 됩니다.

세워 두기

기호 용어
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기호 설명

열상/절단 위험

레이저 방사선 위험

들어올리기 위험

자기 위험

제조업체

가동부 위험

심박조율기 위험. 심박조율기를 장착한 사람은 접근할 수 없습니다.

끼임 사고 위험

가압 가스 위험

보호 접지(접지)

자상 위험

화학 반응 물질 위험

기호 용어
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기호 설명

일련 번호

독성 화학물질 위험

시스템을 66kPa ~ 103kPa 내에서 운송 및 보관하십시오.

시스템을 75kPa ~ 101kPa내에서 운송 및 보관하십시오.

지정된 최소(min) ~ 최대(max) 상대 습도 수준(비응결) 내에서 시스템을
운송 및 보관하십시오.

시스템을 –30°C ~ +45°C 내에서 운송 및 보관하십시오.

시스템을 –30°C ~ +60 °C 내에서 운송 및 보관하십시오.

USB 2.0 연결

USB 3.0 연결

자외선 방사 위험

United Kingdom Conformity Assessment 마크

VA 볼트 암페어(전력)

V 볼트(전압)

기호 용어
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기호 설명

WEEE. 장비를 분류되지 않은 도시 폐기물로 폐기하지 마십시오. 환경 위
험

W 와트

yyyy-mm-dd

제조 일자

기호 용어
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경고 용어 F
참고: 구성품을 식별하는 데 사용되는 레이블이 떨어지면 FSE(현장 서비스 직원)에게 문의하
십시오.

레이블 번역(해당하는 경우)

FOR RESEARCH USE ONLY. NOT FOR
USE IN DIAGNOSTIC PROCEDURES.

연구용으로만 사용하십시오. 진단 절차에 사
용하지 마십시오.

IMPACT INDICATOR

SENSITIVE PRODUCT WARNING

충격 표시

민감한 제품 경고

참고: 표시가 트립되어 있으면 이 컨테이너가
떨어졌거나 잘못 취급된 것입니다. 선하 증권
에 기록한 뒤 손상되었는지 확인하십시오. 충
격 손상에 대한 청구를 표시해야 합니다.

IMPORTANT!

RECORD ANY VISIBLE CRATE DAMAGE
INCLUDING TRIPPED “IMPACT
INDICATOR” OR “TILT INDICATOR” ON
THE WAYBILL BEFORE ACCEPTING
SHIPMENT AND NOTIFY YOUR LOCAL AB
SCIEX CUSTOMER SUPPORT ENGINEER
IMMEDIATELY.

DO NOT UNCRATE. CONTACT YOUR
LOCAL CUSTOMER SUPPORT ENGINEER
FOR UNCRATING AND INSTALLATION.

중요!

배송품을 받기 전에 "충격 표시" 또는 "경사
표시" 트립 등 육안으로 확인할 수 있는 운송
상자의 손상 상태를 화물 운송장에 모두 기록
하고 현지 AB SCIEX 고객 지원 엔지니어에
게 즉시 알리십시오.

상자를 풀지 마십시오. 상자를 풀고 설치하려
면 현지 고객 지원 엔지니어에게 문의하십시
오.

TIP & TELL 경사 표시

참고: 컨테이너가 기울어졌거나 잘못 취급되
었는지 여부를 나타냅니다. 손상 여부를 검사
하고 선하 증권(Bill of Lading)에 기록하십시
오. 모든 전복 클레임에는 기록이 요구됩니다.

경고 용어
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레이블 번역(해당하는 경우)

TiltWatch PLUS

ShockWatch

경사 표시

참고: 컨테이너가 기울어졌거나 잘못 취급되
었는지 여부를 나타냅니다. 손상 여부를 검사
하고 선하 증권(Bill of Lading)에 기록하십시
오. 모든 전복 클레임에는 기록이 요구됩니다.

WARNING: DO NOT OPERATE WITHOUT
FIRST ENSURING BOTTLE CAP IS
SECURED.

경고: 병 마개가 고정되어 있는지 확인한 후
작동하십시오.

참고: 이 경고는 소스 배기 폐기물 병에 부착
되어 있습니다.

WARNING: NO USER SERVICEABLE
PARTS INSIDE. REFER SERVICING TO
QUALIFIED PERSONNEL.

경고: 내부에는 사용자가 수리할 수 있는 부품
이 없습니다. 적격 담당자에게 서비스를 의뢰
하십시오.

참고: 사용 지침을 참조하십시오.

경고 용어
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문의하기

고객 교육
• 북아메리카: NA.CustomerTraining@sciex.com

• 유럽: Europe.CustomerTraining@sciex.com

• 유럽 및 북미 이외 지역의 연락처 정보는 sciex.com/education

온라인 학습 센터
• SCIEX Now Learning Hub

SCIEX 지원 부서
SCIEX 및 전 세계 대리점은 충분히 교육을 받은 서비스 및 기술 전문가를 보유하고 있습니다.
이들은 시스템에 대한 질문 또는 발생할 수 있는 모든 기술적 문제에 대한 도움을 제공합니다.
자세한 내용은 SCIEX 웹 사이트(sciex.com)를 참조하거나, 다음 방법 중 하나를 사용하여 당
사로 문의하십시오.

• sciex.com/contact-us

• sciex.com/request-support

사이버 보안
SCIEX 제품의 사이버 보안에 대한 최신 지침은 sciex.com/productsecurity에서 확인할 수 있
습니다.

문서
이 문서가 이전 버전의 모든 문서를 대체합니다.

이 문서를 컴퓨터로 보려면 Adobe Acrobat Reader가 필요합니다. 최신 버전을 다운로드하려
면 https://get.adobe.com/reader로 이동하십시오.

소프트웨어 제품 문서를 찾으려면 릴리스 노트 또는 소프트웨어와 함께 제공되는 소프트웨어
설치 안내서를 참조하십시오.

하드웨어 제품 문서를 찾으려면 시스템 또는 구성품과 함께 제공되는 Customer Reference
DVD를 참조하십시오.

SCIEX 웹 사이트(sciex.com/customer-documents)에서 최신 버전의 문서를 확인할 수 있습니
다.

문의하기
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참고: 이 문서의 무료 인쇄 버전을 요청하려면 sciex.com/contact-us에 문의하십시오.

문의하기

TripleTOF 6600+ 시스템
138/138

시스템 사용자 안내서
RUO-IDV-05-8593-KR-D

https://sciex.com/contact-us

	시스템 사용자 안내서
	목차
	작동 주의 사항 및 제한
	일반 안전 정보
	설명서 기호 및 표기 규칙
	규정 준수
	호주 및 뉴질랜드
	캐나다
	유럽
	미국
	국제

	전기 주의 사항
	주 전원 공급 장치
	보호 접지 도체

	화학물질 주의 사항
	시스템에 안전한 액체

	환기 주의 사항
	물리적 주의 사항
	환경 주의 사항
	전자기 환경
	전자기 적합성
	전자기 간섭

	철거 및 폐기
	전기/전자 장비 폐기물


	적격 담당자
	실험실 조건
	안전한 환경 조건
	성능 사양

	장비 사용 및 개조

	작동 원리
	시스템 개요
	하드웨어 개요
	패널 기호

	작동 이론
	데이터 처리


	작동 지침
	시스템 시작
	시스템 종료
	통합형 주사기 펌프 위치 조정
	주사기 펌프 재설정

	작동 지침 — 샘플 워크플로
	작동 지침 — 하드웨어 프로필 및 프로젝트
	하드웨어 프로필
	하드웨어 프로필 생성
	하드웨어 프로필에 장치 추가
	하드웨어 프로필 활성화 문제 해결

	프로젝트 및 하위 프로젝트
	프로젝트 및 하위 프로젝트 생성
	하위 프로젝트 생성
	하위 프로젝트 복사
	프로젝트와 하위 프로젝트 간 변경
	설치된 프로젝트 폴더
	API Instrument 폴더
	Default 폴더
	Example 폴더

	API Instrument 폴더 백업
	API Instrument 폴더 복구


	작동 지침 — 조정 및 교정
	질량 분석계 최적화
	성능 확인 또는 조정 대화 상자
	결과 요약

	작동 지침 — 획득 방법
	획득 방법 편집기를 사용하여 획득 방법 생성
	실험 추가
	기간 추가
	실험을 기간으로 복사
	기간 내 실험 복사

	방법 마법사를 사용하여 획득 방법 생성
	스캔 기술
	단일 질량 분광분석법
	사중극자 기반 단일 질량 분광분석법
	TOF 단일 질량 분광분석법

	직렬 질량 분광분석법
	생성 이온 질량 분광분석법
	전구체 이온 질량 분광분석법
	스펙트럼 데이터 획득 정보

	MS 매개 변수

	작동 지침 — Batches
	대기열 옵션 설정
	배치에 세트 및 샘플 추가
	샘플 또는 샘플 세트 제출
	샘플 교정 설정
	샘플 순서 변경
	데이터 획득
	배치 편집기에서 샘플 위치 설정
	위치 탭에서 바이알 위치 선택(선택 사항)
	샘플 획득 중지
	대기열 상태와 장치 상태
	대기열 상태
	기기 및 장치 상태 아이콘 보기


	작동 지침 — 데이터 분석 및 탐색
	데이터 파일 열기
	데이터 파일에서 샘플 간 이동
	실험 조건 보기
	테이블에 데이터 표시
	ADC 데이터 표시
	기본 정량적 데이터 표시
	크로마토그램
	스펙트럼에서 TIC 표시
	TIC의 스펙트럼 표시
	XIC 생성
	선택한 범위를 사용하여 XIC 생성
	최대 피크를 사용하여 XIC 생성
	기준 피크 질량을 사용하여 XIC 생성
	질량을 선택하여 이온 추출

	BPC 생성
	XWC 생성
	DAD 데이터 표시
	TWC 생성
	임계값 조정
	그래픽 데이터 처리
	그래프
	데이터 관리
	Y축 확대
	X축 확대


	서비스 및 유지보수 정보
	권장 유지보수 일정
	표면 청소
	프론트 엔드 청소
	오염 증상
	필요한 품목
	제조업체에서 구입 가능한 도구 및 소모품

	청소 실무 지침
	질량 분석계 준비
	커튼 플레이트 청소
	오리피스 플레이트의 전면 청소
	질량 분석계 다시 사용

	소스 배기 배출 용기 비우기
	러핑 펌프 오일양 검사
	질량 분석계 냉각 팬 필터 교체
	보관 및 취급에 대한 환경 요구 사항

	질량 분석계 문제 해결
	권장 교정 이온
	정확한 질량 및 화학식
	도구 모음 아이콘
	오른쪽 클릭 메뉴
	배치 편집기
	대기열
	파일 정보 표시 창 오른쪽 클릭 메뉴
	크로마토그램 창
	스펙트럼 창
	결과 테이블
	피크 검토
	교정 곡선

	기호 용어
	경고 용어
	문의하기
	고객 교육
	온라인 학습 센터
	SCIEX 지원 부서
	사이버 보안
	문서



